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RESUMEN 
 
 
El trabajo se divide en siete capítulos. 
 
El Capítulo I presenta de una forma muy general, conceptos y propiedades básicas de las 
rocas, de los diferentes registros geofísicos de pozos (de litología, porosidad y 
resistividad), de la corrección de la información obtenida a través de dichos registros 
(específicamente corrección de parámetros de interpretación por efectos ambientales en 
las mediciones); así como las interpretaciones para formaciones limpias y arcillosas. 
 
El Capítulo II describe el uso del paquete de cómputo Interactive Petrophysics utilizado 
en este trabajo para llevar a cabo un ejemplo de aplicación, en él se dan a conocer las 
capacidades de alcance que tiene este software así como los requisitos necesarios para su 
utilización. 
 
El Capítulo III contiene los procedimientos para poner en marcha un proyecto de 
aplicación, en este caso de una evaluación petrofísica. 
 
El Capítulo IV menciona cómo cargar información digital de curvas de registros 
geofísicos de pozos que vienen en formatos LAS y ASCII (para datos de núcleos) a un 
proyecto, como realizar un encabezado general a la información que describe un proyecto 
de aplicación, así cómo la preparación de log plots y plot formats que muestran de 
manera gráfica la información requerida para empezar la interpretación de registros de 
pozos. 
 
El Capítulo V describe cómo preparar la información de registros y núcleos antes de 
empezar con el proceso de interpretación, como: filtrar una curva, extrapolar datos de una 
curva, conversión de unidades, correcciones ambientales a los registros y, también cómo 
preparar gráficas cruzadas de porosidad, histogramas de algún parámetro de interés y el 
cálculo de parámetros, como volumen de arcilla, resistividad del agua de formación y 
saturación de agua. 
 
El Capítulo VI integra los conceptos teóricos del Capítulo I más el uso del manual de 
Interactive Petrophysics para obtener la porosidad en cinco intervalos de interés a través 
de la combinación de registros de porosidad y de las ecuaciones de los registros sónico y 
densidad, así como algunos comentarios acerca de los resultados. 
 
Finalmente se presentan algunas conclusiones acerca de este trabajo. 
 
Y por último se dan algunas referencias utilizadas de libros y artículos técnicos para la 
realización de este trabajo.  
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INTRODUCCIÓN 
 
El objetivo principal de este trabajo es que sirva como una opción de consulta para el 
estudiante de la carrera de Ingeniero Petrolero, sobretodo que sea una herramienta de 
apoyo en la materia de Caracterización de Formaciones; para que el alumno no se quede 
con una visión general de lo que es una Caracterización Estática de Yacimientos a través 
de la interpretación de registros geofísicos de pozos, sino que sea capaz de comprender 
de una manera más interactiva las características o propiedades de las rocas y del sistema 
roca-fluidos que a nosotros en particular como ingenieros de ciencias de la tierra nos 
competen. 
La evaluación de una formación productora o de un yacimiento, requiere definir con 
precisión la distribución original de fluidos. Esto puede lograrse mediante procedimientos 
directos haciendo mediciones especiales a las rocas almacenadoras atravesadas por el 
pozo o, bien, en forma indirecta, llevando a cabo interpretaciones cualitativas y 
cuantitativas de los registros geofísicos. 
Los registros geofísicos son una de las herramientas más útiles y poderosas en la 
obtención de información petrofísica necesaria para el proceso de Caracterización de 
Yacimientos. Los principales parámetros físicos necesarios en la evaluación de los 
yacimientos, son: la porosidad, la saturación de fluidos, los espesores de las capas 
permeables y la permeabilidad. 
Un registro de pozo es una representación digital o analógica de una propiedad física que 
se mide contra la profundidad. La obtención de esta se realiza a partir de una sonda que 
se corre en la trayectoria del pozo y de un equipo superficial que traduce la información 
enviada por la sonda a través de un cable que se registra en una cinta magnética o 
película fotográfica. 
 
Las sondas son cilindros de metal que tienen en su parte interior circuitos electrónicos 
muy sofisticados que varían de acuerdo, con la propiedad que miden, a las necesidades de 
investigación, condiciones y profundidad del pozo. La manera de medir las distintas 
propiedades de las rocas parte de un sistema básico común: un emisor (electrodo, bobina, 
emisor de reactividad, emisor de neutrones, emisor de ondas acústicas, etc.) que envía 
una señal (corriente eléctrica, campo electromagnético, radiactividad, neutrones, ondas 
acústicas, etc.) hacia la formación. Uno o varios receptores miden la respuesta de la 
formación a cierta distancia del emisor. 
 
 Interactive Petrophysics (IP) es un software comercial utilizado en la interpretación de 
registros geofísicos de pozos en la industria petrolera, porque uno de los principales 
beneficios de IP es la facilidad en el manejo del workflow (pasos básicos para comenzar 
con una interpretación cualitativa y cuantitativa de registros de pozos) a comparación de 
otros software comerciales. Además de su sencillo manejo, es un paquete de cómputo que 
cuenta con todos los requerimientos para la preparación de la información, el 
procesamiento de la información, alcance y su interfase gráfica nos permite claramente 
analizar los resultados con mayor facilidad. Es por esto que se eligió este paquete de 
cómputo para llevar a cabo una Evaluación Petrofísica en este trabajo. 
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CAPÍTULO I CONCEPTOS BÁSICOS 
 
 
No se intenta sugerir aquí el gran efecto que puede alcanzar el análisis de los registros, 
sino para asegurar las propiedades de los yacimientos de hidrocarburos que son de interés 
en la predicción de la productividad esperada de un pozo. 
 
I.1.-PROPIEDADES BÁSICAS DE LAS ROCAS 
 
 
En este capítulo se presentarán las propiedades que son consideradas fundamentales en 
registros geofísicos de pozos y de las cuales se pueden obtener propiedades, parámetros y 
conceptos muy importantes. 
 
Las rocas en general contienen fluidos como agua, aceite, gas o combinaciones de éstos 
que se encuentran en cavidades llamadas poros, es decir la porosidad. La fracción del 
volumen  de poro contenido con algún fluido se denomina índice de saturación. Para 
evaluar la productividad de un depósito con fluidos es necesario conocer la facilidad con 
que el fluido puede atravesar el sistema poroso; esta propiedad de la formación, la cuál 
depende de la manera en que están interconectados los poros se conoce como 
permeabilidad. 
 
La porosidad, índice de saturación de fluidos, permeabilidad y espesor de la formación 
contenida con fluidos de interés son necesarios para determinar si el pozo puede 
considerarse económicamente productivo. Estos parámetros pueden obtenerse e inferirse 
por muestras de canal, núcleos, o bien a partir de registros geofísicos de pozos que se 
corren tanto en rocas sedimentarias, como ígneas y metamórficas, por lo que es 
conveniente clasificarlas y conocer su comportamiento cuando son detectadas por las 
sondas. 
 
 
I.1.1.-POROSIDAD (φ) 
 
 
La porosidad de una roca es una medida de la cantidad de los espacios internos que son 
capaces de almacenar fluidos. Se define también como la relación que existe entre los 
espacios en rocas llenos con algún fluido y el volumen total de ésta. 
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Fig. I.1Muestra la distribución de los espacios porosos, la esferecicidad y redondez de los  granos. 
 
De acuerdo con el modo en que se originó, la porosidad puede clasificarse en: 

- porosidad primaria y 
- porosidad secundaria 

 
La  porosidad primaria u original es aquélla que se desarrolló en el momento de la 
depositación de los sedimentos o del origen de las rocas, mientras que la secundaria o 
inducida se generó por procesos geológicos subsecuentes. La primaria está representada 
por la porosidad intergranular en areniscas, y por la intercristalina y oolítica en algunas 
calizas. Las rocas que tienen porosidad primaria son más uniformes en sus características. 
Asimismo, la porosidad inducida está representada por fracturas, comúnmente en 
carbonatos y en menor frecuencia en lutitas  y por vesículas o cavidades en disolución; 
otro proceso que la genera es la dolomitización. 
 
Existen varios procesos que afectan a la porosidad de las rocas sedimentarias: 

a) acomodamiento de los granos 
b) cementación 
c) esfericidad y redondez de los granos 
d) solución de minerales por acción del agua, aumenta la porosidad 
   

I.1.2.-PERMEABILIDAD (K) 
 
Donde quiera que exista un gradiente hidráulico en poros interconectados o rocas 
fracturadas, la migración de fluidos puede ocurrir. 
En el código API se establece que la permeabilidad (K) es una propiedad del medio 
poroso y también una medida, tanto de la capacidad del medio para transmitir fluidos 
como de la magnitud del flujo del fluido por unidad de gradiente hidráulico, es decir es 
una medida de la facilidad con que un fluido puede desplazarse en una formación, 
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mediante un gradiente de presión. Para ser permeable, una roca debe tener porosidad 
interconectada (poros, cavernas, capilares, fisuras o fracturas). 
 
La permeabilidad de una roca determinada al flujo de un solo fluido homogéneo es una 
constante si el fluido no interactúa con la roca. La permeabilidad determinada por un sólo 
líquido  homogéneo se llama permeabilidad absoluta o intrínseca. 
 
Si se conoce la permeabilidad, puede predecirse la productividad de un acuífero o 
yacimiento en condiciones variantes de presión y de flujo, utilizando los métodos de 
ingeniería de yacimientos. Debido a que la mayoría de los pozos son perforados para 
recuperar agua o hidrocarburos, la determinación de esta propiedad tiene un significado 
económico primordial. 
 
La mayoría de los métodos de registros para medir la permeabilidad se basan en las 
consideraciones del espacio poroso, estructura del poro y la saturación del agua, o sea, 
que la permeabilidad está impuesta a partir de las propiedades de las rocas en condiciones 
estáticas y no de flujo. 
 
Algunas arenas de granos finos pueden tener un alto índice de porosidad interconectada, 
aunque los poros individuales y los canales de poros sean bastante pequeños. Como 
resultado, los caminos disponibles para el movimiento de fluidos a través de los poros 
estrechos están restringidos y son sinuosos; por lo tanto, las permeabilidades de las 
formaciones de granos muy finos pueden ser muy bajas. 
 
Las arcillas y los esquistos (roca metamórfica en la que predominan los minerales 
fibrosos o laminares), que están compuestos por partículas de granos extremadamente 
finos, generalmente presentan una porosidad muy alta. Sin embargo, como los poros y los 
canales de poros son igualmente pequeños, en la práctica la mayoría de las arcillas y de 
los esquistos presentan una permeabilidad nula. 
 
Otras formaciones como la caliza, pueden estar compuestas por una roca densa fracturada 
por pequeñas fisuras de gran extensión. La porosidad de una formación densa 
seguramente será baja, pero la permeabilidad de una fisura puede ser enorme. Por lo 
tanto, las calizas con fisuras pueden tener porosidades muy bajas, pero altas 
permeabilidades. 
 
I.1.3.-RESISTIVIDAD (R) 
 
La resistividad eléctrica de una sustancia es su capacidad de impedir el flujo de 
corriente eléctrica a través de si misma. La unidad utilizada en los registros es el 
ohmio/metro . La conductividad eléctrica es el recíproco de la resistividad y se expresa en 
milimhos por metro. 
 
La mayoría de las formaciones que se registran para buscar saturaciones potenciales de 
aceite y gas, se componen de rocas que, al estar secas, no conducirán una corriente 
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eléctrica; esto es, la matriz de roca tiene una conductividad nula o una resistividad 
infinitamente alta. Una corriente eléctrica fluirá sólo a través del agua intersticial que 
satura la estructura porosa de la formación, más solamente si el agua intersticial contiene 
sales disueltas. Las sales se disocian en cationes de carga positiva y aniones de carga 
negativa. Bajo la influencia de un campo eléctrico, estos iones se mueven, transportando 
una corriente eléctrica a través de la solución. Si las otras condiciones permanecen 
estables, mientras mayor sea la concentración salina, menor será la resistividad del agua 
de formación y por lo tanto, de la formación. Mientras sea más grande la porosidad de la 
formación y, por lo tanto, mayor sea la cantidad de agua de formación, la resistividad será 
menor. 
De todos los parámetros de la roca que miden las herramientas de registros actuales, la 
resistividad reviste particular importancia. Es la medición para la cuál existen 
herramientas que tienen una gran profundidad de investigación (hasta varios metros de la 
pared del pozo). Las mediciones de la resistividad son básicas en las determinaciones de 
saturación; en especial determinaciones de saturación en la parte no invadida del 
yacimiento. Las mediciones de resistividad se emplean solas y en combinación para 
determinar la resistividad en la formación no invadida (llamada resistividad verdadera 
Rt). Las mediciones de resistividad también se utilizan para determinar la resistividad 
cerca del pozo (llamada resistividad de zona lavada, Rxo), en donde el filtrado de lodo ha 
reemplazado en su mayoría a los fluidos originales de los poros.  
 
Las mediciones de resistividad de la roca, junto con las resistividades del agua y la 
porosidad se utilizan para obtener los valores de saturación de agua. Es posible comparar 
los valores de saturación de las mediciones de resistividad a poca y gran profundidad con 
el propósito de evaluar la productividad de la formación. 
 
I.1.4.-SATURACIÓN DE FLUIDOS (Sf) 
 
La saturación de fluidos de una formación es la fracción de su volumen poroso que ocupa 
el fluido en consideración. Por lo tanto, la saturación de agua es la fracción o porcentaje 
del volumen poroso que contiene agua de formación. Si sólo existe agua en los poros, una 
formación tiene una saturación de agua del 100 %. El símbolo de saturación es S; se 
utilizan varios subíndices para denotar la saturación de un líquido en particular ( Sw 
saturación de agua; So saturación de aceite; Sh saturación de hidrocarburos, etc). 
 
La saturación de aceite o gas es la fracción del volumen poroso que contiene aceite o gas. 
Los poros deben saturarse con algún fluido. De este modo, la suma de todas las 
saturaciones de una determinada roca de formación debe ser igual al 100 %. Aunque 
existen casos poco comunes de fluidos de saturación aparte del agua, el aceite y el gas  
(como bióxido de carbono o simplemente aire), la presencia de una saturación de agua 
menor al 100 % generalmente implica una saturación de hidrocarburos igual al 100 % 
menos la saturación de agua (o sea 1-Sw); en otras palabras, en un yacimiento que 
contiene agua en su parte inferior e hidrocarburos en la superior, el límite entre el 
hidrocarburo y el agua no está siempre bien definido, hay una transición más o menos 
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gradual desde un 100% de agua hasta donde hay mayormente hidrocarburos; o sea, que la 
saturación de agua en la parte superior se acerca a un valor mínimo. 
 
La saturación de agua de una formación puede variar de un 100 % hasta un valor muy 
pequeño; sin embargo, muy rara vez es nula. Sin importar que tan rica sea la roca del 
yacimiento de aceite o gas, siempre habrá una pequeña cantidad de agua capilar que el 
petróleo no puede desalojar; generalmente dicha saturación se conoce como saturación de 
agua irreductible. 
 
Del mismo modo, en el caso de una roca de yacimiento con presencia de aceite o gas, es 
imposible retirar todos los hidrocarburos por medio de las técnicas de recuperación más 
comunes. Alguna cantidad de hidrocarburos permanece atrapada en partes del volumen 
poroso; esta saturación de hidrocarburos se conoce como saturación residual. 
 
En un yacimiento que contenga agua en el fondo y aceite en la parte superior, la 
demarcación no siempre será clara; se presenta una transición más o menos gradual de un 
100 % de agua hasta un mayor contenido de aceite. Si el intervalo  con contenido de 
aceite es sumamente grande, la saturación de agua en la parte superior se aproxima a un 
valor mínimo llamado saturación de agua irreductible, Swi. Debido a las fuerzas capilares, 
cierta cantidad de agua se adhiere a los granos y no es posible desalojarla. Una formación 
con saturación de agua irreductible producirá hidrocarburos sin presencia de agua. Dentro 
del intervalo de transición se obtendrá un poco de agua junto con el aceite. Debajo del 
intervalo de transición, la saturación de agua es igual al 100 %. Por lo general, mientras 
sea más baja la permeabilidad de la roca del yacimiento, mayor será el intervalo de 
transición. Por el contrario, si el intervalo de transición es corto, la permeabilidad será 
alta.    
 

 
Fig. I.2 Representación del sistema roca-fluidos 
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I .1.5.-CLASIFICACIÓN DE LAS FORMACIONES 
 
Es conveniente conocer el comportamiento de los diferentes paquetes de roca atravesados 
por el agujero. Los tipos de roca que se encuentran  y pueden servir para acumular algún 
fluido de interés, o bien, algún mineral, son las sedimentarias e ígneas; aunque pueden 
encontrarse rocas metamórficas. 
 
Las rocas más comunes que se encuentran son arenas y areniscas, calizas, lutitas y rocas 
ígneas, anhidritas y sal. Cada una de éstas tiene diferente respuesta al ser detectada por la 
herramienta. 
 
Los tipos de roca que van a ser tratados en este trabajo son esencialmente las areniscas y 
los carbonatos. 
 
ARENISCAS 
 
Son rocas compuestas por granos de cuarzo. El material cementante generalmente es el 
sílice. Los granos pueden variar de tamaño, dependiendo el nivel de energía en el cual se 
depositaron. Las areniscas pueden estar asociadas a lutitas y calizas. 
 
Las porosidades de las areniscas son menores del 40% (del 10 al 15 % en areniscas bien 
consolidadas; las arenas no consolidadas pueden llegar a 30%). Cuando las porosidades  
están por debajo del 7 % en zonas de gas y 8 % en zonas de aceite, la permeabilidad  será 
tan baja que no se podrán extraer estos fluidos. Se considera un corte mínimo de 
porosidad el cuál el yacimiento puede ser productor y es del 9%. Aunque se han 
encontrado areniscas que producen a niveles más bajos de porosidad, debido a que los 
paquetes están fracturados o son tan delgados que las herramientas de detección no miden 
precisamente las propiedades del intervalo de interés. 
 
En general, a medida que disminuya la porosidad, la permeabilidad también decrece y la 
saturación de agua aumenta. Un valor de corte de saturación de agua que se considera 
promedio para que el yacimiento produzca es del 45 %. 
 
La permeabilidad depende principalmente del tamaño, del arreglo de los granos y del 
grado de cementación. 
 
La resistividad variará en función del tipo de fluido que exista en la roca. De igual forma, 
la propagación de las ondas acústicas dependerá del grano y tipo de fluidos. Si la roca es 
muy compacta, la velocidad de una onda de sonido será muy grande. Si la roca es muy 
porosa, o bien está fracturada, la velocidad disminuirá. 
 
Respecto a la radiactividad, este tipo de roca contiene muy poca. El aumento de ésta 
dependerá de la cantidad de lutita diseminada o laminar que tenga la roca. 
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Una característica importante en este tipo de yacimientos es la saturación de agua 
irreductible, la cuál se puede definir como aquella agua que no es posible extraerla de la 
roca por ningún medio, por las fuerzas de atracción que existen entre la roca y el fluido. 
Esto es, se refiere a la cantidad de agua que queda adherida en las paredes de los granos. 
 
Se puede decir que una arenisca es limpia si contiene menos del 15 % de arcilla(1) . 
 
CARBONATOS 
 
Son rocas de origen marino, formadas directa o indirectamente de animales y plantas, 
como corales, crinoides, moluscos, algas y protozooarios. Están constituidas de mineral 
de calcita. El espacio poroso que se origina en este tipo de rocas depende del ambiente en 
el tiempo de depósito, nivel de energía y por procesos orgánicos. 
 
En yacimientos comerciales, las porosidades en carbonatos varían de 4 a 40 %. Las 
relaciones de saturación de agua-porosidad son mucho más variables que en las areniscas. 
Existen carbonatos que son comerciales a un corte de saturación de agua del 70 %. 
 
Para poder determinar el corte de saturación de agua que se puede considerar como límite 
para que el yacimiento se pueda explotar, dependerá de las condiciones geológicas y 
económicas que existan en el lugar. 
 
Los tipos de porosidad que se puedan encontrar en rocas carbonatadas son: 

a) interparticular 
b) intraparticular 
c) transparticular 

 

 
Fig. I.3 Diferentes tipos de porosidad 
(1) Referencias al final. 
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Cada una de ellas reaccionará diferente cuando la sonda de un registro las detecte. 
 
Por otra parte, el arreglo del poro es importante para poder determinar si la roca pueda 
tener permeabilidad, siendo los arreglos más comunes: el regular, por textura y el 
irregular. 
 
Otro proceso que altera la porosidad es la dolomitización. En este caso se crea una 
estructura cristalina rígida que se resiste a la compactación y conserva la porosidad 
intercristalina. Por otra parte, favorece al fracturamiento de los yacimientos. 
 
Es común en este tipo de formaciones que se fracturen, esto se debe a que son frágiles 
cuando están sujetas a fuerzas tectónicas, o bien a profundidades mayores de 4000 m. Las 
fracturas no aumentan el volumen del poro, pero sí favorecen la permeabilidad. El 
fracturamiento está controlado por deformaciones estructurales. 
 
La resistividad variará de acuerdo con el tipo de roca; se puede comportar como una 
arenisca porosa, o bien, como un cuerpo compacto. Por lo regular tiende a aumentar. 
 
La velocidad de las ondas acústicas dependerá del cementante y del tipo de fluido. Son 
poco radiactivas, variando sus valores, en general, de 0 a 40 unidades API. 
 
I.2.- REGISTROS GEOFÍSICOS DE POZOS 
 
Los registros geofísicos de pozos, constituyen una de las informaciones básicas obtenidas 
durante la perforación de un pozo petrolero, ya que permiten determinar propiedades 
físicas de las rocas tales como litología, porosidad, permeabilidad, saturación de fluidos, 
etc.,  y por consiguiente su capacidad de producción de hidrocarburos y su calidad de 
rocas almacén y sello. 
 
También son considerados elementos indispensables en la interpretación geológica-
económica de áreas exploratorias, desarrollo de campos, caracterización de yacimientos y 
evaluación de reservas.  
 
Desafortunadamente, sólo algunos de estos parámetros petrofísicos pueden medirse 
directamente. En cambio, deben inferirse u obtenerse de la medición de otros parámetros 
físicos de las formaciones. Actualmente es posible medir una gran cantidad de 
parámetros que incluyen, entre otros: la densidad, el tiempo de tránsito, el potencial 
espontáneo, la radiactividad natural y el contenido de hidrógeno de la roca. 
 
La interpretación de registros es el proceso por el cual dichos parámetros medibles se 
traducen a los parámetros petrofísicos deseados de porosidad, saturación de 
hidrocarburos, permeabilidad, productividad, litología, etc. 
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Esta traducción se complica aún más debido al proceso de perforación en sí. Al perforar a 
través de una formación, los fluidos dentro de los poros de la roca que rodea al agujero 
pueden verse desplazados o contaminados debido a la invasión del fluido de perforación. 
Algunas veces, se puede hasta alterar la roca. 
 
Ya que se requieren los parámetros petrofísicos de la formación virgen y no contaminada, 
la herramienta de registros de pozos debería ser capaz de “ver” más allá de la zona 
contaminada en la región virgen; como alternativa, las técnicas de interpretación deben 
ser capaces de compensar el problema de la contaminación. 
 
En el registro de pozos, se utilizan ambos enfoques. Cuando las propiedades físicas de la 
medición lo permiten, se ha diseñado la herramienta a fin de que se obtenga una gran 
profundidad de investigación. Cuando las propiedades físicas de la medición impidan una 
investigación a nivel profundo, las técnicas de interpretación deben tomar en cuenta los 
problemas de invasión por el filtrado de lodo. 
 
El propósito de las diferentes herramientas de registro de pozos es proporcionar 
mediciones de las que sea posible obtener o inferir las características petrofísicas de las 
rocas del yacimiento. La meta de la interpretación cuantitativa  es proporcionar las 
ecuaciones y técnicas para que dichos cálculos puedan llevarse a cabo.  
 
 
APLICACIÓN DE LOS REGISTROS GEOFÍSICOS DE POZOS 
 

• Determinación de litología 
• Determinación de cuerpos permeables 
• Correlación y límites entre capas 
• Determinación cuantitativa de φ y sw 
• Determinación de contactos agua-hidrocarburos 
• Determinación de porosidad secundaria 
• Delineación de las características estructurales y sedimentarias 
• Volumen de arcilla y permeabilidad (K) 
• Diferenciación entre rocas duras y blandas 
• Salinidad del agua de formación 
• Discriminación entre capas acuíferas-petrolíferas 
• Pronósticos de fluidos a producir 
• Medida del diámetro del agujero 
• Determinación de calidad de cementación 
• Determinación de daños en tuberías 
• Localización de coples 
• Determinación de temperatura 
• Medidor de desviaciones 
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I.2.1.-REGISTRO DE POTENCIAL NATURAL (SP) 
 
La curva SP es un registro de la diferencia entre el potencial eléctrico de un electrodo 
móvil en el pozo y el potencial eléctrico de un electrodo fijo en la superficie en función 
de la profundidad, es decir, el potencial natural se desarrolla en el pozo como resultado 
de la diferencia de salinidad que existe entre el fluido de perforación y el agua de 
formación. 
 
Enfrente de lutitas, la curva SP por lo general, define una línea más o menos recta en el 
registro, que se llama línea base de lutitas. 
 
Enfrente de formaciones permeables la curva muestra deflexiones con respecto a la línea 
base de lutitas; en las capas gruesas estas deflexiones tienden a alcanzar una deflexión 
altamente constante, definiendo así una línea base de arenas. 
 
La deflexión puede ser a la izquierda (negativa) o a la derecha (positiva) dependiendo 
principalmente de las salinidades relativas del agua de formación y del filtrado del lodo. 
Si la salinidad del agua de formación es mayor que la del filtrado del lodo, la deflexión es 
a la izquierda. Si el contraste de salinidades es a la inversa, la deflexión es a la derecha. 
 

 
Fig. I.4 Deflexiones de la curva de potencial natural 
 
 
No se puede registrar una curva de SP en pozos llenos con lodos no conductivos, ya que 
éstos no proporcionan una continuidad eléctrica entre el electrodo del SP y la formación.  
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Las deflexiones de la curva del SP resultan de las corrientes eléctricas que fluyen en el 
lodo del pozo. Estas corrientes del SP se deben a fuerzas electromotrices en las 
formaciones que tienen un origen electrocinético y electroquímico. 
 

 
                                                          Fig. I.5 Curva de SP 
 
Componente Electroquímico del SP 
 
Considérese una formación permeable con capas gruesas de lutitas tanto en la parte 
superior como en la parte inferior; supóngase también que los dos electrolitos presentes, 
filtrado del lodo y agua de formación intersticial, sólo contienen cloruro de sodio (NaCl). 
Debido a la estructura laminar de la arcilla y a las cargas en las láminas, las lutitas son 
permeables a los cationes Na 

+ pero impermeables a los aniones Cl- . Sólo los cationes Na 
+ (cargas positivas) pueden moverse a través de la solución de cloruro de sodio más 
concentrada a la menos concentrada. Este movimiento de iones cargados constituye una 
corriente eléctrica y la fuerza que causa que se muevan constituye un potencial a través 
de la lutita. 
Otro componente del potencial electroquímico se produce en el límite de la zona 
invadida, donde el filtrado del lodo y el agua de formación están en contacto directo. 
Aquí, los iones Na 

+ y Cl- pueden moverse de cualquiera de las soluciones a la otra. Como 
los iones Cl- tienen una movilidad mayor que los iones Na 

+, el resultado neto de esta 
difusión de iones es un flujo de cargas negativas (iones Cl-) de la solución más 
concentrada a la menos concentrada. 
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Componente Electrocinético del SP 
 
Se produce cuando un electrolito fluye a través del medio poroso, permeable y no 
metálico. La magnitud del potencial electrocinético se determina por varios factores, 
entre los que se encuentran la presión diferencial que produce el flujo y la resistividad del 
electrolito. 
 
La Curva de Potencial Natural permite: 

• Determinar cuerpos permeables 
• Determinar los límites entre capas 
• Correlacionar estratos 
• Determinar valores de Resistividad del agua intersticial de las formaciones 
• Conocer cualitativamente el contenido arcilloso de una capa 

 
Anomalías en el SP 
 
Algunas veces una señal de baja amplitud de onda sinusoidal queda superpuesta en el SP; 
esto sucede cuando una parte móvil del malacate se magnetiza accidentalmente. Un 
contacto intermitente entre la cubierta y la armadura del cable puede causar también 
picos falsos en la curva de SP. 
A veces es difícil registrar un buen SP en plataformas marinas o en embarcaciones, los 
barcos que pasan instrumentos de protección catódicos y fuentes de energía que puede 
escapar, pueden contribuir a un registro de SP dudoso. En tierra, la proximidad a líneas 
de energía o a pozos de bombeo puede tener un efecto similar en la curva de SP. 
 
 

I.2.2.-REGISTRO DE RAYOS GAMMA (GR) 
 
Es un registro de radioactividad de las rocas, producto de la desintegración natural de las 
pequeñas cantidades de elementos radioactivos (la radioactividad que se detecta es la 
producida por la desintegración del potasio 40 y las series del uranio y thorio, de estas 
tres posibles fuentes de radiación, el potasio 40 está presente en rocas de grano fino como 
lutitas y arcillas). 
 
Los elementos radioactivos tienden a concentrarse como ya se mencionó anteriormente 
en arcillas y lutitas, mientras que las formaciones limpias tienen normalmente un nivel 
bajo de radioactividad (arenas, areniscas, calizas y dolomías), a menos que contaminantes 
radioactivos como cenizas volcánicas o residuos de granito estén presentes o que las 
aguas de formación contengan sales radioactivas disueltas. 
 
Este registro se puede tomar simultáneamente con otros, ya sean también radioactivos o 
de resistividad, puede ser corrido en pozos entubados lo que hace muy útil como una 
curva de correlación en operaciones de terminación o modificación de pozo.  
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Este registro normalmente se presenta en la pista izquierda del registro. En escala “API” 
incrementándose la radioactividad  de izquierda a derecha.; también es utilizado para 
complementar el registro de SP y como sustituto para la curva SP en pozos perforados 
con lodo salado, aire o lodos base aceite. En cada caso es útil para la localización de 
capas con y sin arcilla y, lo más importante, para la correlación. 
 
Los rayos gamma son erupciones de ondas electromagnéticas de alta energía que son 
emitidas espontáneamente por algunos elementos radioactivos. Casi toda la radiación 
gamma en la tierra es emitida por el isótopo radioactivo de potasio de peso atómico 
cuarenta y por elementos radiactivos de la serie uranio y thorio. Cada uno de estos 
elementos emite rayos gamma cuyo número y energía son  distintivos de cada elemento. 
El potasio K40 emite rayos gamma de un solo nivel de energía (de 1.46 mev.) mientras 
que las series del uranio y torio emiten rayos gamma de varios niveles de energía.  
 
Todas las rocas contienen cierta cantidad de material radioactivo que emite rayos gamma. 
Si la curva de SP no proporciona buena resolución, la de rayos gamma es de mucha 
utilidad; por ejemplo, en formaciones de alta resistividad, como son los sedimentos 
carbonatados. 
 
Factores que influyen sobre el registro de rayos gamma 
*  Arcillosidad ↑                       Radioactividad ↑ 
*  Densidad de las rocas ↑        Radioactividad ↓ 
*  Diámetro del agujero ↑         Radioactividad ↓ 
*  Densidad del lodo ↑              Radioactividad ↓ 
 

 
Fig. I.6 Presentación del registro GR 
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APLICACIONES 
 
El registro de rayos gamma es particularmente útil para definir las capas arcillosas 
cuando el SP está distorsionado (en formaciones muy resistivas), cuando el SP es 
insignificante (en formaciones que llevan agua dulce o en lodo salado; es decir cuando 
Rmf ≈ Rw ); o cuando el SP no se puede registrar ( en lodo no conductivo, pozos vacíos o 
perforados con aire o en pozos revestidos). Se toma el límite de la capa en un punto 
intermedio entre la deflexión máxima y la mínima de la anomalía. 
 
El registro de rayos gamma refleja la proporción de arcilla y, en muchas regiones, se 
puede utilizar cuantitativamente como un indicador de la arcillosidad. También se emplea 
para la detección y evaluación de minerales radioactivos como potasio o uranio. El 
registro de rayos gamma también se puede utilizar para delinear minerales no 
radioactivos. 
 
Otros usos del registro de rayos gamma: 

- identificación de la litología 
- evaluación de la arcillosidad (cuantitativa) 
- evaluación de deposición de materiales radioactivos 
- correlación de profundidad 
- identificación de disparos 
- detección e identificación de flujos 
- estructura del medio poroso 

 
I.2.3.- REGISTRO DE ESPECTROSCOPIA DE RAYOS GAMMA (NGS) 
 
Al igual que el registro de rayos gamma, el NGS o registro de espectroscopia  de rayos 
gamma naturales mide la radioactividad natural de las formaciones. A diferencia del 
registro de rayos gamma que sólo mide la radioactividad total, este registro mide el 
número de rayos gamma y el nivel de energía de cada uno y permite determinar las 
concentraciones de potasio, torio y uranio radioactivos en la formación. 
 
Los tres elementos radioactivos medidos por el NGS en diferentes partes del yacimiento. 
Si se conoce la litología, se puede deducir más información: 
 
 
 
 
En Carbonatos: 

• Uranio →  indica presencia de fosfatos, materia orgánica, etc. 
• Torio →  indica el contenido de arcilla 
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• Potasio →  indica el contenido de arcilla y evaporizas radioactivas 
En Arenas: 

• Torio →  indica el contenido de arcillas y minerales pesados 
• Potasio → indica la presencia de micas y feldespatos 

 
 
En Lutitas: 

• Uranio → nos da una idea del origen de las rocas 
• Torio → indica la cantidad de material detrítico o el grado de material arcilloso 
• Potasio → indica el tipo de arcilla y mica  

 
Además de las concentraciones de los tres elementos radioactivos individuales, una curva 
de rayos gamma total se registra y se presenta en la pista 1. La respuesta total se 
determina por medio de una combinación lineal de las concentraciones de potasio, torio y 
uranio.  

 
Fig. I.7 Presentación del registro de Espectroscopia de rayos gamma con las curvas de concentraciones de 
torio, uranio y potasio (derecha) 
 
Las concentraciones de torio y uranio se presentan en partes por millón (ppm) y la 
concentración de potasio en porcentajes (%). Esta curva estándar se expresa en unidades 
API. Si se desea, también se puede proporcionar una medición “libre de uranio” (CGR) 
que sólo es la suma de los rayos gamma del torio y del potasio. 
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I .2.4.-REGISTRO DE DENSIDAD (FDC) 
 
El dispositivo de medición es un patín pegado a la pared y cuenta con una fuente de rayos 
gamma y dos receptores. El flujo de rayos gamma en los receptores es función de la 
densidad electrónica de la matriz de la roca. Con este registro se determina 
indirectamente la densidad de la roca. 
Es uno de los registros llamados de pared y puede tomarse tanto en agujeros llenos con 
lodo como en agujeros vacíos. No puede usarse en agujero entubado.  
 
 

 
Fig. I.8 Herramienta del registro de densidad 
 
El registro de densidad es un registro radioactivo que mide la densidad total de la 
formación con base en el fenómeno Compton (transferencia de una parte de la energía de 
un rayo gamma a un electrón, al momento de chocar ambos). 
 
Se bombardean rayos gamma a la formación y son dispersados por los electrones de los 
átomos del material, perdiendo energía. Si el material es muy denso (contiene muchos 
electrones) los rayos gamma introducidos a la formación son esparcidos más, es decir 
existen más choques; por lo que la mayor cantidad de ellos son absorbidos y pocos llegan 
al detector de la sonda. 
 
En formaciones con pocos electrones (menor densidad) los rayos gamma no pierden tanta 
energía por lo que pocos son absorbidos y muchos llegan al detector.  
 
La densidad de las formaciones se relaciona con la porosidad; esto es, a densidades altas 
corresponden porosidades bajas y viceversa, para una litología conocida. En este registro 
las lutitas generalmente muestran densidades medias a altas (baja porosidad). 
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Fig. I.9 Presentación del registro de Densidad 
 
La información del registro se presenta como se muestra en la figura. La curva de 
densidad total se registra en las curvas 2 y 3 con una escala de densidad lineal en gramos 
por centímetro cúbico. 
 
Aplicaciones 
 
Los registros de densidad se usan principalmente como registros de porosidad. Otros usos 
incluyen identificación de minerales en depósitos de evaporitas, detección de gas, 
determinación de la densidad de hidrocarburos, evaluación de arenas con arcilla y de 
litologías complejas, determinación de producción de lutitas con contenido de aceite, 
cálculo de presión de sobrecarga y propiedades mecánicas de las rocas. 
 
Porosidad a partir del registro de Densidad 
 
Para una formación limpia con una matriz de densidad conocida ρma, que tenga una 
porosidad φ, que contenga un liquido de densidad promedio ρf, la densidad total de la 
formación ρb, será: 
 
 
ρb = φ * ρf  (1-φ)* ρma ………………………………………………………………1.1 
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Para fluidos usuales en poros (excepto gas e hidrocarburos ligeros) y para minerales 
comunes de las matrices de yacimiento, la diferencia entre la densidad aparente ρa, que 
lee el registro de densidad y la densidad total, ρb, es tan pequeña que no se toma en 
cuenta. De la ecuación anterior se extrae la porosidad: 
 
φ = ρma  -  ρb  /  ρma  -  ρf ……………………………………………………………1.2   
 
 
I .2.5.-REGISTRO NEUTRÓN (CNL) 
 
 
El registro Neutrón se utiliza principalmente para delinear formaciones porosas y para 
determinar su porosidad. Responden principalmente a la cantidad de hidrógeno en la 
formación. Por lo tanto, en formaciones limpias cuyos poros estén saturados con agua o 
aceite, el registro de neutrones refleja la cantidad de porosidad saturada de fluido. 
 
Las zonas de gas con frecuencia pueden identificarse al compararse el registro neutrón 
con otro registro de porosidad o con un análisis de muestras. Una combinación del 
registro neutrón con uno o más registros de porosidad proporciona valores de porosidad e 
identificación de litologías aún más exactos, incluso una evaluación del contenido de 
arcilla. 
 
Las herramientas actuales emplean fuentes de americio-berilicio (AmBe) para proveer 
neutrones con energías iniciales de varios millones de electrón voltios. 
Por medio de una fuente radioactiva, colocada en la sonda, se emiten neutrones con alta 
energía (alta velocidad) a la formación. Estos neutrones chocan con átomos de los 
materiales existentes en la formación y se desaceleran (pierden energía) hasta alcanzar en 
muy poco tiempo un estado tal que se mueven al azar, sin ganar ni perder energía. En este 
estado, llamado térmico, los neutrones son capturados por varios materiales. 
 
Al momento de la captura, el núcleo capturante se excita intensamente y emite un rayo 
gamma de captura que es registrado por el contador colocado, también en la sonda, a 
cierta distancia de la fuente. Dependiendo del tipo de sonda, se registran los rayos gamma 
de captura ó los neutrones mismos. 
 
Los neutrones son partículas eléctricamente neutras, cuya masa es igual a la masa del 
átomo de hidrógeno. La mayor pérdida de energía del neutrón ocurre cuando choca con 
un núcleo con masa prácticamente igual a la suya, esto es, con un núcleo de hidrógeno, 
por lo que la desaceleración de neutrones depende grandemente de la cantidad de 
hidrógeno en la formación. 
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El registro neutrón mide el contenido de hidrógeno en la formación. En una formación 
limpia, el hidrógeno se encuentra sólo en el agua y el aceite. Ambos fluidos contienen 
aproximadamente la misma cantidad de hidrógeno. 
 
 
Cuando la concentración de hidrógeno en el material que rodea la fuente de neutrones es 
grande, la mayor parte de los neutrones se desaceleran y se capturan a corta distancia de 
la fuente. Si la concentración de hidrógeno es pequeña, los neutrones viajan más distancia 
antes de ser capturados. De acuerdo con esto, el ritmo de conteo o registro en el contador 
se incrementa cuando disminuye la concentración de hidrógeno y viceversa. 
 

  
 Fig. I.10 Presentación del registro Neutrón  
 
 
Aplicaciones 
 

• delinear formaciones porosos y determinar su porosidad 
• determinar zonas con gas 
• interpretación de litología 

 
 Relación de respuesta sobre  el registro neutrón 
 
φN ≈ φe     →  Formaciones limpias 
 
φN ≈ φe + Vcl * φNcl ……………………………………………………………………1.3 
 
φe = φN - Vcl * φNcl  →  Corregida por arcillosidad 
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I .2.6.-REGISTRO SÓNICO (BHC) 
 
En su forma más sencilla, una herramienta sónica consiste de un transmisor que emite 
impulsos sónicos y un receptor que capta y registra los impulsos, la velocidad del sonido 
en la sonda sónica y en el lodo de perforación es menor que en la formación; 
consecuentemente, los primeros arribos de energía acústica a los receptores corresponden 
a recorridos del sonido dentro de la formación cerca de la pared del pozo. Por lo tanto, el 
diámetro de investigación del registro sónico es de pocas pulgadas. 
 
El registro sónico es simplemente un registro en función del tiempo, t, que requiere una 
onda sonora para atravesar un pie de formación. Este es conocido como tiempo de 
tránsito, ∆t; t es el inverso de la velocidad de la onda sonora. El tiempo de tránsito para 
una formación determinada depende de su litología y su porosidad. Cuando se conoce la 
litología, esta dependencia de la porosidad hace que el registro sónico sea muy útil como 
registro de porosidad. 
 
Los tiempos de tránsito sónicos integrados también son útiles al interpretar registros 
sísmicos. 
 
Cuando un transmisor es activado por un pulso, este genera una onda de sonido la cuál 
penetra la formación. Se mide el tiempo transcurrido entre la detección del primer arribo 
a los dos receptores correspondientes, los transmisores son activados alternativamente. 
Los valores de ∆t son promediados automáticamente en superficie. 
 
El tiempo de tránsito por lo general se registra en una escala lineal en las pistas 2 y 3 
(figura 1.11) medida en microsegundos por cada pie.  
 
En formaciones sedimentarias, la velocidad del sonido depende de muchos parámetros; 
principalmente, depende del material de la matriz de roca (arenisca, caliza, dolomita) y de 
la distribución de la porosidad (principalmente de la porosidad primaria). 
 
Experimentos en laboratorio por Wyllie llegó a la conclusión de que en formaciones 
limpias y consolidadas con pequeños poros distribuidos uniformemente, existe una 
relación lineal entre la porosidad y el tiempo de tránsito. 
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Fig. I.11 Presentación del registro Sónico  
 
 
Relación ∆t - φ 
 

- estudios en laboratorio (Wyllie) 
- relación lineal entre ∆t y porosidad (ecuación de promedio de tiempo) 

 
∆t medido = ∆t fluido *  φ * + ∆t matriz  * (1-φ)        por lo que : 
 
φ = ∆t log - ∆t matriz  / ∆t fluido - ∆t matriz ………………………………………………1.4   
 
Bajo las siguientes condiciones: 

• porosidad intergranular uniforme 
• agua en los poros 
• formación limpia sin arcilla 
• formación compactada 
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I .2.7.-REGISTROS DE RESISTIVIDAD 
 
La resistividad de la formación es un parámetro clave para determinar la saturación de 
hidrocarburos. La electricidad puede pasar a través de una formación sólo debido al agua 
conductiva que contenga dicha formación. Con muy pocas excepciones, como el sulfuro 
metálico y el grafito, la roca seca es un buen aislante eléctrico. Además, las rocas 
perfectamente secas rara vez se encuentran. Por lo tanto, las formaciones subterráneas 
tienen resistividades medibles y finitas debido al agua dentro de sus poros o al agua 
intersticial absorbida por una arcilla. 
 
La resistividad de una formación depende de: 

• la resistividad de agua de formación 
• la cantidad de agua presente 
• la geometría estructural de los poros 

 
La resistividad de una sustancia, es la resistencia medida entre lados opuestos de un cubo 
unitario de la sustancia a una temperatura específica. El metro es la unidad de longitud y 
el ohmio es la unidad de resistencia eléctrica. 
 
Las resistividades de formación por lo general varían de 0.2 a 1000 ohm-m. 
Resistividades superiores a 1000 ohm-m son poco comunes en formaciones permeables 
pero se observan en formaciones impermeables de muy baja porosidad. (por ejemplo las 
evaporitas). 
 
Clasificación de Registros de Resistividad  
 

- Micro Esférico Enfocado (SFL) } Rxo 
- Microlaterolog (MSFL) } Rxo 
- Doblelaterolog (DLL) } Rt 
- Inducción } Rt 

 
 
I .2.7.a.-REGISTRO ESFÉRICO ENFOCADO(SFL) 
 
El instrumento SFL (herramienta que mide la conductividad de la formación cerca del 
pozo y difiere de anteriores instrumentos con electrodos de enfoque, ya que establece en 
esencia esferas de potencial constante alrededor del electrodo de corriente)  y proporciona 
la investigación a un nivel relativamente poco profundo, que es requerida para evaluar los 
efectos de la invasión en mediciones de la resistividad de mayor profundidad. Es el caso 
del instrumento de espaciamiento corto que ahora se utiliza en la herramienta 
DIL(herramienta utilizada por el registro de doble inducción laterolog)-SFL, desarrollado 
para reemplazar la normal de 16 pulgadas y los dispositivos LL8. 
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El SFL puede preservar la distribución de potencial esférico en la formación a pesar de 
una gran cantidad de variables de pozo. 
 
El lodo del pozo, las capas adyacentes y la zona invadida influyen sobre las lecturas del 
laterolog y del SFL, como a la mayoría de las mediciones de resistividad. Se han 
preparado cartas en base a simulaciones matemáticas para corregir dichas influencias en 
las lecturas del registro. Las correcciones siempre se harán en este orden: efecto de pozo, 
espesor de capa e invasión. 
 
I .2.7.b.-REGISTRO MICROLATEROLOG(MSFL)  
 
La herramienta microlaterolog se diseñó para determinar de manera precisa Rxo con 
valores más altos de Rxo/ Rmc donde la interpretación de la herramienta microlog carece 
de resolución. 
 
Pruebas de laboratorio y resultados simulados en computadora han demostrado que la 
formación virgen, de hecho, no presenta ninguna influencia sobre las lecturas de 
microlaterolog si la profundidad de investigación rebasa de 3 a 4 pulgadas. 
 
La influencia del enjarre no reviste interés si esta es menor a 3/8 de pulgada, pero cobra 
importancia en espesores mayores. 
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Fig. I.12 Presentación de los registros de resistividad somera (LLS) y profunda (LLD) 
 
I .2.7.c.-REGISTRO DOBLE LATEROLOG (DLL) 
 
El objetivo de todos los instrumentos de resistividad para lectura profunda es medir la 
resistividad real de la formación, Rt. Se diseñaron dichos instrumentos de manera que, 
hasta donde sea posible, su respuesta se vea determinada por la resistividad de la 
formación virgen (más allá de la zona invadida). Por desgracia, ninguna medición ha sido 
capaz de eliminar por completo los efectos de la zona invadida. 
 
Una solución es medir la resistividad con diferentes arreglos que tengan diferentes 
profundidades de investigación. En general, las mediciones que responden a tres 
profundidades de investigación elegidas de manera adecuada, se aproximan al registro de 
la invasión de una manera que permite determinar Rt. 
 
Para obtener una mayor exactitud en la interpretación, una combinación en las 
características debería ser requerida: 

• Los efectos del agujero deben ser pequeños y/o corregibles 
• Las resoluciones verticales de los instrumentos deben ser similares 
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• Las investigaciones radiales deben encontrarse bien distribuidas; esto es, una 
lectura debe ser tan profunda como práctica, otra será poco profunda y una tercera 
se hará entre ambos extremos. 

 
Esto provocó el desarrollo de la herramienta doble laterolog DLLMicroSFL con 
mediciones simultáneas. La siguiente figura es un esquema de la herramienta que muestra 
la disposición de los electrodos utilizada por los dos instrumentos laterolog. Ambos usan 
los mismos electrodos y tienen el mismo espesor de haz de corriente, pero tienen un tipo 
de enfoque diferente para proporcionar sus diferentes características sobre profundidad de 
investigación. 

 
Fig. I.13 Herramientas utilizadas para la medición en registros de resistividad 
 
La herramienta DLL tiene una respuesta que va de 0.2 a 40.000 ohm-m, rango mucho 
más amplio que aquel que cubren los instrumentos laterolog anteriores. 
 
La medición del laterolog profundo (LLD) de la herramienta DLL posee una profundidad 
de investigación mayor que las herramientas laterolog anteriores y se extiende a una 
gama de condiciones de la formación en donde es posible determinar de manera confiable 
Rt. 
 
Para lograr esto, se requieren electrodos de guardia muy grandes. La distancia entre los 
extremos de los electrodos de guardia de la herramienta DLL-Rxo es de aproximadamente 
28 pies. Sin embargo, el espesor nominal del haz de 2 pies asegura una buena resolución 
vertical. 
 
La medición del laterolog somero (LLS) tiene la misma resolución vertical del 
instrumento laterolog profundo (2 pies), pero responde de manera más pronunciada a la 
región alrededor del agujero afectado por la invasión. Utiliza un tipo de enfoque llamado 
pseudolaterolog por el cuál la corriente de enfoque regresa a los electrodos remotos. Esto 
provoca que la corriente de medición se disperse más rápidamente una vez que ha entrado 
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a las formaciones. Así, se produce una profundidad de investigación relativamente 
somera. 
 
I .2.7.d.-REGISTRO DE INDUCCIÓN (1-ES) 
 
La herramienta de registro de inducción se desarrolló en principio para medir la 
resistividad de la formación en pozos que contienen lodos con base aceite y en agujeros y 
en agujeros perforados reumáticamente. Los instrumentos de electrones no funcionan en 
lodos no conductivos. Los intentos de utilizar electrodos para registrar en esos tipos de 
fluido, no resultaron satisfactorios. 
 
Con la experiencia pronto se demostró que el registro de inducción tenía muchas ventajas 
sobre el registro convencional ES cuando se aplicaba en pozos de registro perforados con 
lodos en base agua. Diseñados, para una investigación profunda, los registros de 
inducción pueden enfocarse con el propósito de minimizar las influencias del agujero, las 
formaciones adyacentes y la zona invadida. 
 
Las herramientas de inducción en la actualidad poseen muchas bobinas transmisoras y 
receptoras. Sin embargo, puede comprenderse el principio al considerar una sonda con 
una sola bobina transmisora y otra receptora. 
 
La herramienta de inducción funciona mejor cuando el fluido del pozo es aislante, incluso 
aire o gas. La herramienta también trabaja bien cuando el agujero contiene lodo 
conductivo, a menos que este sea demasiado salado, las formaciones muy resistivas, o el 
diámetro muy grande. 
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               Fig. I.14 Registro de Inducción   
 
 
I.3.-CORRECCIÓN DE LA INFORMACIÓN EN LOS REGISTROS                
GEOFÍSICOS DE POZOS 
 
Durante el proceso de perforación las rocas son alteradas por la trituración y por el tipo 
de fluido que sirvió como lubricante, ocasionando en las formaciones porosas y 
permeables infiltraciones del fluido de perforación. En muchos de los casos, la 
infiltración o invasión proporciona bastante información que servirá para la interpretación 
de los datos obtenidos en el registro. Generalmente un pozo se perfora con lodo, que tiene 
la función principal de ser lubricante y servir de peso para contrarrestar la presión 
hidrostática. La manera en que se perfora un pozo afecta las condiciones de medición del 
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registro, particularmente en la resistividad del fluido de la formación, diámetro del 
agujero e invasión del filtrado del lodo en la vecindad del pozo. 
 
Desviación del agujero  
 
La mayoría de los pozos se perforan verticalmente. Sin embargo, aún los pozos verticales 
tienen desviaciones de 1 ó 2 grados; variaciones mayores de 5 grados ocurren a menudo 
en pozos marinos. Pozos perforados con poca inclinación (3 grados o menos) tienden a 
formar espirales y los pozos con ángulos mayores de 5 grados forman un arco. La 
desviación ocurre más fácilmente donde la barrena atraviesa una secuencia de capas de 
diferente consistencia. Se sabe que la desviación está controlada por la rigidez del equipo 
en la base del agujero. Puede esperarse que diámetros de agujero pequeños se desvíen 
más que los grandes, esto se debe a que los conectores entre los segmentos de los tubos 
son más flexibles. 
 
Durante una segunda operación en el mismo agujero, a veces sucede que la barrena no 
sigue el curso original del pozo. Esto puede dificultar la localización del agujero original 
y el perforador puede optar por continuar con una nueva dirección. Algunas veces se 
puede cementar uno de los dos agujeros, en otras no. 
 
Cualquiera que sea la causa, las condiciones que se crearon puede confundir la corrida de 
los registros. La sonda puede irse por el camino no deseado. 
 
Perforación Direccional 
 
Existen muchas razones para controlar el curso de un pozo, cuando no es totalmente 
vertical, a una profundidad específica. Muchos pozos perforados en plataformas marinas 
son desviados a propósito con el objetivo de utilizar una sola plataforma y no colocar 
varias. Desde el punto de vista de los registros, estos se pueden correr, pero hay que tener 
cuidado porque el espesor de los estratos puede parecer mayor si no se verticaliza el 
pozo. 
 
Elevación de la mesa rotaria 
 
Las profundidades de los registros están referidas a la elevación de la mesa rotaria (Kelly 
Bushing)  a menos de que la barrena se mueva; en este caso, la profundidad del registro 
debe de referirse al nivel de la superficie del terreno. 
 
Es conveniente que el analista de registros conozca las condiciones en que se perforó el 
pozo para realizar las correcciones pertinentes. 
 
Efectos de la perforación 
 

a) tamaño del agujero 
En formaciones arenosas, el diámetro del agujero disminuye por el hecho de que 
cierta cantidad del fluido que contiene el lodo (filtrado del lodo) penetra a la 
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formación desplazando a los fluidos que se encuentran en ésta. La pared del pozo 
actúa como colador, impregnándose la parte sólida del lodo sobre la superficie, con lo 
cuál se forma una capa llamada enjarre que ocasiona la disminución del diámetro del 
pozo. 
 
En la respuesta de la herramienta, a mayor diámetro de agujero habrá mayor volumen 
del lodo alrededor de la herramienta; esto puede ocasionar que la señal inducida no 
penetre completamente a la formación y que la señal natural se distorsione. 
 
b) tipo y densidad del lodo 
Los registros funcionan de acuerdo con el tipo de lodo. Por un lado, las señales 
acústicas se transmiten pobremente en un agujero lleno de aire y a la vez la corriente 
eléctrica no se conduce en aire o aceite; un lodo salado afectará la señal de la 
conductividad en el registro de inducción; por otro lado, las herramientas enfocadas 
de resistividad superan esta limitación y dan buenos resultados. La salinidad del lodo 
afecta a la conductividad, resistividad e índice de hidrógeno. 
 
Por lo que respecta al tipo del lodo, el agua es el fluido más utilizado, aunque el 
aceite y gas también se ocupan. Otros materiales se agregan al fluido base para darle 
peso, viscosidad y enjarre. La viscosidad se controla agregando bentonita u otras 
arcillas. El tamaño de las partículas ó el volumen de barita determinan la densidad del 
fluido. Sales y componentes orgánicos se agregan para reducir los posibles derrumbes 
de las lutitas, minimizar la disolución de la sal o anhidrita, y controlar las propiedades 
de los fluidos a altas presiones y temperaturas. 
 
La densidad del lodo se controla, para mantener la presión en el fondo del agujero lo 
suficientemente alta, de tal forma que los fluidos de la roca no entren en el agujero. 
Cerca de la superficie es posible perforar con agua o aún con aire, pero a medida que 
se profundiza, se requiere de un fluido más pesado. 
 
A altas densidades aumenta el riesgo de que la roca se fracture y se adhiera a la 
tubería. La densidad del lodo aumenta naturalmente a medida que las partículas de 
diámetro pequeño se incorporan al lodo. Si la presión en el agujero disminuye 
respecto a la de formación, se le agrega barita. Un lodo de alta densidad en el agujero 
aumenta la flotabilidad de la sonda de registro, de tal manera que deben agregarse 
contrapesos para transportarla al fondo del agujero. En agujeros de diámetros 
pequeños y altamente inclinados, se vuelven más difíciles las operaciones del manejo 
de los fluidos. La alta densidad de la barita ocasiona que los rayos gamma se atenúen 
bastante. 
 
c) Invasión del filtrado del lodo 
La respuesta de las formaciones porosas y permeables a la invasión depende de la 
calidad, tipo de lodo utilizado y de las formaciones perforadas. Frecuentemente 
ocurre que en formaciones de alta porosidad con alta saturación de hidrocarburos, 
dentro de la zona invadida, el filtrado desplaza más rápido al hidrocarburo que al 
agua. Esto crea un anillo con una resistividad menor que Rxo o Rt . 
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Es recomendable que exista un contraste entre las resistividades del filtrado de lodo 
Rmf y la resistividad del agua Rw para apreciar la diferencia en las lecturas de 
resistividad en las curvas que detectan la zona lavada, de transición y la zona virgen 
como se muestra en la siguiente figura: 
 

 
Fig. I.15 Esquema que representa el modelo de invasión en una formación 
 
 
 
d) Diámetro de la herramienta y excentricidad 
Existe un diámetro mínimo por el cuál la herramienta puede pasar a través del 
agujero. Para cada herramienta se tiene un rango de diámetro apropiado para 
diferentes tamaños de agujero. 
La herramienta de registro puede tomar tres posiciones relativas respecto al agujero: 
centrada, descentrata (standoff) y pegada a la pared. 
 
La posición correcta de la herramienta es obligatoria para realizar algunas medidas. 
Se asegura por medios mecánicos, uno o varios centralizadores (como el caso de la 
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BHC), un patín (CNL,FDC). El registro de inducción a menudo requiere de stand off. 
El posicionamiento se vuelve aún más importante en pozos desviados, donde la sonda 
tiende a acomodarse a lo largo del lado más bajo del agujero. 
 

 
Fig. I.16 Grado de excentricidad de una sonda  
 
e) Resolución vertical 
Una secuencia sedimentaria consta de una serie de capas de varios espesores que 
difieren en sus propiedades litológicas y petrofisicas. En teoría cada capa puede 
distinguirse de sus vecinas por su comportamiento en el registro. Esto generalmente 
sucede cuando las capas son gruesas. 
 
Las capas delgadas presentan un aspecto diferente. Se requiere que exista un contraste 
muy grande entre la litología, las características de diseño de la herramienta y la 
velocidad de medición de la sonda. 
 
La identificación de una capa a través de una secuencia sedimentaria depende de un 
número de factores que son diferentes para cada herramienta, entre los que se puede 
distinguir: 
• Espesor de las capas 
• Geometría de la herramienta 
• Contraste de lecturas en la capa y sus capas vecinas, etc. 
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La identificación de la capa puede estar afectada por la constante de tiempo y la 
rapidez de obtención del registro. Si los límites de las capas no son agudos, entonces 
existe una zona de transición gradual entre las lecturas. La pendiente de la zona de 
transición afecta la resolución de la capa. 
 
 
 
f) Rapidez del registro 
No es la misma para todas las herramientas. Los fenómenos naturales y de inducción 
por radioactividad son aleatorios, requieren de la acumulación de datos tomados sobre 
un periodo de tiempo y calcular la media para obtener una lectura representativa. Esta 
acumulación ó periodo de muestreo corresponde a la constante de tiempo. 
 
La constante se cambia de acuerdo con la relación del nivel de conteos y a la 
precisión deseada. La constante se ajusta de manera que la herramienta viaja 30 cm 
en un periodo de tiempo constante (véase la siguiente tabla) 
 

EQUIPO RAPIDEZ (velocidad de medición) 
(m/min) 

SP 30 
IL 30 
Laterolog 15 
MLL 10 
Neutrón 9 
GR 6 
FDC 4.5 
TDT *  
BHC 20 
Amplitud del agujero 10 

Tabla I.3.1 Rapidez máxima recomendada para obtener los registros 
 
* TDT es una herramienta que detecta el número de rayos gamma de captura de baja 
energía de neutrones termales. 
  
Otros factores que limitan la rapidez del registro son: 
- la inercia del galvanómetro 
- tensión del cable 
- daño al equipo del tipo de almohadilla 

 
I .3.1.-CORRECCIONES A LOS REGISTROS DE RESISTIVIDAD 
 
Como en el caso de todas las mediciones de resistividad, el agujero, las capas adyacentes 
y la invasión de filtrado pueden afectar las lecturas de inducción. Deben corregirse estos 
efectos en el registro de inducción antes de poder utilizar las mediciones. Ya que los 
registros de inducción se han diseñado de manera específica para minimizar dichos 
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efectos, estos por lo general no son grandes y , en muchos casos pueden ignorarse sin 
mayores consecuencias. A pesar de todo, es aconsejable llevar a cabo dichas correcciones 
ambientales. Hay tres casos: corrección de agujero, de capa adyacente y de invasión.  
 

a) Corrección por efecto del agujero 
 Es posible evaluar las señales de conductividad provenientes del lodo al utilizar 
factores geométricos. Algunas veces, la señal nominal del agujero, basada en el 
tamaño del pozo, se elimina durante la adquisición del registro. Cuando la señal del 
agujero es considerable, consúltese el encabezado del registro para verificar que dicho 
procedimiento se llevó a cabo. Esta precaución se aplica en especial a los 
instrumentos de inducción media, puesto que el tamaño del agujero influye en ellos 
en gran medida. 
El algoritmo de inducción Phasor (muestra los límites Rt/Rm para los cuáles pueden 
efectuarse correcciones en las mediciones de inducción media y profunda) para 
corrección por agujero incluye los datos para pozos grandes y los efectos para un gran 
standoff (distancia de la pared del pozo a la sonda, es decir que tan centrada se 
encuentra dicha sonda). 
 
 
b) Corrección de efecto de capa adyacente 
La necesidad de hacer correcciones para el caso de capas delgadas es reconocida, 
mientras que, no es bien reconocida la necesidad de corregir cuando el espesor de la 
capa se encuentra en un rango de 10 a 30 pies y la resistividad de la capa excede los 5 
ohm/m. 
 
c) Corrección por Invasión 

Las cartas para la corrección por invasión se derivan de consideraciones sobre factores 
geométricos. Si se toma un perfil escalonado de la invasión( es aquél en el que el filtrado 
del lodo empuja toda el agua de formación frente a él, como lo haría un pistón. 

 
 

 
I .3.2.-CORRECCIONES AL REGISTRO DE POTENCIAL NATURAL 
 
Es un registro muy útil para calcular la resistividad del agua de formación. Existen varios 
factores que la alteran: espesor de capa, resistividad del lodo de perforación a la 
temperatura del intervalo que se analizará, resistividad de la zona invadida Ri. La 
ecuación que involucra estos factores es: 
 
SSP = - K log aw/amf ……………………………………………………………….1.5 
 
Donde: 
aw y amf son las actividades químicas de las dos soluciones (agua de formación y filtrado 
de lodo) a temperatura de formación; K es un coeficiente proporcional a la temperatura 
absoluta y para soluciones de cloruro de sodio equivale a 71 @ 25°C. 
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La actividad química de una solución es aproximadamente proporcional a su contenido 
salino, es decir, a su conductividad. 
 
 
De otra forma: 
 
SSP = SP * 10P …………………………………………………………………………1.6 
 
P = 10(a + b log10 (Ri/Rm) + c log10)* espesor 
a = -0.4183 
b = 0.4831 
c = -1.3920 
Donde SSP es el potencial espontáneo estático y P es el factor de corrección que 
involucra a los factores que alteran la medida. 
 
 
I .3.3.-CORRECCIONES PARA EL REGISTRO DE RAYOS GAMMA 
 
Los factores que afectan la respuesta de la sonda de rayos gamma naturales son: tipo y 
longitud del detector, fluctuaciones estadísticas y constante de tiempo, velocidad del 
registro, efectos del agujero, espesor de la capa, tubería de ademe y cemento. 
 

a) Radio de investigación 
Como se ha visto, los rayos gamma son absorbidos o atenuados por el medio a través 
del cuál viajan, particularmente cuando su energía es baja o el medio es denso. 
Consecuentemente, una herramienta de radioactividad natural sólo detecta radiación 
originada a partir de un volumen relativamente pequeño que rodea al detector. 
 
b) Definición vertical 
Es igual al diámetro de la esfera de investigación y varía de acuerdo con la formación, 
las densidades y las energías de los rayos gamma detectados 
 
c) Factores que afectan la respuesta del registro 
1. Variaciones Estadísticas. Todos los fenómenos radioactivos en la naturaleza son 

aleatorios. Las relaciones de conteo varían alrededor de un valor medio y las 
cuentas deben de acumularse en un periodo de tiempo y promediarse para obtener 
una estimación razonable de la media. El periodo de acumulación es la constante 
de tiempo. La estimación de la media será más precisa cuanto mayor sea la 
relación de conteo y la constante de tiempo. 

2. Rapidez del Registro. La constante de tiempo introduce un retraso en la respuesta del 
registro obtenido respecto a los límites de las capas, porque el promedio de 
medición de los circuitos electrónicos requiere de un periodo finito de tiempo para 
responder completamente a un cambio en las relaciones de conteo. Después de 
atravesar un límite de capa, la respuesta medida alcanza el 97% del nuevo valor 
sólo después de un tiempo igual a 5T (donde T=Tiempo). 
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3. Condiciones del agujero. La relación se atenúa varios grados por la presencia del 
fluido del agujero, entubamiento, ademe y cemento. La posición de la herramienta 
en el agujero afecta la respuesta del registro. Se plantean algunos factores 
importantes: 

• Fluido del agujero. La influencia depende de : 
- su volumen. Por el tamaño del agujero o ademe 
- la densidad ( aire, agua, base aceite, contenido de sólidos) 
- su composición 

 
• Ademe. Depende de su espesor, densidad y naturaleza de los materiales 
• Cemento. Tipo, naturaleza de aditivos, densidad y espesor. 

 
4. Espesor de Capa. La curva de rayos gamma no alcanza su valor correcto en una 

capa cuyo espesor sea menor que el diámetro de la esfera de investigación. En una 
serie de capas delgadas, la lectura será el volumen  promedio de las 
contribuciones. Hallenburg (1973) proporciona una buena aproximación de las 
lecturas a través de la ecuación: 

 
Da = V1D1 + V2D2 + …………….+ VnDn …………………………………………1.7 
 
Donde Vi representa el volumen del Pe-ésimo subestrato y Di su nivel de energía de 
los rayos gamma. 
 

 
I .3.4.-CORRECCIONES PARA EL REGISTRO DE DENSIDAD 
 
Se ha visto que para una fuente y espaciamiento dados, los principales factores que 
alteran la medición son la masa y la relación Z/A (donde Z = número atómico y A = peso 
atómico). Como una primera aproximación (Z/A) se considera constante. La densidad 
global en la región de investigación depende de: 
 

• La densidad y el porcentaje de los diferentes contribuyentes mineralógicos de las 
rocas. 

• En el caso de las rocas porosas, la densidad de los fluidos y sus porcentajes en el 
yacimiento, porosidad y saturación de fluidos. 

 
Sin embargo una buena corrección implica que se debe tomar en cuenta la influencia 
(Z/A) cuando difiera de uno para aceite, gas y agua (ver la siguiente tabla) 
 
 
compuesto  ρb  ρe 
Cuarzo  2.654  2.650 
Calcita  2.71  2.71 
Dolomita  2.87  2.876 
Anhidrita  2.96  2.977 
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Silvita  1.984  1.863 
Halita  2.165  2.032 
Yeso  2.32  2.351 
Agua dulce  1.00  1.00 
Agua salada (200,000 ppm)  1.146  1.135 
Aceite  0.850  0.850 
Tabla I.3.2 Valores de densidad electrónica y volumétrica en algunos minerales comunes en las rocas 
 
Existen tres parámetros importantes que pueden influir en la medición, los cuáles se 
explican a continuación. 
 

a) lutitas. Si se trata de interpretar a la densidad en términos de porosidad, la 
influencia de la lutita en el registro de densidad es mucho menor que en los 
registros neutrón. La densidad de una arcilla seca es similar a la del cuarzo y tiene 
el mismo efecto en la matriz. En cualquier caso donde se realiza una 
interpretación para litología ó porosidad es preferible tomar en cuenta el efecto de 
la lutita; sobre todo si su densidad es muy diferente de los otros minerales que 
componen la roca. 

 
    ρbc = ρb + Vsh (ρma – ρsh ) ……………………………………………………………1.8 
 
donde: 
 
ρbc  = densidad de masa corregida por lutita 
ρb   = densidad de masa leída 
ρma  = densidad de masa de la matriz 
ρsh  = densidad de masa de la lutita 
Vsh  = porcentaje de lutita 
 

b) Agua. El fluido en la zona investigada por la herramienta es filtrado de lodo, si la 
roca es porosa. Como la densidad varía con la temperatura y presión como una 
función de la salinidad, es necesario hacer correcciones en la información. 

c) Hidrocarburos. La densidad de los hidrocarburos es menor que la del agua, lo cuál 
significa que en una misma formación llena de gas aparece mucho más ligera y 
por lo tanto más porosa que si estuviera saturada con agua. Existe un caso para 
realizar corrección por hidrocarburos cuando se determina la porosidad. 

d) Efectos ambientales: 
- Agujero. El efecto del agujero es fácilmente visto en los registros no compensados 

y es mucho menor en los compensados. 
- Diámetro del agujero. Su influencia en el registro es mucho mayor en agujeros de 

diámetros mayores a 10 pulgadas 
- Fluidos de perforación. Las correcciones para pozos con aire son más importantes 

que para pozos con lodos. Como el aire es menos denso se tienen muy pocos 
rayos gamma 
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- Rugosidad del agujero. Si la pared del agujero no es suave, el cojín del FDC no 
estará bien acoplado a la formación y afectará la respuesta del registro en aquellas 
zonas en donde haya presencia de lodo.  

- Ademe. El fierro absorbe rayos gamma, de aquí que cuando se usa este registro en 
pozos ademados, la cantidad de rayos gamma se reduce en el detector; por lo cuál 
no se recomienda correr estos registros en tales condiciones. 

- Invasión. Se ha visto que la invasión depende de la presión ∆P entre la formación y 
la columna del lodo, porosidad y permeabilidad. La invasión cambia la naturaleza 
de los fluidos en la zona de investigación de la herramienta. Para determinar el 
efecto de la zona invadida en la medición, se necesita conocer la naturaleza del 
fluido dentro de la zona de investigación. Con algún registro de resistividad se 
encuentran las saturaciones de agua en las diferentes zonas. 

 
Entre los diferentes efectos ambientales los más importantes son la rugosidad y la 
invasión. El primero sólo se corrige empíricamente. El segundo es importante donde 
exista gas o aceite ligero, se realiza una corrección para obtener la densidad de la zona 
virgen, utilizando la siguiente ecuación: 
 
 (ρb)corr = φSw ρw +  φ (1-  Sw) ρh + (1- φVsh) ρma …………………………………1.9 
 
donde φ, Sw, Vsh, y ρma pueden obtenerse de una interpretación cuantitativa de registros 
de pozos. 
 
I .3.5.-CORRECCIONES PARA EL REGISTRO NEUTRÓN 
 
Los factores que alteran la medida de estos registros son: hidrógeno, arcillas, micas y 
otros minerales; tipo de material, presencia de absorbedores de neutrones; salinidad, 
hidrocarburos, efectos ambientales; así como un sin  número de factores geológicos que 
afectan el índice de hidrógeno. 
 

a) Hidrógeno. El contenido de hidrógeno de la mayoría de los granos de roca pura 
(cuarzo, calcita, etc) son cercanos a cero; su decaimiento es débil dando un IH  
(índice de hidrógeno) del fluido de 1.0 

b) Arcillas, micas y otros minerales. Ciertos minerales contienen hidrógeno en la 
estructura cristalina que puede ser agua de cristalización ó molecularmente agua 
impregnada. Aunque este hidrógeno no se asocia con la porosidad, esto no puede 
discriminarlo la herramienta. En suma, las arcillas a menudo retienen grandes 
cantidades de agua dentro de su estructura laminar. Es común observar lecturas de 
altas porosidades del neutrón en zonas de lutitas,  teniéndose que aplicar una 
corrección a la lectura del registro. 

c) Salinidad. Altera la cantidad de hidrógeno presente y reduce el IH. Esto debe 
tomarse en cuenta para los fluidos en el agujero, la zona de flujo o virgen. Para un 
pozo perforado con aceite o lodo base aceite sólo se debe considerar la salinidad 
del agua de formación. En agujeros ademados figurarán el fluido de la tubería y la 
salinidad del agua de formación. 
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d) Hidrocarburos. Muchos de los medios que tienen aceite pesado presentan un IH 
cercano a la unidad y su presencia tendrá poco efecto en la medida del registro. 
Por otra parte, aceites ligeros y gases pueden alterar las lecturas por su bajo IH. 
Una zona con impregnaciones de hidrocarburos ligeros está caracterizada por una 
porosidad neutrón aparente, la cuál es menor que la que se observaría si la zona 
tuviera agua. 

e) Efectos ambientales.  
- Tipo del lodo. En agujeros perforados con aire o llenos de gas las contribuciones de 

neutrones disminuyen y no hay captura. Sin embargo, la respuesta de la 
herramienta es sensible a agujeros vacíos, generalmente resulta un incremento en 
la relación de conteo del detector, parte de la formación, parte por la interacción 
entre la fuente y los detectores. Las herramientas GNT(equipo de medición 
radioactivo convencional que mide el número de neutrones según la distancia), 
TDT, SNP(equipo de medición neutrón epitermal de pared de investigación 
limitada y de lectura directa de porosidad si la litología es conocida) y la CNT-
G(equipo de medición de neutrón compensado de investigación profunda y se 
puede obtener la porosidad en agujeros entubados) pueden correrse en agujeros 
vacíos, pero no así la CNT termal. 

 
En agujeros llenos con líquidos, la influencia del fluido de la lectura del registro depende 
de: 

- Salinidad del lodo. El cloro es un fuerte absorbedor de neutrones. Un incremento en 
la salinidad ocasiona una disminución de los neutrones térmicos y, en 
consecuencia, un incremento en los rayos gamma de captura. Las herramientas de 
neutrones térmicos trasladan a un mayor índice de hidrógeno aparente. 

- densidad del lodo. El IH de la columna del lodo se reduce por el aumento en el peso 
de los aditivos (barita, cloruro de sodio, etc), incrementando el nivel del neutrón 
térmico cerca del detector. Las herramienta térmicas leen un IH aparente bajo. 

- Diámetro del agujero. A mayor tamaño de agujero o ademe, mayor serán el 
decaimiento y captura de neutrones en el agujero. La señal de la formación será 
menor. 

- Posición de la herramienta. La señal de la formación es usualmente más fuerte 
cuando la herramienta está pegada contra el agujero o el ademe. Se pueden 
utilizar descentradores mecánicos. En pozos ligeramente desviados, la 
herramienta tiende a correr  a lo largo del lado bajo del agujero. 

- Enjarre. El efecto del enjarre es importante en herramientas de almohadillas como 
la SNP, pero usualmente despreciable como en otras herramientas. El enjarre es 
rico en átomos de hidrógeno, lo que contribuye al incremento del IH aparente. 

- Ademe. El fierro es un fuerte absorbedor de neutrones. También atenúa rayos 
gamma. El cemento pegado junto al ademe tiene un alto IH (>50%). El efecto 
total en esta situación es incrementar el IH aparente mediante la reducción de las 
relaciones de conteo. . En resumen, las herramientas con almohadilla son 
ligeramente sensitivas a los efectos del agujero, pero fuertemente influidas por el 
enjarre. No pueden correrse en agujeros ademados. 

- Invasión.  El volumen de formación que contribuye a la medida, depende de la 
configuración de la herramienta, la técnica de medida y de la misma característica 



  
                                                                     44 

de la formación. Las herramientas GNT, CNT Y TDT  tienen aproximadamente la 
misma profundidad de investigación, mucho se obtiene en mediciones someras. El 
proceso de invasión ya se discutió. La profundidad de invasión varía de acuerdo al 
lodo, a las características de formación y al procedimiento de perforación. 

- Presión. Un incremento en la presión tiende a aumentar el IH de los fluidos. Esto 
es particularmente cierto para gas. Los efectos combinados de presión y de 
temperatura dan como resultado un incremento neto del IH con la profundidad. La 
presión es también un factor en el proceso de invasión 

 
I .3.6.-CORRECCIONES PARA EL REGISTRO SÒNICO 
 
Los factores  que influyen en la medida son: matriz, porosidad, fluidos, temperatura, 
presión, textura, efectos ambientales y otros 
 

- matriz. La velocidad del sonido en la formación depende del tipo de mineral de 
que está compuesta la roca. El efecto de los minerales se determina por sus 
densidades y parámetros elásticos. En el caso de litologías complejas, el efecto de 
un mineral se determina por su fracción de volumen y de su propia velocidad 
respecto al sonido 

- tiempo de tránsito de alargamiento. Como el sonido que arriba el segundo receptor 
tiene una trayectoria más larga, la señal es generalmente débil. Como el detector 
en la entrada es el mismo para ambos receptores, la detección puede ocurrir más 
tarde en el receptor más distante. 

- Tamaño del agujero. Esto aparece sólo cuando la suma del tiempo de tránsito del 
emisor a la pared del agujero y de la pared al receptor es mayor que la distancia 
del transmisor al receptor en este caso, el primer arribo es recto a través del lodo 
.Para eliminar tal efecto, la sonda se corre excéntrica. Este mismo efecto en la 
herramienta BHC es pequeño a menos que la cavidad sea muy grande. En el caso 
del lodo de perforación, si el agujero está lleno con aire ó el lodo tiene gas, la 
atenuación de la señal es muy grande. 

- Invasión. Existe poco efecto de invasión en zonas con agua. Sin embargo, en zonas 
con gas o aceite, aún con altas saturaciones de agua, el intervalo de tiempo en la 
zona invadida puede ser muy diferente que en la zona virgen. 

- Invasión profunda. La lectura sónica sólo se obtiene en la zona de flujo y no se 
detecta gas o aceite. No existe problema en el cálculo de la porosidad en este 
caso. 

- Poca invasión. El gas o aceite ligero afectan la medida. Si el tiempo de tránsito es 
menor en la formación con hidrocarburos que en el lodo, la lectura es 
representativa de la zona virgen.. Sin embargo, el tiempo de tránsito requiere 
interpretaciones cuidadosas en términos de porosidad. Si el tiempo de tránsito de 
la formación  es mayor que el del lodo, el registro dará el tiempo de tránsito del 
lodo. El tiempo de tránsito de la zona virgen no puede ser menor. 

- No invasión y producción ligera. En este caso ocurren burbujas en el lodo y se 
presentan saltos de ciclo debido a la fuerte atenuación. 
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I .4.-INTERPRETACIÓN EN FORMACIONES LIMPIAS 

 
I .4.1.-DETERMINACIÓN DE LA SATURACIÓN DE AGUA (Sw) EN 
FORMACIONES LIMPIAS 
 
La evaluación de formaciones limpias es básicamente una cuestión de introducir valores 
correctos de los parámetros Rw, Rt y de la porosidad φ en la ecuación de saturación de 
Archie: 
 
Sw = (a Rw / φm Rt)1/n ………………………………………………………………….1.10 
Donde:  
a = constante de cementación 
m = exponente de cementación 
n = exponente de saturación 
 
De otra forma:  
 
Sw = c RtRw /  / φ.......................................................................................................1.11 
Donde: 
C= 0.9 para arenas y 
C= 1.0 para carbonatos 
 
Aunque el procedimiento aparenta ser sencillo, se pueden presentar dificultades. Una es 
la determinación de Rw cuando el agua de formación producida no está disponible y 
ninguna muestra o valores de catálogos no se encuentran disponibles. Otra es la 
derivación de la porosidad cuando sólo es corrido el registro de densidad o el sónico y los 
valores apropiados de densidad o tiempo de tránsito de la matriz no se conocen. 
 
Estas situaciones son encontradas comúnmente por operadores independientes de 
perforación en áreas no familiares (donde no se cuenta con información), particularmente 
donde las formaciones son de baja porosidad. En casos de esta naturaleza crossplots 
(gráficas) de porosidad-resistividad pueden ayudar considerablemente en la 
interpretación. 
 
Y más aún la pregunta fundamental es si los valores promedios de cementación y de 
saturación constantes en la ecuación 1.10 realmente aplican a la formación específica que 
se esté analizando. Estas constantes pueden variar considerablemente. Una de las gráficas 
cruzadas como la de porosidad-resistividad puede ayudar a definir el valor de la constante 
de cementación. 
 
Otro aspecto de importancia para los geólogos e ingenieros de yacimientos es el tipo de 
roca y el mapa de facies en áreas donde la litología es totalmente variable y la 
información disponible de núcleos es muy reducida. Esto ocurre frecuentemente en 
regiones de rocas muy duras (formaciones bien consolidadas). 
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I .4.2.-Métodos de identificación de minerales 
 

1) Gráfica Resistividad- Porosidad 
Este método es conveniente para analizar un intervalo donde: 

• Rw es desconocida pero debe ser constante sobre el intervalo 
• La densidad de la matriz y/o la velocidad de la matriz no son conocidas 
• Por lo menos zonas productoras de agua de diferentes porosidades están 

presentes en el intervalo 
• La formación de interés es limpia 

 
 
 
Este método se subdivide en dos gráficas cruzadas: la de Hingle y la de Pickett. Con lo 
anterior, valores de Rw, densidad de la matriz, etc. pueden obtenerse y pueden leerse 
valores de porosidad y saturación de agua directamente de la gráfica. 
 
1.1 Gráfica de Hingle 
 
Es una gráfica de porosidad vs 1/ Rt  

                                                                              
Fig. I.17 Gráfica de Hingle 
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Como se ve en la figura la porosidad se incrementa linealmente en el eje horizontal, pero 
la resistividad decrece en forma no lineal en el eje vertical. La porosidad para la gráfica 
es mejor que se obtenga de registros neutrón-densidad y la Rt del registro de inducción 
profundo o del laterolog corregido por invasión. 
 
De la ecuación 
 
φ = c ( Rw ) * 1/( Rt )……………………………………………………………….1.12 
 
Rw es determinado sustituyendo valores de φ y Rt para cualquier punto en la línea  Sw = 
1 y el valor de C depende de la litología, posteriormente se calcula Sw con la siguiente 
ecuación: 
Sw = RtRo /  ………………………………………………………………………1.1.3       
Sabiendo que Ro → Rw 
 
1.2 Gráfica de Pickett 
 
La forma generalizada de la ecuación de Archie está indicada como: 
 
Swn = (a/φm)*(Rw/Rt).....................................................................................................1.14 
Cuando no se conocen los valores de a,m y n se les asigna los siguientes valores: 
El exponente de saturación n=2, el exponente de cementación m=2 y la constante de 
cementación a=1 para carbonatos y a=0.81 para arenas; que es equivalente a: 
Sw = RtRw 2/φ ……………………………………………………………………..1.14ª 
 

Rt  = φ Sw/ Rt ……………………………………………………………….…...1.14b 
 
Despejando la porosidad de la ec. 1.14b se obtiene: 
 
φ = C Rt/1 …………………………………………………………………………...1.15 
 
Por lo que:  
C= 1.0  para calizas 
C= 0.9 para arenas  bajo la siguiente condición: C = a  
 
Reacomodando los términos y tomando logaritmos se tiene: 
Log Rt = -m log φ + log (a Rw) -n log Sw.....................................................................1.16 
 
Estas ecuaciones muestran que si a, Rw, n y Sw son constantes. Una gráfica de log Rt vs 
log φ  produce una línea recta cuya pendiente es -m. Una gráfica de Rt vs φ en escala 
doble logarítmica (log-log) es llamada gráfica de Pickett. 
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Fig. I.18 Gráfica de Pickett donde la porosidad está en (%) y la resistividad en (ohm-m) 
 
La figura 1.18 muestra una gráfica de Pickett para una caliza de arrecife con puntos 
trazados para tres pozos penetrando el mismo intervalo. Para trazar los puntos es igual 
que en la gráfica de Hingle sólo que siempre deben trazarse valores de porosidad en 
escala de porosidad no en densidades o tiempo de tránsito. 
 
Después de que los puntos se han trazado, la línea Ro para Sw = 1 se traza a través de los 
puntos de resistividades que corresponden a diferentes porosidades. La pendiente x/y está 
indicando el manejo del exponente de cementación m que para este caso es de 2. 
 
Además la ecuación 1.14 muestra que si la línea Sw = 1 es extrapolada a una porosidad  
φ = 1 ( en donde los puntos log φ y log Sw son cero) el valor de Rt interceptado es igual a 
Rw. Si Rw es desconocido,  un valor para a se debe asumir y determinar posteriormente 
Rw. 
 
Las ventajas de la gráfica de Pickett sobre la gráfica de Hingle es que no asume los 
valores estándar de a y de m construidos en la gráfica de Hingle. Esto es importante en 
formaciones de bajas porosidades donde las variaciones de m pueden alterar 
considerablemente los valores de Sw. Preferiblemente se considera utilizar la gráfica de 
Pickett en áreas de rocas muy duras. 
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2) Gráfica Sónico-Resistividad  
 
Si una combinación neutrón-densidad se corre, las porosidades pueden ser derivadas 
sin conocer la litología y graficados directamente en un crossplot. Ahora, si 
únicamente un registro sónico está disponible para porosidad y la litología es 
desconocida, (una combinación inducción-sónico es muy popular en algunas áreas)  
por lo que las porosidades inicialmente no pueden ser determinadas. Como se ve en la 
figura 1.19 en el eje horizontal se tiene el tiempo de tránsito incrementándose de 
izquierda a derecha. Los valores de tiempo de tránsito para los niveles de interés se 
colocan en la gráfica y se traza posteriormente la línea de Sw = 1.0 
 
La porosidad que corresponde al tiempo de tránsito al lado derecho del crossplot 
puede ser determinada mediante la relación de Wyllie, posteriormente se hace una 
corrección a ésta porosidad debido a la compactación. 
 
El procedimiento es el mismo para determinar Rw y posteriormente estimar los 
valores de Sw. 
 

 
Fig. I.19 Gráfica Sónico-Resistividad.  
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Rango de Incertidumbre de Sw 
 
Dos factores contribuyen a tener una incertidumbre en el cálculo de la Sw. Uno es la 
desviación de las constantes m , n y c de valores promedios asumidos en la ecuación 1  
( m, n = 2; c= 0.9 ó 1.0). La otra son los posibles errores en las mediciones de Rw, Rt y la 
φ. 
 
En muchos casos de estudio en la literatura tienen valores reportados de m y n para 
formaciones específicas. Una considerable variación ha sido observada. La lista de las 
tablas 1.3.3 y 1.3.4 muestra valores promedios de m y n para formaciones determinadas 
por mediciones de núcleos en el laboratorio.  
 
Formación Litología m n 
Wilcox, Gulf Coast SS 1.9 1.8 
Sparta, 
So.La.Opelousas 

SS 1.9 1.6 

Cockfield, So 
Louisiana 

SS 1.8 
 

2.1 

Government Well, 
So Texas 

SS 1.7 1.9 

Frio So Texas SS 1.8 1.8 
Miocece, So Texas Cons SS 1.95 2.1 
Travis Pick and 
Cotton Valley 

SS 1.8 1.7 

Woodbine,  East 
Texas 

SS 2.0 2.5 

Nacatoch, Arkansas SS 1.9 1.3 
Ordovician Simpson, 
Texas and New 
Mexico 

SS 1.6 1.6 

Permian, Texas SS 1.8 1.9 
Simpson, Kansas SS 1.75 1.3 
Pennsylvanian, 
Oklahoma 

SS 1.8 1.8 

Bartlesville, Kansas SS 2.0 1.9 
Mississippian, 
Illinois 

SS 1.8 1.9 

Pennsylvanian, 
Illinois 

SS 1.8 2.0 

Muddy, Nebraska SS 1.7 2.0 
Cretaceus, 
Saskatchewan, 

SS 1.6 1.6 
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Canada 
Bradford, 
Pennsylvannia 

SS 2.0 1.6 

Frio, Chocolate, 
Bayou, Louisiana 

SS 1.55-1.94 1.73-2.22 

Frio, Agua Dulce, 
South Texas 

SS 1.71 1.66 

Frio, Edinburgh, 
South Texas 

SS 1.82 1.47, 1.52 

Frio, Hollow Tree, 
South Texas 

SS 1.8, 1.87 1.64, 1.69 

Jackson, Cole Sd, 
South Texas 

SS 2.01 1.66 

Navarro, Olmos, 
Delmonte, South 
Texas 

SS 1.89 1.49 

Lakota, Wyoming SS 1.52 1.28 
Tabla I.3.3 Valores de m y n para areniscas 
 
 
 
 
 
 
 
Rodessa, East Texas LS 2.0 1.6 
Edwards, So Texas LS 2.0 2.8 
Pennsylvanian, 
Texas 

LS 1.9 1.8 

Mississippian, 
Illinois 

LS 1.9 2.0 

Madison, Dakota LS 1.9 1.7 
Edwards Lime, Darst 
Creek Co. 

LS 1.94, 2.02 2.04, 2.08 

Viola, Bowwie Field, 
No Texas 

LS 1.77 1.15 

SPWLA Logging Symposium 
Transactions (1973) 

   
Tabla I.3.4 Valores de m y n para calizas 
 
Esta es una buena evidencia teórica y experimentalmente indica que el exponente de 
cementación m es función de la forma del grano. 
En el caso de carbonatos, el valor de m está directamente relacionado con la fracción del 
espacio poroso. Mediciones en laboratorio han demostrado que m se incrementa de 2 a 3 
cuando se incrementa la fracción del espacio poroso de 0 a 60%. El efecto es importante 
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en porosidades bajas (5-10%) donde las saturaciones de agua  calculadas usando el valor 
de m = 2 pueden ser mucho muy bajas. 
 
 
Con los datos de las tablas 1.3.3 y 1.3.4 se construyó la gráfica de m-n para litologías de 
areniscas y calizas (ver figura I.20). Observándose así un mayor rango de dispersión de 
los valores en las calizas (por una mayor variación en la geometría del espacio poroso). 
 
 
 

Gráfica m-n para areniscas y calizas
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Fig. I.20 Distribución de valores m-n para formaciones de calizas y areniscas 
 
 
La incertidumbre en las mediciones de Rw, Rt y φ están en el rango de mas menos (5-
10%). Cuando éstos se acoplan con incertidumbres del mismo orden de magnitud en m, n 
y c, el resultado final es un promedio de incertidumbre al calcular la saturación de agua 
en el rango de mas menos (10-20%). 
 
 
 
I .4.3.-Identificación Multimineral en Formaciones Limpias 
 
Los principales minerales que conciernen a los ingenieros de yacimientos son areniscas, 
calizas, dolomías y anhidrita. Estas litologías pueden contener algunos componentes 
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dentro de la roca como la lutita y algunos minerales que se encuentran en menor 
frecuencia como: yeso, sal, azufre, etc. 
 
La identificación de la composición de la matriz es particularmente importante en 
formaciones por diferentes razones. Primero, las porosidades se pueden obtener de 
valores en áreas de interés y segundo porque a menudo las formaciones requieren de 
procesos de acidificación o fracturamiento para estimular la formación y aumentar la 
conductividad en el área de flujo. Y, finalmente, la tercera razón es geológica. Por 
ejemplo en muchos casos ocurre la dolomitización que está a menudo acompañada por un 
incremento en la porosidad y ver la dirección de incremento en volumen de dolomita que 
puede ser favorable para la producción. 
Hay tres métodos de combinación de información de registros de porosidad para 
distinguir la composición de los minerales.  
 
 
Estos son: 
 

a) Gráfica M-N 
b) Gráfica MID  
c) Método de litodensidad  
d) Sistema de ecuaciones a partir de tres o más registros 

 
Los primeros dos utilizan datos de registros de densidad, neutrón y sónico. El tercero usa 
litodensidad y datos de registros neutrón. También puede hacerse uso de información del 
registro de Espectroscopia de rayos gamma. 
 

a) Gráfica M-N 
 
En mezclas minerales más complejas, se facilita la interpretación de la litología gracias al 
uso de la gráfica M-N. Esta combina los datos de tres registros de porosidad para 
proporcionar las cantidades de M y de N que dependen de la litología. M y N son sólo las 
pendientes de las líneas individuales de litología en las gráficas sónico-densidad y 
neutrón-densidad respectivamente. Así,  M y N son esencialmente independientes de la 
porosidad, y una gráfica proporciona la identificación de la litología. 
 
 
M y  N se definen como: 
 
 
M = (tf - t)/(ρb - ρf) * 0.01…………...............................................................................1.17 
 
 
N= (φNf  - φN)/ (ρb - ρf)…………………………………………………………………1.18 
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En el caso de lodos dulces, tf = 189, ρf = 1 y φNf = 1. La porosidad del neutrón se expresa 
en unidades de porosidad de caliza. Se utiliza el coeficiente 0.01 para hacer los valores de 
M compatibles con la escala de N. 
 
 
 
MINERAL ∆tma ρma φma SNP φma CNL 
Arenisca 1 
φ>10% 
Vma = 18,000 

55.5 2.65 -0.035 -0.05 

Arenisca  2 
φ>10% 
Vma = 19,500 

51.2 2.65 -0.035 -0.05 

Caliza 47.5 2.71 0.0 0.0 
Dolomita 1  
φ = 5.5 a 30% 

43.5 2.87 0.035 0.085 

Dolomita 2  
φ = 1.5 a 5.5 y 
30% 

43.5 2.87 0.02 0.065 

Dolomita 3  
φ = 0 a 1.5 % 

43.5 2.87 -0.005 0.04 

Anhidrita 50.0 2.98 -0.005 -0.002 
Yeso 52.0 2.35 0.49 - 
Sal 67.0 2.03 0.04 -0.01 
Tabla I.3.4 Coeficientes de matriz de varios minerales 
 
 
FLUIDOS ∆tf Ρf φNf 
Porosidad primaria 
Lodo dulce 
Lodo salado 

 
189.0 
185.0 

 
1.0 
1.10 

 
1 
1 

Tabla I.3.5 Coeficientes de fluidos 
 
Si los parámetros de la matriz (∆tma, ρma,  φNma) para un mineral determinado se utilizan 
en las ecuaciones 5 y 6 en lugar de los valores de registro, entonces se definen los valores 
de M y N para ese mineral. Con base en los parámetros de matriz y fluidos listados en los 
cuadros anteriores y en la siguiente tabla se muestran los valores de M y N para varios 
minerales en pozos llenos con lodo dulce y lodo salado. 
 
MINERAL Lodo dulce  Lodo salado  
 M N M N 
Arenisca 1 0.810 0.636 0.835 0.667 
Arenisca 2 0.835 0.636 0.862 0.667 
Caliza 0.827 0.585 0.854 0.621 
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Dolomita 1 0.778 0.489 0.800 0.517 
Dolomita 2 0.778 0.500 0.800 0.528 
Dolomita 3 0.778 0.513 0.800 0.542 
Anhidrita 0.702 0.504 0.718 0.533 
Yeso 1.015 0.296 1.064 0.320 
Sal   1.269 1.086 
Tabla I.3.6 Valores de M y N para minerales comunes 
 
La porosidad secundaria, la arcillosidad y la porosidad llena de gas cambiarán la posición 
de los puntos con respecto a su litología real; incluso pueden provocar que los puntos M y 
N se grafiquen fuera del área triangular definida por los componentes minerales 
primarios. 
 
El gráfico M y N que se muestra a continuación indican como la presencia de cada 
mineral determina la dirección de desplazamiento de los puntos. En el caso de la lutita, la 
flecha resulta ilustrativa sólo porque la posición del punto de la lutita variará con el área y 
la formación. 
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Fig. I.21 Gráfica M-N 
 
La gráfica M-N contribuye a la selección de la litología probable. Para utilizar la gráfica, 
los valorse de los registros se leen en el nivel de interés, posteriormente se calculan y 
grafican M y N. Si la formación consiste de una combinación binaria, los puntos caerán 
en la línea que une a los dos minerales. Si existen tres minerales, los puntos caerán dentro 
del triángulo.  
 



  
                                                                     57 

En principio, si la matriz se conoce, las cantidades relativas de cada mineral se 
determinarán por la posición del punto en la gráfica. Sin embargo, el método no es exacto 
por las siguientes razones: 
 
 

- los puntos básicos sílice-calcita-dolomita no están muy separados 
- sus posiciones son algo dependientes al considerar la velocidad de la 

matriz 
- la posición de cualquier punto está sujeta a las variaciones estadísticas de 

los registros de densidad y neutrón 
 
 
 
En conclusión, la presencia de arcilla, yeso, porosidad secundaria, gas, sal o azufre, 
desplazan a los puntos fuera de los triángulos básicos en las direcciones indicadas. La 
gráfica funciona mejor tomándola como base estadística para indicar la tendencia de un 
grupo de puntos de un intervalo. 
 
 
 

b) GRÁFICA MID 
 
Es una técnica para utilizar tres herramientas de porosidad independientes. Esta 
aproximación asocia las respuestas sónico-neutrón para definir dos parámetros (∆tma)a y 
(ρma)a, que son característicos de la roca y que pueden expresarse de la siguiente manera: 

 

∆t  = (∆tma)a + [∆tf - (∆tma)a]* φN......................................................................................1.19 

 

ρb = ρf  + [ρf  - (ρma)a] * φN……………………………………………………………...1.20 

 

 

Las soluciones gráficas de éstos dos parámetros para fluidos de agua dulce se muestran 
en las siguientes figuras: 
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Fig. I.22 Gráfica MID. Gráfica de Interrelación tiempo de tránsito-porosidad neutrón para determinar (∆tma)a 
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Fig. I.23 Gráfica densidad-neutrón. Gráfica de Interrelación densidad-porosidad neutrón para determinar  (ρma)a 
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Fig. I.24 Gráfica de identificación de la matriz (MID). Gráfica que utiliza la técnica MID para identificar minerales 
 
 
La gráfica de identificación de matriz es otro método que utiliza los mismos datos que la 
M-N. Se basa en la determinación de la densidad de matriz aparente (ρma)a y del tiempo 
de tránsito aparente (∆tma)a de un nivel de interés. La figura 1.24 representa un gráfico 
MID. 
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Para determinar la densidad de matriz aparente a una profundidad dada, se grafican los 
valores de ρb y φN, y se lee en la carta figura 1.23 el valor de (ρma)a. 
 
La determinación de la velocidad de matriz aparente es similar. El tiempo de tránsito se 
lee del registro sónico y se intersecta con la φN en la gráfica de interrelación sónico-
neutrón (figura 1.22). En esta gráfica, las líneas de (∆tma)a constante se obtienen 
interpolando y extrapolando los valores de velocidad de matriz conocida. 
 
Las coordenadas (ρma)a , (∆tma)a se colocan en la figura 1.24 para obtener los componentes 
de la matriz. Se hacen las mismas consideraciones que en la gráfica M-N. La lutita coloca 
los puntos hacia abajo, la sal y el gas hacia arriba y a la derecha. 
 
La principal ventaja de la gráfica MID sobre la M-N es que no requiere de muchos 
cálculos matemáticos. La combinación de ambas gráficas ayuda a resolver efectos de 
minerales como sal, yeso y azufre. 
 

 
c) Método de Litodensidad 

 
Es un método relativamente nuevo para identificar minerales. Requiere de la densidad ρb 
y del coeficiente de absorción fotoeléctrica, Pe, leídos del registro de litodensidad, y la 
porosidad, φN, del registro neutrón. Los valores ρb y φN pueden utilizarse para calcular 
litología y porosidad cuando sólo existen dos minerales. Con el registro neutrón pueden 
distinguirse hasta tres minerales. 
 
El método se basa en una gráfica de la densidad aparente de la matriz (ρma)a contra el 
índice de absorción volumétrica aparente, (Uma)a. La gráfica de interrelación (figura 
1.24a) se muestra a continuación: 
 

 
Fig. I.24a Gráfica del método de Litodensidad 
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El índice de absorción volumétrica fotoeléctrico, U, de una formación dada se obtiene de 
los valores de ρb y Pe, como se muestra: 
 
U = Pe (ρb + 0.1883)/1.0704……………………………………………………………1.21 
 
Este coeficiente se suma para diferentes componentes en una mezcla de tal forma que 
para una formación de porosidad φ se tiene: 
 
U = φ Uf + (1-φ) Uma…………………………………………………………………...1.22 
Donde Uf es el índice de absorción para un fluido y Uma es el índice de absorción de la 
matriz. Para una formación de matriz desconocida, se obtiene un índice de absorción de 
matriz aparente: 
(Uma)a = (U-Uf*φ) /(1-φ)……………………………………………………………….1.23 
 
El procedimiento para un nivel de interés es: leer los valores en el registro de φN, ρb y Pe, 
encontrar la densidad aparente de la matriz (ρma)a y la porosidad total aparente, φta. Los 
valores de ρb , Pe y φta se colocan el nomograma de la figura 1.24b) para encontrar el 
valor de (Uma)a. 
 
Los valores de (ρma)a y (Uma)a se colocan en la figura 1.24a). Porcentajes aproximados de 
caliza, arenisca y lutita pueden leerse en las mallas. 
 

 
Fig. I.24b Gráfica del método de Litodensidad  
 
 
Inclusiones de arcilla o lutita mueve los puntos hacia la parte inferior derecha, 
ocasionando que las formaciones que contengan cuarzo aparezcan excesivamente 
dolomitizados y los intervalos de calcita-dolomita aparezcan como anhidrita.  
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Tendencias en la identificación multimineral con el método de litodensidad neutrón se 
espera tener una mejor aproximación que con las gráfica M-N y MID, porque los puntos 
curazo-calcita dolomita-anhidrita están m{as separados y no existe incertidumbre en el 
tiempo de tránsito de la matriz. 
 
 
 

d) Método de Sistema de ecuaciones a partir de tres o más registros 
 
Savre (1963) usó un método muy claro para resolver la porosidad y fracciones de 
minerales una vez que los tres minerales habían sido escogidos por cualquiera de los 
métodos antes vistos, en aquélla época el M-N era el más conocido. 
 
Savre consideró las fracciones volumétricas de tres minerales f1,f2,f3 y φN1, φN2 y φN3 la 
respuesta de la sonda de tres matrices y las densidades de la matriz ρma1, ρma2 y ρma3 y 
∆tma1, ∆tma2 y ∆tma3 para los tiempos de tránsito de la matriz, de aquí propuso qué: 
 
φN = f1 φN1 + f2 φN2 + f3 φN3 + φNf ……………………………………………………..1.24 
 
∆t = f1 ∆tma1 + f2 ∆tma2 + f3 ∆tma3 + ∆tf φ..........................................................................1.25 
 
ρb = f1 ρma1 + f2 ρma2 + f3 ρma3 + ρf φ…………………………………………………....1.26 
 
1 = f1 + f2 + f3 + φ……………………………………………………………………...1.27 
 
 
Esto proporciona cuatro ecuaciones con cuatro incógnitas. Si ∆tmai, ρmai, y φNi son 
conocidos, se pueden encontrar φ y fi. Savre estableció que si hay gas en la formación, el 
sistema de ecuaciones no puede tener una solución por los errores y variaciones que 
puedan tener las constantes antes mencionadas. Las ecuaciones 1.24-1.27 pueden 
generalizarse a un sistema de k = 1,……., n registros y ei = 1,……., n componentes. 
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I .5.-MODELOS PARA LA DETERMINACIÓN DE LA SATURACIÓN DE AGUA 
EN FORMACIONES ARCILLOSAS 
 
La presencia de arcilla en el yacimiento origina perturbaciones en la evaluación, 
complica la determinación de hidrocarburos y afecta la habilidad del yacimiento para 
producirlos. Los efectos que produce la presencia de arcillas en las arenas, calizas y 
dolomías son: 

- Reducción de la porosidad efectiva 
- Disminución de la permeabilidad 
- Alteración de la resistividad 

 
Las arcillas son partículas muy finas que tienen una gran superficie y que son capaces de 
acumular fracciones de agua en dicha superficie. El agua contribuye a que la roca sea 
eléctricamente más conductora pero no hidráulicamente, es decir, no puede ser 
desplazada por hidrocarburos; por esta razón, hay que definir a la porosidad como 
efectiva, aquella en la que los poros están interconectados. 
 
Las correcciones que se aplican a este tipo de formaciones tienden a disminuir la 
saturación de agua. Un estudio confiable requiere tener conocimiento y experiencia de la 
zona para poder determinar si el yacimiento tiene arcilla o lutita en forma laminar o 
dispersa. 
 
La lutita es una combinación de minerales y sedimentos que se depositan en ambientes de 
baja energía. Los sedimentos constan de partículas finas, la mayoría sílice con pequeñas 
cantidades de carbonatos y otros minerales no arcillosos. Los sólidos de una lutita típica 
pueden consistir del alrededor del 50% de arcilla, 25% de sílice, 10% de feldespato, 10% 
de carbonatos, 3% de óxido de hierro, 1% de material orgánico y 1% de otros minerales, 
asimismo pueden contener del 2 al 40% de agua por volumen. 
 
Los minerales arcillosos que se clasifican en grupos específicos de acuerdo con las rocas 
sedimentarias son la montmorillonita, ilita, caolinita y clorita. La montmorillonita se 
hincha al contacto con el agua, sufre diagénesis a ilita a altas temperaturas. Esto ocasiona 
eliminación de agua y contribuye a aumentar la presión de las arenas adyacentes. 
 
La mayoría de las herramientas de registros tienen un promedio de resolución vertical de 
2 a 4 pies. En estos intervalos la arcilla o lutita puede estar depositada en la arena de tres 
maneras. : laminar, dispersa y estructural (figura 1.25). 
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Fig. I.25 Forma esquemática en la que se presenta la lutita en los sedimentos (Dewan, 1983, pag. 232) 

 
a) Laminar 

 
En esta forma la arcilla o lutita se presenta en láminas de algunos centímetros de espesor, 
está intercalada con arena limpia. La porosidad efectiva y la permeabilidad de las lutitas 
son nulas. La arcilla en una lutita laminar es de origen detrítico. La arcilla se obtiene de 
diversos tipos de rocas y arenas, generalmente tiene dos o mas minerales de arcilla. La 
depositación, las laminaciones de lutita y arena tienden a ser homogéneas por el trabajo 
de los organismos y la infiltración de partículas de arcilla dentro de la arena por el 
movimiento de agua. 
 

b) Dispersa 
 
En esta forma, la arcilla, no la lutita, está diseminada en el espacio poroso de la arena, 
remplazando al fluido. Este tipo de distribución es muy dañina porque una pequeña 
cantidad de arcilla cierra los poros, reduce su porosidad efectiva y la permeabilidad. El 
máximo contenido de arcilla en la arena es de alrededor del 40%, que representa el 15% 
del volumen. 
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Mucha de esta arcilla es de origen autígeno. La arcilla autígena se desarrolla después de 
la depositación de la arena, como resultado de interacciones químicas entre el fluido del 
poro y los constituyentes menores de la arena, tales como los feldespatos. 
 
La arcilla autígena se caracteriza por ser de varios tipos: partículas discretas, de 
revestimiento y de tapón. Estos nombres se le han dado por la forma en que se generan en 
el poro. Las partículas discretas, generalmente caolinita, construyen plaquetas aisladas 
dentro del poro, ocasionando una baja muy pequeña de la porosidad efectiva y de la 
permeabilidad. La de revestimiento cubre los granos y forma microporos que entrampan 
una buena cantidad de agua del poro, reducen la porosidad efectiva. La de tapón cierra 
totalmente el poro, disminuye bastante la porosidad efectiva y drásticamente la 
permeabilidad. La arcilla dispersa es más dañina que la lutita laminar. En la figura 1.26 
muestra los efectos que produce en la permeabilidad la arcilla autígena. 
 

 
Fig. I.26 Esquema de las formas en que la arcilla autígena puede formarse en el espacio poroso  
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c) Estructural 

 
Este tipo de arcilla ocurre en menor proporción. En esta forma los granos arcillosos 
toman el lugar de los grados de arena. No afecta a los registros. Sin embargo, la 
disposición particular de la arcilla afecta fuertemente la productividad de la formación.  
 
 
I .5.1.-INTERPRETACIÓN EN FORMACIONES ARCILLOSAS 
 
La interpretación de arenas arcillosas todavía está evolucionando. Durante años un 
número muy grande de diferentes modelos se han propuesto para calcular la saturación de 
agua. En la actualidad los modelos para arenas arcillosas están basados en la capacidad 
de intercambio catiónico (CEC) que es la más importante propiedad de la arcilla en la 
evaluación de las formaciones. 
 
 
 
I .5.1.a-Capacidad de Intercambio Catiónico 
 
Es la fuente del exceso de conductividad, que se muestra en la figura 1.27. Las plaquetas 
de arcilla cristalina están cargadas negativamente como resultado de las sustituciones de 
los iones y de la ruptura de la adhesión en los bordes en la estructura. La carga de balance 
de los cationes, Na

+, está en la superficie de la arcilla seca. Cuando la arcilla está en 
contacto con una solución salina, los cationes Na

+ están en suspensión cerrada a la 
superficie de la arcilla y como resultado repelen a los aniones Cl- en la solución, a partir 
de la superficie de la arcilla. 
 

 
Fig. I.27 Esquema en el que se representa la forma de impregnación de la molécula de agua a la superficie 
de la arcilla. 
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Hay una capa de agua que rodea a la arcilla que es inmóvil. Las fuerzas de atadura son 
tan grandes que el agua no puede reducirse por las presiones tan altas (figura 1.27). Esto 
origina que la migración de aceite hacia la arena arcillosa no desplace a esta agua. 
 
La cantidad de arcilla y el agua libre de aniones se han medido en núcleos de arena 
arcillosa, dando los siguientes resultados en gramos de agua por meq de cationes 
intercambiables: 
 
W = 0.22 + 0.084/(C)1/2………………………………………………………………..1.28 
Donde:  
C  = es la concentración de cloruro de sodio de un agua en equilibrio. 
W = es el volumen de agua impregnada 
Los modelos de interpretación de registros de pozos más usados en arenas arcillosas son: 

- Indonesia 
- Simandoux 
- Simandoux Modificado 
- Waxman-Smits 
- Doble Agua  

 
I .5.2.-Método de Indonesia 
 
1/(Rt)1/2 = [ Vcl  

(1-Vcl/2)  /(Rcl)1/2 + φm/2/(aRw)1/2] Sw
n/2…………………………………..1.29 

Donde:  
Vcl = volumen de arcilla 
Rcl = resistividad de la arcilla 
φ   = porosidad 
m  = exponente de cementación 
n   = exponente de saturación 
a   = constante de cementación 
Sw = saturación de agua de formación 
Rw = Resistividad del agua de formación 
Rt   = Resistividad verdadera de la zona virgen 
Sxo = Saturación de agua en la zona lavada 
Rxo= Resistividad en la zona lavada 
Rmf= Resistividad del filtrado de lodo 
 
La Sxo puede ser calculada remplazando Rt y Rw por Rxo y Rmf 
 
I .5.3.-Método de Simandoux 
 
Estudios extensivos en 1963 por Simandoux en medios porosos artificiales compuestos 
de arena y arcilla, estableció que la conductividad de los mismos pueden ser expresados 
por la siguiente relación: 
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Ct = Vsh Cc Sw + Sw
n (φm/ aRw )…………………………………………………………1.30 

Donde: 
Cc  = conductividad de la arcilla dispersa 
Ct  = conductividad de la zona virgen  
Vsh= volumen de arcilla 
 
Este método se aplica con los registros de resistividad, densidad y neutrón. Determinando 
así la saturación de agua: 
 
Sw = C Rw/ φe [ ((5 φe

2/ Rw Rt) + (Vsh/Rsh)2)1/2 - Vsh/Rsh]………………………………1.31 
 
Donde: 
C  =  es una constante donde involucra m, n y a igual a 0.4  para arenas 
C  = 0.45  para carbonatos 
Vsh= es el valor mínimo de lutita obtenido a partir de los indicadores SP o GR 
Rw= resistividad del agua de formación 
Rt = es la resistividad leída del registro de resistividad profundo, corregido por invasión 
Rsh= es la resistividad leída del registro de resistividad profundo leído en la zona de        
lutitas 
φe = la porosidad efectiva que se puede calcular como: 
φe = (φFDC

2 + φN
2 / 2 )1/2 

φFDC y φN son las porosidades de los registros densidad y neutrón corregidos por 
contenido de lutita. 
 
 
I .5.4.-Método de Simandoux Modificado 
 
Este es el método de Simandoux, modificado por Fertl y Hammack. En 1971 Fertl y 
Hammack simplificaron la ecuación de Simandoux haciendo unas sustituciones prácticas 
y modificaciones matemáticas quedando la ecuación de la siguiente manera: 
 
Sw = (F Rw / Rt)1/2 – (Vsh Rw / φ Rsh)…………………………………………………...1.32 
 
Donde: 
F = factor de formación 
 
Por medio de las gráficas Vll- lla y Vll- llb se resuelve en forma gráfica la ecuación 1.32. 
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Fig. I.28 Gráficaa VII-IIa 
 
Para encontrar el valor de la saturación de agua mediante el método gráfico de 
Simandoux Modificado se entra a la gráfica (1.28) con los valores de Rw y φ,  se obtiene 
F Rw ; y además con el valor de Rsh se obtiene el factor A. Con el valor de A y Vsh se 
obtiene el factor B. 
 
Donde: 
 
A = F Rw/Rt.……………………………………………………………………………1.33 
 
B = F Rw Vsh/ Rsh………………………………………………………………………1.34 
 
Finalmente con los valores de A y B se introducen en la gráfica VII-IIb de la figura 1.29 
obteniendo así el valor de saturación de agua. 
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Fig. I.29 Gráfica VII-Iib donde A y B son las ecuaciones 1.33 y 1.34 
 

 
I .5.5.-Método de Waxman-Smits 
 
En 1968, Waxman y Smits propusieron, con base en extensos trabajos de laboratorio y 
estudios teóricos, una relación resistividad-saturación de agua para las formaciones 
arcillosas, la cual relaciona la contribución de resistividad de las arcillas  a la capacidad 
de intercambio catiónico CEC de las arcillas. 
 
Waxman y Smits propusieron un modelo que consiste de dos elementos conductivos en 
paralelo: un elemento es la capacidad de intercambio catiónico asociado a la arcilla y el 
otro elemento es la contribución del electrolito libre. 
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En este modelo se considera que la conducción catiónica y la conducción del electrolito 
de cloruro de sodio actúan de forma independiente en el espacio poroso, dando 
trayectorias de conducción paralelas.  
La conductividad efectiva del agua a una saturación del 100% se considera como: 
Cw e = Cw + BQ…………………………………………………………………………1.35 
Donde: 
Cw e = es la conductividad efectiva del agua 
Cw = es la conductividad del agua libre dentro del poro   
B  = es la conductividad específica de los iones   
Q  = es la capacidad de intercambio catiónico expresado como equivalentes por unidad de 
volumen de fluido de poro. 
 
Un equivalente se refiere en este caso a la cantidad de iones que puede aceptar la arcilla 
de una solución salina en unidades similares en volumen o masa.  
 
Cuando hay hidrocarburos en el espacio poroso y desplazamiento de agua libre, los iones 
están más concentrados en el agua remanente. La conductividad efectiva del agua se 
convierte en: 
 
 Cw e = Cw + BQ/Swt…………………………………………………………………….1.36 
Donde : 
Swt = es la saturación total de agua en el medio poroso 
 
La relación de Archie lleva directamente a la siguiente expresión para la conductividad 
de una arena arcillosa con hidrocarburos: 
 
Ct = (Swt φt )n (Cw + BQ/Swt )/ φ………………………………………………..............1.37 
Donde: 
φt = es la porosidad total (que incluye el volumen de poros saturados con agua ligada y 
agua libre) 
φ = es la porosidad promedio de la formación en fracción 
 
Esta ecuación (1.37) puede resolver a Swt si se conoce Ct, φt y Cw. B  puede medirse a 
partir de análisis de núcleos. Los valores de Q se conocen para diferentes salinidades. 
Otra forma es la siguiente: 
 
1/Rt = (Sw

2/FRw) + B QV Sw/F…………………………………………………………1.38 
Donde: 
F = Factor de formación de la porosidad interconectada 
Sw = saturación de agua relacionada con los poros interconectados 
B = conductancia equivalente de los cationes de intercambio de arcilla y sodio como una 
función de la conductividad del agua de formación 
QV = es el CEC de la roca por unidad de volumen de poros 
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El método se basa en tres premisas: 
1. La conductividad de la arcilla se debe a su CEC 
2. El CEC de las arcillas puras es proporcional al área específica de 

superficie de la arcilla 
3. En soluciones salinas, los aniones se excluyen de una capa de agua 

alrededor de la superficie del grano. El espesor de esta capa se expande al 
decrecer la salinidad de la solución y el espesor es una función de la 
salinidad y la temperatura. 

 
En el modelo, se considera que la arcilla consiste de dos componentes, agua ligada y 
minerales de arcilla. Los minerales de arcilla se consideran eléctricamente inertes, la 
conductividad eléctrica de la arcilla se considera al agua, que es independiente al tipo de 
arcilla. 
 
Sw = (B QV Rw2 + [(B QV Rw2)2 + 4 F Rw1/ Rt)1/2] )/ 2…………………………………1.39 
Donde : 
B = 4.6 (1-0.6 e(-0.77/Rw))………………………………………………………………..1.40 
 
QV = CEC (1- φ) ρ / 100φ……………………………………………………………....1.41 
 
CEC = Capacidad de intercambio catiónico 
φ = porosidad en fracción 
ρ = densidad del grano en gr/cm3 
Rw1 = resistividad del agua a temperatura de formación 
Rw2 = resistividad del agua a 77° F 
F = factor de formación de la arena arcillosa 
 
Debido a las limitaciones en la obtención de todos los parámetros (datos de laboratorio) 
necesarios en la ecuación de Waxman- Smits, es posible realizar las siguientes 
simplificaciones: 
 
F = 1/  φ2……………………………………………………………………………….1.42 
CEC = se obtiene de gráficas 
ρ = 2.65 g/cc y la φ debe ser corregida por arcillosidad 
 
En la actualidad los modelos de interpretación en arenas arcillosas están basados en el 
concepto de capacidad de intercambio catiónico más que considerar el volumen de 
arcilla. 
 
I .5.6.-Método de Doble Agua 
 
Este modelo considera que la conducción de los iones se restringirá al agua impregnada 
donde estos residen y la conducción del electrolito normal se confinará al agua libre, 
puesto que los aniones de Cl-  se excluyen de la parte impregnada. Por lo tanto, existe una 
combinación de dos conductividades de aguas: la conductividad del agua impregnada 
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(Cb), que ocupa una fracción del espacio poroso (Sb) y la conductividad del agua libre 
(Cw), que ocupa el espacio del poro remanente. La conductividad del agua efectiva para 
una saturación del 100% es: 
 
 
Cw e = Cw (1-Sb) + Cb Sb……………………………………………………….............1.43 
 
Los hidrocarburos desplazan al agua libre. Cuando esto sucede, una cantidad relativa de 
agua impregnada y de agua libre se intercambian dando una conductividad efectiva del 
agua: 
 
Cw e = Cw (1-Sb/Swt) + (Cb Sb/Swt)……………………………………………………..1.44 
 
La conductividad en la arena con hidrocarburos es: 
 
Ct = (Swt φt )2( Cw(1-Sw)/ Swt + Cb Sb / Swt)……………………………………………1.45 
 
Como la conductividad de los iones, BQ, se restringe a la fracción del espacio poroso 
WQ, el modelo predice que la conductividad del agua impregnada Cb será el cociente: 
 
Cb = B/W………………………………………………………………………………1.46 
 
Utilizando la relación  Sb = WQ  la ecuación de conductividad se convierte en: 
 
Ct = (Swt φt )2( Cw(1-WQ)/ Swt + BQ / Swt)…………………………………………….1.47 
 
Que es la relación del modelo para el cálculo de la saturación de agua. Existe un término 
más que en la relación de Waxman-Smits. 
 
Análogamente, en el modelo de doble agua, se considera que la arcilla consiste de dos 
componentes, agua ligada y minerales de la arcilla. 
 
Los minerales de arcilla se consideran eléctricamente inertes, la conductividad eléctrica 
de la arcilla se considera como derivada de la conductividad de agua ligada que se supone 
es independiente del tipo de arcilla. La cantidad de agua ligada varía de acuerdo con el 
tipo de arcilla y es mayor para las arcillas más finas (con mayores áreas de superficie) 
como la montmorillonita y menor para arcillas más gruesas como la kaolinita. La 
salinidad también tiene un efecto; en aguas de baja salinidad (aproximadamente 20000 
ppm de cloruro de sodio) la capa difusa se expande. 
 
Bajo condiciones normales el agua ligada es inmóvil; por lo tanto, el volumen que ocupa 
no puede ser desplazado por hidrocarburos. Como los minerales de arcilla (coloides 
secos) se consideran eléctricamente inertes, pueden tratarse como otros minerales. 
Esquemáticamente, las formaciones arcillosas se consideran con el modelo de doble agua 
como se ilustra a continuación: 
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Sólidos Fluidos 
1) matriz + sedimento + arcilla seca + agua ligada + agua libre + hidrocarburos 
2) matriz + arcilla + porosidad efectiva 
Fig. I.30 Constitución de una formación arcillosa  
 
Es decir, se puede ver de las dos formas como se ilustra en la figura 1.30. La suma de 
todos los elementos sólidos más la suma de los fluidos conforman a una formación 
arcillosa. 
Para la mayoría de las rocas (excepto para minerales conductivos como la pirita que no 
puede tratarse de esta manera) sólo es necesario considerar la parte porosa al discutir las 
propiedades eléctricas y se trata de acuerdo con la ecuación de saturación de agua de 
Archie. La ecuación se convierte en: 
 
Ct = (( φt )m Swt

n Cw)/a………………………………………………………………….1.48 
Donde: 
a,m y n tienen el significado usual de la ecuación de Archie, 
Ct es la conductividad de la formación virgen no invadida y Cwe es la conductividad 
equivalente de las aguas en el espacio poroso. 
 
Debe observarse que  φt y Swt se refieren al volumen total de los poros que incluye el 
volumen de los poros saturados con agua ligada y el agua innata de la formación (que a 
veces se denomina agua libre). La conductividad equivalente del agua Cwe, es: 
 
Cwe = Vw Cw + Vwb Cwb / (Vw + Vwb)…………………………………………………..1.49 
 
Donde Vw y Vwb son los volúmenes totales del agua de formación y de agua ligada, 
respectivamente, y Cw y Cwb son sus conductividades. 
 
En términos de saturación la ecuación se convierte en: 
Cw e = Cw  +  (Swb/Swt) (Cwb-Cw)………………………………………………………..1.50 
 
Donde Swb es la saturación del agua ligada (es decir, la fracción del volumen total de los 
poros ocupada por el agua ligada). 
 
La ecuación anterior describe la conductividad equivalente del agua como una función de 
la conductividad del agua de formación más la conductividad del agua ligada. La 
ecuación de saturación se convierte en: 
 
Ct = (( φt )m Swt

n Cw)/a (Cw  +  (Swb/Swt)(Cwb-Cw))……………………………………...1.51 
 
La porosidad y saturación de agua de la fase de arena (la fase no arcillosa) de la 
formación (formación limpia) se obtiene restando la fracción del volumen del agua 
ligada. Por lo tanto la porosidad efectiva es: 
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φ = φt ( 1- Swb) y la saturación de agua es: 
 
Sw = (Swt - Swb)/ ( 1- Swb)………………………………………………………………1.52 
 
Para poder evaluar una formación arcillosa con el modelo de doble agua, deben 
determinarse cuatro parámetros que son: Cw, Cwb, φt y Swb. Un diagrama neutròn-
densidad proporciona un valor adecuado para φt. Swb Puede obtenerse de una variedad de 
mediciones sensibles a la lutita (SP, GR, etc). Generalmente Rwb y Rw los determina el 
analista del registro y se consideran parámetros de entrada. 
 
Relación entre el modelo de Waxman- Smits y el de doble agua 
 
Es posible hacer un cambio de información entre los dos métodos porque la 
conductividad de los iones, el valor de B, y el exponente de cementaciòn (m), se obtienen 
de manera independiente. Si se utilizan los mismos valores de B, m y n en ambas 
ecuaciones, la relación de dos aguas dará valores de saturación mayores del 10% (porque 
cuenta con un término adicional) que en la relación de Waxman-Smits.  
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CAPÍTULO ΙΙ SOFTWARE  INTERACTIVE  PETROPHYSICS 
 
ΙΙ .1.-INTRODUCCIÓN A INTERACTIVE PETROPHYSICS 
 
Interactive Petrophysicsc está destinado a ser un software intuitivo. El provee un amplio 
rango de opciones, cuyos resultados son actualizados casi instantáneamente al ser 
desplegados en la pantalla. Esto es inmediato, el modo interactivo de trabajo que efectúa 
Interactive Petrophysics, considerada como una herramienta ideal para los no 
especialistas para obtener información petrofísica que éstos necesitarán usar en otros 
trabajos dentro de la Industria Petrolera. Cuando el resultado de cualquier parámetro 
cambia es mostrado inmediatamente para el analista o usuario que lo va a evaluar. 
Ningún cambio se aplica a la serie o conjunto de datos hasta que éste no haya sido 
salvado. Esto proporciona la libertad para explorar un rango amplio de opciones de 
interpretación sin la preocupación de que se vaya alterar el conjunto de información 
original. 
 
ΙΙ .2.-CAPACIDADES Y REQUERIMIENTOS 
 
Este software corre en Microsoft Windows 95/98 y es compatible con sistemas operativos 
2000. Por consiguiente, cualquier familiar con programas de Microsoft Windows podrá 
acceder las características y herramientas fácilmente disponibles en Interactive 
Petrophysiscs. La interfase gráfica para el usuario se diseñó con un esquema intuitivo 
para que los usuarios inexpertos de Windows puedan aprender a usar el programa de una 
manera productiva y en un lapso de tiempo muy corto. 
 
Todas las opciones de los programas pueden ser accesadas de los menús que son típicos 
de los programas de Windows. Además, las funciones que normalmente son más usadas 
están disponibles haciendo una selección en la barra de herramientas desplegada 
directamente debajo de la barra de menú principal. 
 
La funcionalidad de los programas incluyen las siguientes características: 

- Administración y Edición de la Información 
- Análisis del volumen de Arcilla 
- Análisis de porosidad y saturación de agua 
- Zonas de Corte 
- Procesamiento e Interpretación multipozos. 

 
Los cálculos petrofísicos convencionales están diseñados tanto para carbonatos como 
para arenas arcillosas. Las ecuaciones para determinar la saturación de agua incluyen los 
siguientes modelos: 

- Archie 
- Doble Agua 
- Simandoux 
- Simandoux Modificado 
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- Indonesian y 
- Waxman Smits. 

 
La siguiente ilustración (Fig. II.1) muestra la ventana de cómo ingresar a Interactive  
Petrophysiscs: 
 

 
Fig. II.1 Ventana que muestra la localización del software Interactive Petrophysics (IP) 
 
 
Al seleccionar Interactive Petrophysics aparece la nueva ventana de Inicio del programa 
(Fig. II.2): 
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Fig. II.2 Ventana de entrada al paquete de cómputo IP 
 
La ventana principal del programa se usa para desplegar datos de entrada del registro y 
resultados petrofísicos. También proporciona acceso directo a todas las funciones 
interactivas del programa. La mayoría de las funciones pueden ser accesadas a través de 
uno o dos clicks del botón derecho del mouse. 
 
La barra de color azul que se encuentra en la parte superior de la ventana despliega el 
nombre y el rango de profundidad del pozo que ha sido actualmente seleccionado.. La 
barra de menús contiene una lista de submenús que proporcionan acceso a todas las 
funciones del programa. La barra de herramientas localizada por debajo de la barra de 
menús da acceso directo a las funciones que más frecuentemente se utilizan. 
 
La figura (Fig. II.3 ) es una ventana que se despliega después de que el usuario tenga 
alguna entrada de datos y haya seleccionado uno de los cuadros de registros que ya se 
encuentren previamente definidos. 
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Fig. II.3 Ventana de IP cuando ya tiene cargada información de registros geofísicos de pozos 
 
Muchas funciones pueden ser accesadas directamente dando dos clicks en el botón 
derecho del mouse posicionándose en el cuadro del registro. Al realizar un análisis, la 
mayoría de la selección de parámetros  son hechos, usando el mouse para arrastrar una 
línea vertical en el cuadro del registro en una posición que representa el valor de dicho 
parámetro. Esta característica será demostrada en ejercicios posteriores. 
 
En el lado derecho del track de referencia muestra el registro de rayos gamma (u otras 
curvas ya definidas por el usuario) y el rango de profundidad del pozo. Las líneas 
horizontales en el track de referencia indican el despliegue del intervalo en el cuadro 
principal del registro. El usuario puede examinar fácilmente los datos, sin embargo  lo 
puede hacer usando el botón giratorio del mouse ó pulsando directamente en el mouse en 
la profundidad deseada en el track del registro deseado. 
 
Además se cuenta con una caída de lista que aparece en la parte superior derecha  en la 

etiqueta con nombre Scale 1: ; también se encuentra en la barra de 
herramientas y permite cambiar al registro la escala de profundidad. Inmediatamente 
después a la derecha de Scale 1: Full se tiene el contador del pozo actual. Este contador 
muestra el número de los pozos actualmente seleccionados. 
 
 
El pozo se desplegará o mostrará en el cuadro del registro, en los crossplots e 
histogramas. Todas las operaciones de interpretación también se realizarán en los pozos 
previamente seleccionados. Si los datos para dos o más pozos están cargados, el pozo 

actualmente seleccionado puede ser cambiado pulsando el botón   con las 
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flechas que indican por numeración adelante /atrás,  localizado al lado derecho del 
contador. En el icono dos (#2) se da un clic y despliega una lista de pozos de la cuál se 
podrá seleccionar el pozo deseado. 
                                                                    

 
       1          2                                                     3  4       5  6  7              8         9      10    11  
 
Los siguientes dos iconos (# 3 y # 4) permiten al usuario revisar la edición y el 
encabezado de la curva del registro y listar datos de la curva del registro. Los siguientes 
tres iconos (# 5, # 6 y # 7) son usados para dar formato al cuadro del registro, hacer 
histogramas y crossplots. El icono número 8 se usa para accesar el módulo de fórmula 
por el usuario, seguido de los iconos para determinar el volumen de arcilla (icono # 9), 
porosidad y saturación de agua (icono # 10) y realizar zonas de corte por el icono # 11. 
Todas las características representadas en la barra de herramientas también se podrán 
accesar a través de la barra de menús.  
 
En la posición inferior de la barra, es decir al fondo de la pantalla se despliega la 
profundidad y los valores de la curva en la localización actual del indicador del mouse. 
 

 
Fig. II.4 Figura que muestra los valores de los diferentes parámetros de IP  
 
 
También despliega el valor de un parámetro cuando el indicador del mouse está por 
encima de la línea del parámetro correspondiente. 
 
ΙΙ.3.-BASE DE DATOS 
 
Interactive Petrophysics trabaja completamente dentro de la memoria interna de las 
computadoras. 
 
Pueden cargarse muchos pozos en la memoria, con un máximo de 100 pozos residentes 
(aunque el Banco de Datos ó la Base de Datos puede sostener hasta 9999 pozos, sólo que 
se tiene una restricción; pueden cargarse sólo 100 pozos trabajando en un solo tiempo, es 
decir, se podrá trabajar únicamente con dichos pozos a la vez), una vez que se asume que 
se cuenta con bastante memoria disponible en la PC. 
 
Operando exclusivamente dentro de la memoria, da las ventajas de cálculos sumamente 
rápidos y que los datos guardados en la memoria (o sea, en el disco duro) no cambian 
hasta que tú estés satisfecho con los resultados y que deliberadamente decidas 
actualizarlos. 
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Cuando el usuario decide salvar la interpretación, el programa guarda los datos en una 
serie de archivos binarios en un fólder donde se encuentra el proyecto que dicho usuario 
haya seleccionado. Esta serie de archivos es usualmente referida a la Base o Banco de 
Datos de Interactive Petrophysics. Cada Base de Datos consiste de un fólder de trabajo en 
el que se encuentra  información de las curvas de registros, información general del pozo 
y un conjunto de parámetros de interpretación  que están asociados con el pozo y con el 
archivo IPDBlock file. El archivo IPDBlock file es el mecanismo para cerrar cualquier 
pozo que un usuario ha abierto. 
 

 Fig. II.5 Localización del directorio de trabajo (Base de Datos de IP) 
 
 
Esta figura (Fig. I I.5) muestra el directorio del fólder de trabajo (Base de Datos) para 
comenzar con Interactive Petrophysics. 
 
ΙΙ.4.- FUNCIONES DE LA BASE DE DATOS 
 
En esta lección el usuario aprenderá a: 

- Abrir un proyecto 
- Cargar pozos desde la Base de Datos 
- Salvar todos los pozos en la Base de Datos 
- Salvar los actuales pozos en la Base de Datos 
- Eliminar pozos desde la Base de Datos 
- Crear pozos en la Base de Datos 
- Seleccionar el pozo actual desde la Base de Datos 
- Cerrar el actual pozo desde la Base de Datos 
- Localizar archivos pre-determinados 

 
Todas las funciones de la Base de Datos en Interactive Petrophysics son localizadas bajo 
el encabezado FILE. Estas opciones muestran el fólder de trabajo que estará abierto y que 
en la Base de Datos (fólder) se crearán, eliminarán, salvarán o seleccionarán pozos. 



  
                                                                     83 

 
CAPÍTULO ΙΙΙ  MANEJO DE INTERACTIVE PETROPHYSICS 
 
ΙΙΙ.-1¿CÓMO ABRIR UN PROYECTO? 
 
Cuando el programa empieza la primera vez, habrá una ventana que seguramente estará 
en blanco. El primer paso es asegurar que un proyecto se va a seleccionar para la Base de 
Datos de Interactive Petrophysics. 
 
Para esto selecciona del menú principal FILE > Open database y entonces localiza el 
proyecto (ó el fólder de trabajo) en el directorio dentro de Windows. El programa creará 
automáticamente un pozo en blanco, para que posteriormente se proceda directamente a 
cargar los datos. 
 
 
 
 

 
Fig. III.1 Figura que muestra la selección de la Base de Datos 
 
 
 
 
Nota: Al estar cambiando de una Base de Datos de un proyecto a otro, el programa 
preguntará si te gustaría salvar los datos del proyecto del fólder donde estés trabajando 
y a punto de cerrarlo. Si la respuesta es sí, entonces los pozos actuales serán guardados 
o salvados en la Base de Datos del proyecto anterior (del que decidiste salir). Si la 
respuesta es no, entonces se eliminarán todos los pozos cargados en la memoria. 
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ΙΙΙ.-2.-CARGANDO POZOS DE LA BASE DE DATOS 
 
Para cargar pozos de la Base de Datos selecciona del menú principal del programa  
FILE > Load Wells from Database. 
 
Los pozos que estén disponibles se mostrarán en la ventana (es decir que ya fueron 
previamente cargados). Al seleccionar un pozo, selecciónalo con el cursor del mouse y da 
un clic en la caja de texto que dice “load”. El pozo con ese número (es decir que 
Interactive Petrophysics asignará un número de pozo dependiendo de cuántos de ellos se 
tenga en el fólder de trabajo) corresponde a la Base de Datos con dicho número. 
 
Esto es, se usa nombrando los archivos de datos en forma binaria y guardando los pozos 
en la Base de Datos. La Base de Datos con el pozo (de cualquier nombre) no debe 
confundirse con el nombre del pozo cargado en la memoria interna de la PC. 
 
El nombre del pozo en la memoria, actualmente desplegado en la ventana se muestra en 
la parte superior de dicha ventana (aparece en la barra superior de color azul). 
 
 
 
 

 
Fig. III.2 Figura que muestra los pozos guardados en la Base de Datos de IP  
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Salvar todos los pozos en la Base de Datos, actualizará los pozos en dicho fólder que 
están actualmente cargados en la memoria. Para salvar todos los pozos selecciona del 
menú principal de Interactive Petrophysiscs FILE > Save All Wells to Database. 
 
 
 
ΙΙΙ.-3.- SALVAR EL POZO ACTUAL EN LA BASE DE DATOS 
 
Esta selección cuenta con tres opciones (como usuario) mostrada en la figura (Fig. III.3)  
para salvar el pozo actual de trabajo. Simplemente da un clic en la selección deseada y 
entonces pulsa el botón en la caja de texto con la leyenda de “OK”. Si el pozo será 
salvado en una Base de Datos diferente, el usuario puede seleccionar el botón en la parte 
izquierda de la ventana (en la caja de texto que lleva por nombre “browse”). 
 
Para salvar el pozo actual en la Base de Datos selecciona FILE > Save Current Well To 
Database As. 
 
 
 

 
Fig. III.3 Opciones para guardar el pozo de trabajo en diferentes directorios 
 
 
 
 
Tres opciones como se mencionó anteriormente están disponibles para el usuario: 
 

• Actualización de pozo seleccionado en la Base de Datos. Esta opción salva los pozos 
actualmente desplegados en la Base de Datos. 

• Crear un nuevo pozo en la actual Base de Datos. Esta opción salva los pozos 
actualmente mostrados en la Base de Datos, pero bajo un nombre diferente. Este 
es un método de copiar un pozo en el fólder de trabajo. 
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• Crear un nuevo pozo en otra Base de Datos. Este módulo salva los pozos actualmente 
mostrados en una diferente Base de Datos, Esto no cambia o elimina el pozo en la 
actual Base de Datos. 

 
ΙΙΙ.-4.- ELIMINAR POZOS DESDE LA BASE DE DATOS 
 
 
Selecciona los pozos con el cursor del mouse que deseas eliminar y da un clic en la caja 
de texto con la leyenda “Delete”. Esta opción elimina el pozo de la Base de Datos. 
 
Si un pozo seleccionado está actualmente cargado en la memoria, esta opción no anula el 
pozo de la memoria. De lo contrario, si seleccionas la opción Save All Wells to Database 
el pozo se creará automáticamente. 
 
Para eliminar pozos de la memoria. Usa la opción Close. Para accesar a la opción de 
eliminar selecciona FILE > Delete well from Database (Fig. III.4). 
 
 
 
 

 
Fig. III.4 Ventana desplegada al eliminar cualquier pozo desde la Base de Datos de IP 
 
 
 
 
 
 
 
ΙΙΙ.-5.- CREAR UN NUEVO POZO 
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La función Create New Well creará automáticamente un nuevo pozo (en blanco) y 
mostrará la ventana Create New Well. Esto permite accesar las opciones con el nombre 
del pozo, la profundidad a la cuál se encuentra la cima, la profundidad del pozo y las 
unidades de campo para el pozo. 
 
 

 
Fig. III.5a Selección para crear un pozo nuevo 
 
 
 

 
Fig. III.5b Ventana desplegada al hacer la selección de la figura  III.5a   
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Si los valores de la cima, de la profundidad del pozo y las unidades que se encuentran a la 
izquierda de las cajas de texto aparecen en blanco o no son llenadas por el usuario, 
entonces el intervalo de profundidad/tiempo del pozo se tomará automáticamente del 
primer archivo cargado en el pozo. Esto le permite al programa adaptar los intervalos en 
el pozo al archivo de entrada. 
 
La función Create New Well no crea automáticamente un nuevo pozo en la Base de 
Datos. El nuevo pozo sólo se crea en la memoria. De lo contrario, el usuario lo tendrá que 
salvar posteriormente en su Base de Datos. 
 
 
 
 
 
ΙΙΙ.-6.- SELECCIÓN DEL POZO ACTUAL DE TRABAJO 
 
Esto le permite al usuario seleccionar el pozo deseado. El pozo seleccionado será el pozo 
que cualquier nueva ventana procesará. El nombre del pozo se puede ver en el título de la 
ventana principal y de cualquier ventana secundaria en la cuál se esté procesando dicho 

pozo. Esta opción también puede ser activada usando el icono   o seleccionando  
FILE > Select Current Well. 
 

                                      
Fig. III.6 Figuras que muestran el nombre del pozo a seleccionar 
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La memoria de cualquier pozo se puede observar al principio de cada línea. Cuando 
aparece un valor de (-1) antes del nombre del pozo, quiere decir que el pozo sólo se 
encuentra cargado en la memoria interna de la PC. Esto es que el valor “-1” cambiará 
cuando dicho pozo se haya agregado a la Base de Datos. 
 

El pozo actual se puede cambiar usando las flechas de la caja de texto  del 
menú principal de Interactive Petrophysics. 
 
 
 
 
ΙΙΙ.-7.-  CERRAR UN POZO 
 
Para activar la opción cerrar un pozo selecciona FILE > Close Well, entonces selecciona 
el pozo (ó los pozos) que deseas cerrar quitándolos de la memoria y posteriormente da un 
clic al botón OK. El programa te pedirá que confirmes si todos los pozos deberán ser 
salvados en la Base de Datos. 
 
 

                     
Fig. III.7 Ventanas que muestran la opción para cerrar un pozo 
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ΙΙΙ.-8.- LOCALIZACIÓN DE ARCHIVOS PREVIAMENTE DEFINIDOS 
 
La localización de directorios con información es usada por el programa para encontrar el 
directorio de entrada y el directorio de datos de salida que ya están predefinidos. 
Escribir el directorio de salida es especialmente importante ya que en este archivo se 
guardan todos los parámetros de interpretación, a menos que el usuario decida otro tipo 
de localización. 
 
Otros directorios son útiles al archivo, pero el usuario tiene el control para verificar en 
donde los archivos de entrada son cargados y anular el directorio pre-definido.  
 
Para accesar a esta opción selecciona Input/Output > SetDefault File Location. 
 

 
Fig. I II.8 Figura que muestra Diferentes Bases de Datos que el usuario puede utilizar 
 

• Input Directory : Esta subventana es donde el programa verá o encontrará los 
archivos de entrada de datos y de entrada de un conjunto de parámetros de 
interpretación. 

• Output Directory: Esta parte de la ventana desplegada en la figura anterior del 
programa, salvará los archivos de salida de información y la serie de parámetros 
de interpretación. Normalmente, los directorios de entrada y de salida son los 
mismos. 

• Use Separate Input/Output directory for each well: Esta opción llama a un Nuevo 
directorio; será creado para cada pozo bajo el directorio de salida. Esto le permite 
agruparse de acuerdo al número de pozo, y todos los archivos de diferentes 
formatos que Interactive Petrophysics reconoce como archivos de salida. Cuando 
cambiamos las Bases de Datos, el programa parece ver si se usan directorios de 
salida separados, sin embargo, es una buena idea verificar ésta opción cuando se 
está creando un nuevo Banco de Información. Porque el usuario tiene la libertad 
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de guardar o salvar archivos donde se ingrese información (archivos de entrada) y 
salve parámetros de interpretación (archivos de salida). 

 
Nota: Los directorios de pozos sólo se crean cuando se necesitan. Si los datos de 
entrada están en un archivo de “X” nombre, pero si no existe un archivo de salida 
(donde se guardó), entonces el directorio del pozo no existirá. 
 
 
• Formula Directory: Este es el directorio donde Interactive Petrophysics salva 

fórmulas. Las fórmulas que se hayan guardado con anterioridad en esta opción se 
hacen volver para ser usadas con otros pozos. 

• Los botones con la leyenda Browse permiten al usuario hacer una inspección de 
dónde se tienen guardadas las carpetas de trabajo, esto con el propósito de 
encontrar el directorio que se quiera usar para mayor facilidad y rapidez. 

• El botón Update Defaults escribe y guarda todos los cambios al disco de tu PC para 
que estos archivos sean usados en la siguiente sesión. 

• La etiqueta con el nombre Same Directory for all pone los archivos de entrada y 
salida y archivos de fórmulas en un solo archivo. 
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CAPÍTULO IV  INFORMACIÓN REQUERIDA PARA EL USO DE IP 
 
IV.1.-INTRODUCCIÓN 
 
Interactive Petrophysics reconoce y acepta varios tipos de archivos o formatos de entrada 
de la información como: Las, ASCII y Dbase4, éstos son los más usados. Todos los 
formatos de carga de datos actualmente disponibles pueden ser encontrados o 
seleccionados al ingresar a Input/Output > Load Data desde el menú principal. 
 
En esta lección el usuario aprenderá a : 

• Cargar Archivos tipo LAS 
• Cargar Archivos tipo ASCII 

 
 
ASCII es un estándar de representar caracteres y símbolos en forma electrónica. Usar 
estándares aumenta la eficiencia y elimina errores. Usar estándares requiere disciplina y a 
veces restringe la creatividad. Es un estándar americano de codificación para el 
intercambio de información. 
Las siglas ASCII vienen de "American Standard Code for Information Interchange". Los 
ordenadores pueden entender solamente números, así que un código ASCII es la 
representación numérica de un carácter tal como ' a ' o ' @ ' o una acción de una cierta 
clase. El ASCII fue desarrollado hace tiempo y ahora los caracteres no imprimibles se 
utilizan raramente para su propósito original. El ASCII fue diseñado realmente para el 
uso con los teletypes así que las descripciones son algo obscuras. Si alguien dice que 
desea su CV en formato ASCII, quiere decir que desea el texto ' llano ' sin ajustar a 
formato tal como lengüetas, en negrita o subrayado - el formato crudo que cualquier 
computadora puede entender. Esto es así en general y es posible importar fácilmente el 
archivo a otras aplicaciones conocidas. Notepad.exe crea el texto del ASCII, o en el MS 
Word puede guardar un archivo como”solo texto “. 
 
Lo mismo ocurre con los anteriores archivos LAS Y Dbase4 reconocidos por Interactive 
Petrophysics. 
 
 
IV.2.-ENTRADA DE ARCHIVOS “LAS” 
 
Para cargar archivos LAS el usuario puede accesar seleccionando Input/Output > Load 
Data > LAS desde el menú principal. El programa cargará los datos desde la versión 1.2 
hasta la versión 2.0 de Interactive Petrophysics. 
 
La figura (Fig. IV.1) muestra la ventana desplegada después de haber hecho la selección. 
Todos los datos desplegados en la ventana son automáticamente leídos desde el archivo 
LAS. 
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Fig. IV.1 Curvas de Registros en formato “LAS” 
 
 
PROCEDIMIENTO: 
 

1. Selecciona Input/Output > Load Data > LAS 
 
2. Selecciona de la Base de Datos (archivos de entrada) Well1dilr1.las y da un clic en 

open. 
 

 
3. El usuario debe asegurar que no esté seleccionada la curva de profundidad ( 

Interactive Petrophysics creará su índice de profundidad de acuerdo a la 
profundidad de la cima, la profundidad del intervalo de interés y el intervalo de 
muestreo). 

 
4. Con el botón Bottom Depth se puede cambiar la profundidad a un valor de interés. 
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5. La extensión puede ser cambiada a una extensión deseada (actualiza el nombre de 

la curva por si cuenta con más registros guardados en la Base de Datos para que el 
usuario no se confunda al comenzar el proceso de interpretación). 

 
6. Da un clic en Load 

 
 
7. Da un clic en New File y ahora selecciona Well1dnr1.las y open. 
 
8. Agrega una extensión de número 1 para las curvas (código de los mnemónicos). 

 
 
9. Da un clic en Load. 
 
10. Cierra la ventana de carga de Datos tipo LAS 

 
 
11. Los datos se cargaron en la memoria interna de la computadora, ahora para 

salvarlos en la Base de Datos. Selecciona File > Save Current Well to Database 
 
 
 
IV.3.- ENTRADA DE ARCHIVOS ASCII 
 
Para cargar archivos de formato ASCII se puede accesar seleccionando Input/Outpu > 
Load Data > ASCII desde el menú principal de Interactive Petrophysics. La figura  
(Fig. IV.2) ha sido desplegada después de haber hecho la selección. El programa intentará 
definir el formato del archivo ASCII seleccionado y desplegará el nombre de las curvas, 
las unidades y la primera línea de datos en la tabla mostrada sobre los datos de entrada. El 
usuario debe asegurarse que esto es correcto antes de proceder a cargar el archivo. 
Si el formato no es correcto, el usuario debe poner el formato a mano. 
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Fig. IV.2 Figura que muestra datos de núcleos en formato ASCII 
 
 
 
PROCEDIMIENTO: 
 
 

1. Selecciona Input/Output > Load Data > ASCII. 
 
2. Selecciona el archivo de datos w1core.txt y da un clic en open. 

 
 
3. Verifica que el número de línea no se encuentre defasado para que lea 

correctamente las curvas correspondientes y da un clic en la caja de texto Apply. 
 
4. Verifica que la línea con el número que corresponda al renglón lea las unidades y 

da un clic en Apply. 
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5. Entra con el número de línea correspondiente, en el cual va a empezar a leer los 
datos (de profundidad y de porosidades correspondientes de núcleos) y da un clic 
en Apply. 

 
6. Después de llenar los pasos 3,4 y 5 el usuario debe asegurar que el intervalo de 

muestreo, las unidades y la cima y la profundidad de fondo estén definidas 
correctamente y después da un clic en Load. (los datos están cargados en la 
memoria interna de la computadora). 

 
 
7. Para salvar los datos en la Base de Datos selecciona File > Save Current Well.  

 
 
 
IV.4.- EDICIÓN Y ENCABEZADO DE LAS CURVAS 
 
 
La edición del encabezado de datos de curvas de registros y el encabezado de la 
información del pozo el usuario lo puede salvar tiempo antes de que comience el proceso 
de interpretación. Los valores pre-definidos de algunos parámetros de la curva pueden 
prepararse, personalizarse y acelerar los procesos de actualización. 
 
En esta lección el usuario aprenderá como: 
 

• Editar encabezados de curvas 
• Editar información general del pozo 
• Editar curvas previamente definidas 
• Editar colores en zonas del registro 

 
 
 
El marco actual del encabezado de curvas permiten al usuario preparar parámetros para 
cada curva que será tomada por cada módulo, por ejemplo la opción log plot que se corre 
en Interactive Petrophysics. Otra información como; agregar información, y actualizar la 
información también puede verse en este módulo. 
 
Cada caja de texto en la figura (Fig. IV.3) que aparece en la hoja de cálculo puede ser 
modificada posicionándose en dicho cuadro en el que se requiera cambiar o actualizar la 
información. 
 



  
                                                                     97 

 
Fig. IV.3 Ventana que muestra varias características de los diferentes registros de pozos 
 
 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona Edit > Edit Curve 
Headers 

 
2. Da un clic en la caja de texto en left scale para cambiar la escala del registro sónico 

y cambiarla a 150 µs/f 
 

 
3. Da un clic ahora en la caja de texto en righ scale para cambiar la escala del registro 

sónico y cambiarla a 50 µs/ft 
 
4. Repite los pasos 2 y 3 para la otra curva del registro sónico ahora con extensión 2 

(DT2) 
 

 
5. Da un clic en la pestaña Color para la curva Cali1 y selecciona Navy de la caída de 

la lista de opciones 
 
6. Repite el paso 5 ahora para la curva Cali2 

 
 
7. Arrastra la barra horizontal a la derecha para ver las otras columnas de la edición 

de curvas 
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8. Nota la columna final. Cuando éstas columnas son seleccionadas, el programa 

reconocerá esto como la curva final y lo usará cuando corra los módulos 
 

 
9. Ir a Short Order a la parte superior izquierda de la ventana. Desde la caída de 

opciones selecciona Curve Type. Las curvas son ordenadas ahora por tipo. 
 
10. Da un clic en Update para que sea actualizado este paso. 

 
 
 
IV.5.- EDICIÓN DE INFORMACIÓN GENERAL DEL POZO 
 
 
Este módulo muestra información general del pozo, información que servirá más adelante 
en los módulos de interpretación (este es el encabezado real del registro), en él se puede 
encontrar: 

- Nombre del pozo 
- País al que pertenece 
- Localización 
- Nombre del campo o provincia petrolera 
- Compañía encargada de la toma del registro 
- Ciudad 
- Elevación 
- Fecha 
- Cima 
- Profundidad del pozo, etc 

 
En esta opción se puede agregar ó cambiar la información del pozo para que tenga una 
mejor presentación a la hora de entregar un análisis de resultados posterior al proceso de 
interpretación.  
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Fig. IV.4 Figura que ilustra la información contenida en el pozo de estudio 
 
 

 
Fig. IV.5 Figura que ilustra la información contenida en el pozo de estudio 
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En esta lección el usuario aprenderá como: 

• Agregar información general del pozo 
• Cambiar información al encabezado del pozo 

 
 
PROCEDIMIENTO:  
 

1. Desde el menú principal de Interactive Petrophysics selecciona Edit > Edit General 
Well Data  

 
2. En la caja de texto donde aparece Rm agrega el valor de 0.2 y para la temperatura 

de Resistividad de lodo pon el valor de 80°F 
 

 
3. En la caja de texto ahora para la Resistividad del filtrado de lodo (Rmf) ingresa el 

valor de 0.15 y un valor de 80°F para la temperatura de Rmf 
 
4. En la caja de texto donde aparece la Resistividad del enjarre agrega el valor de 0.3 

y para la temperatura un valor de 80°F 
 

 
5. Ya que se han llenado estos valores ahora agrega un valor de Resistividad del 

agua de 0.1, con su correspondiente valor de temperatura de 80°F 
 
6. Para la compañía contratada de toma de registros selecciona Schlumberger 

 
7. Ahora da un clic en OK 

 
 
 
 
IV.6.- EDICIÓN DE CURVAS PREVIAMENTE DEFINIDAS 
 
Este sistema de curvas pre-definidas están contenidas dentro del directorio de instalación 
de (C:\ Interactive Petrophysics). Para accesar al archivo selecciona Tools > Edit Curve 
System Defaults 
 
El archivo es abierto con Notepad y puede ser editado y salvado. 
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Fig. IV.6. Figura que muestra la localización de curvas de registros desde un archivo externo (Notepad) 
 
 
IV.7.- EDICIÓN DE COLORES EN DIFERENTES ZONAS DEL REGISTRO 
 
 
Los colores desplegados para algunas zonas de los registros se utilizan en log plots, 
crossplots e histogramas. Los colores que aparecen en la caída de la lista son usados 
automáticamente si el usuario no lo ha especificado. Los colores están definidos en un 
archivo llamado ZoneColors.opt donde se crea en cada proyecto. 
 
Para accesar al editor de este módulo selecciona Tools > Edit Zone Colors 
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Fig. IV.7. Ventana que muestra los colores que se pueden utilizar en zonas deseadas de los registros 
 
 
Para construir ó retocar una combinación de colores en una zona del registro da un clic en 
la caja de texto del color ó los colores deseados desde la caída principal de opciones. Si 
quieres que Interactive Petrophysics lo haga automáticamente da un clic en la opción 
Defaults. 
 
 
En esta lección el usuario aprenderá como: 

• Editar colores en cualquier zona del registro 
 
 
 
 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona Tools > Edit Zone 
Colors 

2. Da un clic en la barra de colores para la zona 12 y cambiarlo a gris ligero 
3. Da un clic en OK  
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IV.8.- LOG PLOTS (GRÁFICOS) 
 
 
Un log plot provee una interfase gráfica al mostrar datos digitales del registro. El usuario 
puede trabajar hasta con 15 gráficos desplegados simultáneamente. Los gráficos pueden 
provenir desde un mismo pozo ó de pozos diferentes; estos pozos se encuentran cargados 
en la memoria de la PC. El nombre del pozo activo ó del cuál se están desplegando los 
gráficos aparecerá en la parte superior de la ventana del menú principal de Interactive 
Petrophysics. 
 
Cualquier módulo, seleccionado desde el menú principal trabajará con datos de pozo que 
está actualmente activo en el programa. 
 
En esta lección el usuario aprenderá como: 
 

• Abrir un log plot (gráfico) 
• Modificar un log plot 
• Agregar un sombreado al gráfico 
• Agregar anotaciones 

 
IV.9.- PLOT FORMATS 
 
Tres formatos pre-definidos son guardados en el directorio del programa con una 
extensión .plt. Otros formatos de cuadros pre-definidos pueden ser creados y usados 
seleccionando la opción Load Plot Format de la opción en la barra de menús. Esto 
permite al usuario seleccionar alguno previamente definido. Los cuadros pre-definidos 
pueden ser muy flexibles; por ejemplo, se puede trazar una curva de rayos gamma que es 
llamada por diferentes nombres (GR, SGR,GRC, etc). Los formatos pre-definidos se 
activan seleccionando Types para definir las curvas. La curva que creada recientemente, 
es la que será abierta en primer lugar. Los archivos para formatos de cuadros (registros) 
pueden ser creados fuera del programa usando un editor, como Notepad. Es mejor copiar 
un ejemplo pre-existente y hacerle cambios posteriores. 
 
En la figura (Fig. IV.8) se presenta un ejemplo mediante la opcion triple combo con 
algunos rasgos ó características de este formato. 
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Fig. IV.8 Figura que muestra los diferentes tipos de registros mediante la opción triple combo de IP 
 
PROCEDIMIENTO: 
 

1. Selecciona el pozo # 1 como el pozo actual 
 
2. Desde la ventana principal de IP, selecciona View > Log Plot . La ventana del 

cuadro de registros deberá abrirse. 
 

 
3. Clic en el botón File y selecciona la opción triple combo de la lista de opciones. Da 

un clic en el botón Edit Format y aparecerá la ventana Log Plot Format 
 
4. Da un clic en la pestaña superior que lleva por nombre Gris 

 
 
5. Bajo la columna de nombre número de track da un clic del botón izquierdo del 

mouse. Nota una línea resaltada sobre el renglón número 1 de la figura (Fig. IV.9) 
mostrada a continuación: 
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Fig. IV.9 Ventana de un log plot donde se pueden ocultar las curvas de los registros 
 
 
 

6. Arrastra el cursor abajo hasta la línea resaltada que se encuentra por debajo del 
renglón del track número 2 

 
7. Da un clic en la opción Apply y nota el cambio en el log plot 

 
 
8. Lo siguiente es dar un clic ahora en la pestaña Curves 
 
9. Y aparecerá la figura (Fig. IV.10): 
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Fig. IV.10  Figura que muestra el formato de cada uno de los registros de pozos 
 
10. Ingresa el valor de 1 para el número de track. Selecciona GR1 en el botón Curve 

Name Y entonces da un clic en Apply. Agrega la curva GR2 en el track número 1 y 
da un clic en Apply. 

11. Agrega las curvas SP1, GRD1 y CALI1 en el track número uno. 
12. En el siguiente renglón teclea el número 3 para el siguiente track. Selecciona 

SFLU del botón Curve Name y da un clic en Apply 
13. Agrega las curvas ILM1 y ILD1 en el track número 3 como en el paso número 11. 
14. En la siguiente fila en blanco, ingresa 4 para el número de track siguiente y 

selecciona CPOR. Cambia las escalas de izquierda a derecha con los valores 0.6 a 
0.0 y da un clic en Apply. Los datos de núcleos deben aparecer entre los intervalos 
10229 ft a 10294 ft y de 10603 a 10636 ft. 

15. En la siguiente línea en blanco, ingresa 4 para el número de track y agrega la 
curva DT1 y da un clic en Apply. Ahora agrega la curva DT2 en el mismo track. 

16. Cambia las escalas de izquierda a derecha con los valores 140-40 seleccionando la 
caja de texto y tecleando los valores en dicha caja y posteriormente da un clic en 
Apply 

17. Agrega la curva RHOB1 y NPHI en el track número 4 
18. Cambia las escalas para la curva RHOB1 y RHOB2 de izquierda a derecha con los 

valores 1.65-2.65 y las escalas para las curvas NPHI1 y NPHI2 de 0.6-0.0. 
19. Cambia el color de línea de las curvas DT1 y DT2 a azul dando un clic en la 

columna donde aparece el listado de la curva y selecciona el color azul de la lista 
de opciones y da un clic en el botón Apply 
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20. En lo ancho de la columna, selecciona cada caja de texto asociada alas curvas SP1 
y SP2. Cambia cada una y después da un clic en Apply 

21. Agrega la curva GRD1 al track número 5 
22. Selecciona de la pestaña superior izquierda la opción Shading 
23. Cierra la ventana Log Plot Format 

 
IV.10.- SPLICE CURVES (EMPALME DE CURVAS) 
 
 
El módulo de empalme de curvas permite hacer el empalme de una serie de múltiples 
curvas. Las curvas pueden ser empalmadas juntas entrando los intervalos de profundidad 
y seleccionando el tipo de curvas a empalmar. Una curva de salida se selecciona o se 
teclea en cada una de las curvas que serán empatadas. La opción en la línea superior 
izquierda (para ser exacto en el segundo renglón) Best Splice permite al programa 
intentar ajustar la profundidad del empalme de las curvas sin que se tenga una tendencia 
que no existe, es decir, que se inventen valores donde no se tienen. 
 
El programa usará el intervalo de búsqueda, para encontrar la profundidad donde las dos 
curvas que serán empalmadas tengan el valor más similar. El empalme de dichas curvas 
puede salvarse en un archivo y después es llamado cuando se necesite. 
 

 
Fig. IV.11  Figura que muestra la opción Empalme de Curvas 
 
En esta lección el usuario aprenderá como: 
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• Empalmar curvas de registros utilizando la opción Splice Curves 
 
 
PROCEDIMIENTO: 
 

1. Desde la ventana principal de IP, selecciona Edit/Splice Curves 
 
2. Para ver el resultado final de la curva Result Curve teclea SP o las curvas a 

empalmar 
 

3. Se sigue el mismo procedimiento del paso anterior ahora para la opción Best 
Splice palomea el recuadro como lo muestra la figura (Fig. IV.11) mostrada 
anteriormente. 

 
4. Selecciona la curva SP1 bajo la opción Splice Curve en la primera pestaña del 

primer renglón 
 

5. Selecciona la curva SP2 bajo la opción Splice Curve en la segunda pestaña del 
segundo renglón 

 
6. Para la primer curva (SP1) el intervalo de empalme será de 9570 ft a 10682 ft que 

deberá ser ingresado tecleando los valores manualmente en las casillas Top y 
Bottom 

 
7. Para la segunda curva SP2 el intervalo a empalmar será de 10682 a 11364 ft 
 
8. Para los intervalos en los cuales se va a llevar a cabo el empalme dentro del 

intervalo (o sea en subintervalos de cada 5 ft hasta completar la profundidad total) 
llena los valores en forma manual en la parte inferior de la ventana. 

 
9. Da un clic en la opción RUN 
 
10. Abre un log Plot y checa que la curva de salida SP (del paso 2) haya sido creada 

 
11. Finalmente cierra la opción Splice Curves 

 
 
IV.11.- EMPALME INTERACTIVO DE CURVAS 
 
La opción Interactive Splice Curves permite al usuario empalmar muchas curvas juntas 
para que el resultado final de la curva sea el formar únicamente una sola curva continua. 
 
La opción muestra al usuario la curva resultante y cuales son las curvas de entrada (de 
empalme) que serán ingresadas en este módulo. Un log Plot es usado al desplegar las 
curvas que serán empalmadas en el track izquierdo (ventana que aparecerá donde serán 
ingresadas las curvas entrantes y se tecleará la curva resultante). Pero, la curva que 
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resulte (de manera gráfica) la podemos ver en el track derecho de la ventana del Log Plot. 
En la figura (Fig. IV.12) que se muestra a continuación se ingresarán las curvas de entrada 
y se seleccionará la curva de salida (es decir la curva resultante). 
 

 
Fig. IV.12  Figura que muestra las curvas a empalmar (encontrar un valor similar entre ellas) 
 
PROCEDIMIENTO: 
 

1. Abrir un Log Plot seleccionando la opción triple combo 
2. Desde la ventana principal de Interactive Petrophysics selecciona Edit > Interactive 

Curve Splice. Entonces la ventana se abrirá. 
3. Teclea GR (que será la curva resultante y selecciona GR1 y GR2 como entrada de 

curvas. Después de hacer la selección da un clic en la opción RUN 
4. Cambia la escala a 1:200 
5. Mueve el cursor en el intervalo del track a una profundidad de 10595 y da un clic 

en el botón del mouse 
6. Selecciona la opción Splite Zone. Nota los intervalos separados y la línea de 

empalme es creada 
7. De nuevo en el intervalo del track, mueve el cursor encima de la línea de 

empalme hasta que se cambie con las flechas ↕ 
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8. Sujetando el botón izquierdo del mouse, ajusta la línea de empalme 
9. Después de tener el empalme deseado da un clic en la opción del botón Finish 

Splice 
 
 
La siguiente figura (Fig. IV.13) muestra ahora las curvas (en este caso sólo fue una sola 
curva de entrada) y la curva de salida (resultante) en la que se obtuvo el empalme 
deseado. 
 

 
Fig. IV.13  Figura que muestra las curvas ya empatadas 
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CAPÍTULO V  PROCESAMIENTO DE LA INFORMACIÓN CON IP 
 
V.1.- INTRODUCCIÓN 
 
El módulo Interactive Depth Shift permite al usuario comparar una curva contra otra para 
ver como es tal cambio en dichas curvas. El usuario prepara la serie de curvas (en 
profundidad) en los tracks deseados. Esto permite al usuario emparejar múltiples curvas 
al mismo tiempo. Los cambios son guardados en un archivo con extensión .sft. El archivo 
puede ser llamado posteriormente y editado usando Notepad. Asegúrese que un Log Plot 
esté abierto al activar este módulo. 
 
 
 

 
Fig. V.1 Entrada y salida de curvas a empatar 
 
PROCEDIMIENTO: 
 

1. Abre la opción triple commbo de un Log Plot en el cuál estén contenidas las curvas 
finales (ya editadas) como GR,GRD,CALI,SP,ILM,ILD,DT,RHOB y NPHI 
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2. Desde el menú principal de Interactive Petrophysics selecciona Edit > Interactive 
Depth Shift. La ventana de formato Log Plot será abierta. 

3. Después de hecha la selección se abrirá la ventana de la figura (Fig. V.1), y 
aparecerá la siguiente ventana (Fig. V.2): 

 
 

 
Fig. V.2 Profundidades en que serán empatadas las curvas (registros de pozos) 
 
Nota: El programa interpolará entre los datos de la curva, si los resultados de 
defasamiento en profundidad caen entre dos incrementos de los datos que se tienen. 
Si no se verificó entonces el valor de entrada para la profundidad de cambio se 
escogerá automáticamente. 
Para datos de núcleos esta opción no debe verificarse, por otra parte podría producir 
interpolaciones entre los puntos de los datos nulos (-999) y los datos buenos. 
 
4. En la primera fila ingresa 1 para el número de track, deja el espacio en blanco 

para la curva resultante y selecciona Display Curve y Reference Curve dando un clic en 
cada una de las pestañas correspondientes. 

5. En la segunda fila selecciona 1 para el número de track y selecciona de la lista de 
opciones GRD para la curva de entrada, la curva de salida debe ser llenada 
automáticamente y selecciona las opciones Shift Curve y Display Curve 

6. En las siguientes cuatro filas usa la curva RHOB,NPHI y CALI. Pónlos en el track 
número 1 y selecciona Shift Curve 

7. Da un clic en la opción Start 
8. La curva GR y GRD deberán desplegarse ahora en un Log Plot. Cambia el color de 

la curva GRD a rojo 
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9. Empieza el defasamiento, examina las curvas, da un clic en el botón izquierdo del 
mouse y no lo sueltes de la curva deseada 

10. Mueve la curva GRD para emparejarla con la curva GR y después suelta el botón 
del mouse. Una línea de defasamiento horizontal aparecerá con una línea de 
defasamiento color rojo a la derecha del track. Para eliminar el defasamiento da 
un clic en la opción Delete  

11. Continúa con el paso # 10, pero en forma inversa. 
12. Después de completar con el proceso de defasamiento, da un clic en la opción 

Finish de la ventana Run Depth Shift 
13. Si la respuesta es sí, salva los datos en tu disco 
14. Guarda el archivo con el siguiente nombre y extensión DepthShift.sft y da un clic en 

Save 
15. Salvarlo en la Base de Datos 

 
 
 
V.2.- DEFASAMIENTO DE LA LÍNEA BASE 
 
El módulo Interactive Baseline Shift le permite al usuario aplicar gráficamente un cambio 
básico a cualquier curva mostrada en el Log Plot. Después de que el cambio se complete, 
los puntos reales defasados pueden salvarse en un archivo y después se vuelven a llamar 
si así se requiere. 
 

 
Fig. V.3 Ventana que muestra la opción Defasamiento de la línea Base 
 
En esta lección el usuario aprenderá como: 

• Hacer un cambio (defasamiento de la línea base) de la curva de SP utilizando la 
herramienta Interactive Baseline Shift 

 
PROCEDIMIENTO: 
 

1. Abrie la opción triple commbo del Log Plot donde se desplegará la curva de SP 
2. Desde el menú principal de Interactive Petrophysics, selecciona Edit > Interactive 

Baseline Shift 
3. Selecciona la opción Create New Curve 
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4. Entones con el cursor, da un clic en la curva de SP en el Log Plot. (Nota: tú debes 
darle un clic justo en la curva del Log Plot y no en el título de la curva). Llena la 
caja de texto con el nombre Curve to Shift con la curva de SP 

5. Para la curva resultante teclea SPBL 
6. Deja el valor de cero en la opción Baseline Value y da un clic en la opción Start Shift 
7. El despliegue del Log Plot ahora se encuentra activo y una línea verde se despliega 

al valor cero.  
8. Cambia las escalas de la curva de SP de -80 a 20 
9. Empezando por la parte superior del Log Plot, selecciona el primer punto de la 

arcilla pulsando el botón izquierdo del mouse de la curva de SP. El cambio 
consistirá en las secciones de la línea que unen a los puntos entrados por el 
usuario. Los puntos entrados por el usuario aparecen como pequeños círculos 
azules adelante del cambio. El usuario puede mover un punto poniendo el cursor 
del mouse en un punto ) ahora el cursor cambiará de una flecha a una cruz) y la 
tendencia abajo del botón izquierdo del mouse sobre el punto puede arrastrarse a 
una nueva posición. Para eliminar el punto, mueve el cursor encima del punto y 
presiona la opción delete.Ver figura (V.4) 
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Fig. V.4 Procedimiento para ajustar la línea Base de la curva SP 
 
10. Continúa al fondo del Log Plot seleccionando puntos y emparejándolos a la curva 

de SP 
11. Después de finalizado, da un clic en Finish Shifth en la ventana de Baseline Shifth 
12. El programa te pedirá que si salvarás (los cambios). Si tu respuesta es sí entonces 

da un clic en la opción Yes y llama el archivo con el nombre: BaselineShifths.bls y 
entonces da un clic en la opción Save 

 
 V.3.-FILTRADO Y PROMEDIO DE UNA CURVA 
 
V.3.1.- FILTRADO DE UNA CURVA 
 
El módulo Curve Filter permite al usuario filtrar una curva. Dos tipos de filtros están pre-
definidos y están disponibles; así como un filtro que el usuario podrá definir. La longitud 
máxima del filtro es de 121 incrementos de muestra de la Base de Datos, que si se usara 
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el filtro que el usuario deberá definir;por otra parte, pueden usarse 2001 incrementos de 
la muestra. 
 

 
Fig. V.5 Figura que muestra la opción para filtrar cualquier curva 
 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona Edit > Curve Filter 
2. Selecciona en la opción Input Curve e ingresa el nombre de la curva a filtrar 
3. Selecciona en la opción Backup Curve si así se requiere un respaldo de la curva 

deseada a filtrar 
4. Posteriormente selecciona el número de niveles a filtrar en la opción Number of 

Nivels 
5. Da un clic en la opción RUN 

 
 
 
V.3.2.- PROMEDIO DE UNA CURVA 
 
El módulo Curve Average permite promediar varias curvas de entrada. Esto puede ser útil 
si se han hecho anteriormente anotaciones en una zona en particular y un promedio de 
dicha curva se requiere para la obtención de algunos resultados. 
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Fig. V.6 Ventana desplegada para promediar cualquier curva 
 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona Edit > Curve Average 
 
2. Selecciona la opción Output Curve y escribe el nombre de la curva resultante de la 

que se obtendrá un promedio de las curvas entrantes 
 

 
3. En la columna que se encuentra en la parte central izquierda ingresa las curvas de 

entrada con la opción Input Curves 
 
4. Finalmente de un clic en la opción RUN 

 
 
V.4.-EXTRAPOLACIÓN DE DATOS DE UNA CURVA 
 
El módulo Fill Data Gaps de llenado de espacios en blanco de datos (es decir, valores 
nulos=-999) permite la extrapolación de datos encima de cualquier intervalo vacío 
encontrado en una curva. Esta opción puede ser muy útil para rellenar espacios donde no 
se tienen valores o para obtener datos continuos de la curva en un intervalo de un 
conjunto de datos. 
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Fig. V.7 Figura que muestra la opción de extrapolación de valores 
 
En esta lección el usuario aprenderá como: 

• Usar la opción Fill Data Gaps 
 

PROCEDIMIENTO: 
 

1. Carga los datos del archivo Well1drh0.las. Nota el incremento de la muestra por 
pie. Habrá datos nulos o cada medio pie de formación están tomados dichos datos 

2. Desde el menú principal de Interactive Petrophysics selecciona Edit > Fill Data 
Gaps. El arreglo de la ventana se abrirá (ver Fig. V.7  ) 

3. En la opción que aparece en la parte superior de la ventana ingresa el valor de 5  
4. Selecciona DRHO como curva de entrada 
5. Da un clic en la opción Create Backup (para crear un respaldo de la curva) 
6. Selecciona la opción RUN 
7. Cierra la ventana con la opción Close 
8. Agrega la nueva curva DRHO en el Log Plot 

 
 
V.5.-GRADIENTE DE TEMPERATURA 
 
El módulo Temperatura Gradient es usado para crear una curva continua de temperatura, 
que es usada en los módulos de interpretación para convertir valores de Resistividad del 
agua (Rw) a valores de temperatura de formación. 
La curva de temperatura puede ser calculada usando un gradiente o entrando las 
temperaturas en los puntos fijos, y el programa extrapolará entre ellos. Las opciones 
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Reference Depth y Temperature también necesitan ser llenadas y dar un punto de 
arranque para la temperatura. 
 

 
Fig. V.8 Opción para calcular un gradiente de temperatura en un pozo 
 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona Calculation > 
Temperature Gradient 

2. Selecciona la opción Use Points 
3. Teclea cero para la primera profundidad y el valor de 70 para la primera 

temperatura 
4. Teclea 11350 para la segunda profundidad y el valor de 250 para la segunda 

temperatura 
5. La curva de salida debe ser Temp y las unidades en grados Fahrenheit (F) 
6. Da un clic en la opción RUN y posteriormente cierra la ventana con la opción Close 
7. Después agrega esta nueva curva al carril # 2 como aparece en la figura (Fig. V.9): 
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Fig. V.9 Gradiente de Temperatura  
 
V.6.-CONVERSIÓN DE UNIDADES DE PROFUNDIDAD DE UN POZO 
 
 
El módulo de Well Depth Conversión permite la conversión del intervalo de profundidad 
de un pozo actual a un nuevo intervalo de muestreo de una unidad a otra. 
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Fig. V.10 Ventana de conversión de unidades 
 
Para cambiar las unidades de un pozo de pies a metros o viceversa tú necesitarás primero 
cambiar las unidades. Deja la profundidad de la cima y la profundidad de fondo en 
blanco. El programa calculará la nueva profundidad de la cima y la profundidad de fondo 
en las nuevas unidades.  
 
Si la distancia en la casilla de nombre Step se cambia, el programa interpolará los datos 
automáticamente para producir curvas continuas. 
 
En esta lección el usuario aprenderá como: 

• Cambiar las unidades de un pozo de pies a metros utilizando el módulo Well Depth 
• Cambiar las unidades de un pozo de metros a pies utilizando el módulo Well Depth 

 
PROCEDIMIENTO: 
 

1. Selecciona el pozo 1 de la Base de Datos, si este no ha sido seleccionado 
previamente 

2. Desde el menú principal de Interactive Petrophysics selecciona Edit > Well Depth 
Conversions 

3. Ya que se abrió la ventana, en la segunda columna que tiene por lema “Change 
to”selecciona metros para las unidades y el valor de 0.1 en la casilla Step 

4. Da un clic en la opción RUN. Nota el cambio en la columna actual 
5. Repita ahora el procedimiento; pero ahora haz el cambio de metros a pies y 0.5 

para la opción Step 
6. Da un clic en la opción Close de la ventana Well Depth Conversions para cerrar el 

módulo 
 
V.7.-MÓDULO DE INGRESO DE FÓRMULAS 
 
Este módulo puede usarse para manipular datos de la curva que usa una solo fórmula. El 
módulo puede usarse para crear una curva con un valor fijo, ó para calcular una curva con 
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una fórmula mucho más complicada. Puede usarse la opción Discriminators para limitar 
el cálculo. 
 

 
Fig. V.11 Ventana para accesar cualquier tipo de fórmula requerida en la interpretación 
  
Estas fórmulas pueden ser salvadas y después ser llamadas nuevamente. Para hacer 
aerodinámico el proceso de funcionamiento de múltiples fórmulas está la opción Batch 
Fórmula. De la misma forma este grupo de fórmulas puede ser salvado y llamado 
posteriormente. 
 

 
Fig. V.12 Ventana utilizada cuando se tiene más de una fórmula 
En esta lección el usuario aprenderá como: 

• Crear fórmulas usando el módulo Used Defined Formulas 
• Correr las fórmulas con la opción Batch Fórmula 
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PROCEDIMIENTO: 
1. Desde el menú principal de Interactive Petrophysics abre la opción Calculation > 

User Formula 
2. En la caja de texto then teclea 2.65-Rhob/2.65-1. Esto calcula la densidad y la 

porosidad 
3. Para la curva resultante Result Curve teclea DPHIds 
4. En la opción Unit teclea dec 
5. Da un clic en la opción RUN 
6. Para salvar la fórmula da un clic en la opción Save Formula 
7. Da un clic en la opción Save 
8. Y finalmente selecciona la opción Close para cerrar el módulo 
9. Desde el menú principal de Interactive Petrophysics selecciona Calculation > Batch 

Formula 
10. Selecciona el pozo 1 bajo la opción Wells 
11. Bajo la opción Formula Set Name , da un clic en el botón browse 
12. Selecciona Formula1.fmr y da un clic en la opción OK (para verificar) 
13. Da un clic en la opción RUN y posteriormente en Close para cerrar la ventana. 

La nueva curva creada por esta opción de fórmulas podrá incluirse en el track de las 
curvas de porosidad, como se muestra a continuación: 
 

 
Fig. V.13 Curva creada por la opción Used Defined Formulas 
 
V.8.-CROSSPLOTS 
 
El módulo de Crossplots es usado para representar gráficamente las relaciones entre 
algunos parámetros y para realizar cálculos en las curvas de los registros. 
Los datos pueden ser desplegados simultáneamente en el crossplot con dos o tres ejes, es 
decir se podrá ver en dos o tres dimensiones. Los crossplots pueden descargarse en 
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escalas lineales ó logarítmicas. Una curva pre-definida se usa para el eje Z ó el usuario 
puede personalizar la curva y el rango de valores. El módulo Crossplots es activado desde 
el menú principal ó poniendo el cursor sobre el carril del registro y pulsando 
correctamente el botón del mouse. Cada despliegue puede imprimirse, copiarse en un 
portapapeles ó puede imprimirse en otro archivo. 
 

 
Fig. V.14 Figura representada por la opción Crossplot 
 
En esta lección el usuario aprenderá como: 

• Arreglar o crear un crossplot 
• Desplegar un crossplot 

 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona View > Crossplot y 
la ventana se abrirá (ver Fig. V.14) 

2. Para el eje X selecciona la curva NPHI, para el eje Y selecciona la curva RHOB y 
seleccione GRD para el eje Z1 

3. Da un clic en la opción OK 
4. Da un clic en la opción 3D 
5. Pon el cursor en el Crossplot, sujeta el botón izquierdo del mouse, y arrástralo 

horizontalmente y verticalmente. Nota como rota el crossplot 
6. Deshabilita la opción 3D y selecciona la opción Edit Format 
7. Cambia el número de líneas verticales y horizontales a 10 
8. Cambia los colores para la curva GRD a 5 
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9. En la opción Overlay Lines selecciona Schlumberger Den/Neut.Corr Den=1 desde las 
opciones de la lista 

10. Da un clic en la opción OK. Nota los cambios hechos en el crossplot 
11. Da un clic en Edit Format, elimina la curva GRD y da un clic en la opción OK 
12. Selecciona Function > Creat Area 
13. Define un área pulsando el botón y arrastrándolo mientras sujetas el botón 

izquierdo del mouse 
14. Para cerrar el área deseada deja de oprimir el botón del mouse y nuevamente traza 

la siguiente línea hasta completar el área deseada 
15. Después de hecha la selección da un clic en la opción Function > Regression  
16. En la ventana de análisis de Regresión selecciona RMA y da un clic en RUN 
17. Da un clic en la opción View Report, y da un clic en Save para guardar el reporte en 

un archivo (usa el nombre de archivo pre-definido) 
18. Da un clic en la opción Close para cerrar la ventana Regressión Análysis y cierra el 

reporte 
19. Selecciona la opción Function > Delete Regression Line 
20. Selecciona la opción Function > Delete Area 
21. Selecciona la opción File > Close 

 
Después de realizar los pasos1-6 la ventana (Fig. V.15) aparecerá de la siguiente forma: 
 

 
Fig. V.15 Crossplot en tres dimensiones 
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Fig. V.16 Crossplot en dos dimensiones 
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V.9.-HISTOGRAMAS 
 
 
Los histogramas de las curvas pueden ser creados y personalizados en el módulo de 
Histogram. La presentación o despliegue del histograma puede ser mediante un tipo de 
barra o bien, algún tipo de curva en escalas lineal ó logarítmica en el eje X. El eje Y tiene 
la opción de desplegar en frecuencia o porcentaje de algún parámetro. Se puede elegir la 
opción Discriminators para desplegar sólo los datos en el que el usuario esté interesado. 
Pueden usarse intervalos de profundidad o profundidades zonales en el histograma. 
 
El módulo de Histogramas o se activa del menú principal de Interactive Petrophysics ó 
poniendo el cursor en el track de la curva deseada del Log Plot y dando un clic en el 
botón izquierdo del mouse aparecerá la opción Histogram. Cada despliegue de 
Histograma puede imprimirse, puede copiarse al portapapeles, ó puede imprimirse en 
otro archivo. 
 

  
Fig. V.17 Ventana representada por la opción Histogramas 
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Fig. V.18 Histograma de la curva de Rayos Gamma 
 
En esta lección el usuario aprenderá como: 

• Preparar un Histograma 
• Desplegar un Histograma 

 
 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona View > Histogram. Y 
la ventana de arreglo del histograma se abrirá (ver Fig. V.18. Histogram- Well1) 

 
2. Selecciona la curva GR para el nombre de la curva (curva en la cuál se hará el 

histograma), selecciona la opción Frecuency Count para el eje “Y” y selecciona la 
opción Interval Depths para el intervalo de profundidad 

 
 
3. Da un clic en OK 
 
4. Selecciona la opción Edit Format y para el eje “Y” selecciona Percentile y da un clic 

en OK 
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5. Selecciona la opción Edit Format y entonces da un clic en la pestaña de la tabla que 
lleva por nombre Discriminators localizada en la parte superior izquierda de la 
ventana 

6. Introduce un arreglo (una condición) como: GR>75. Asegúrate que la casilla USE 
esté verificada (no activarla) y posteriormente da un clic en la opción OK 

 
7. Da un clic en File > Close 

 
 
 
V.10.-PROFUNDIDAD VERTICAL VERDADERA (TVD) 
 
El módulo TVD es usado para crear una curva continua de profundidad vertical 
verdadera de un estudio de desviación del pozo. El estudio de desviación del pozo, puede 
cargarse en el módulo o mediante datos que se obtengan de alguna curva de desviación 
(es decir, introducir esos datos manualmente) ó finalmente seleccionando un archivo tipo 
ASCII que contenga la información. Hay cuatro métodos de cálculo estándar a partir del 
cuál se haya seleccionado. 
 
 

 
Fig. V.19 Ventana para crear la curva de TVD 
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Fig. V.20 Formato ASCII de la curva TVD 
 
En esta lección el usuario aprenderá como: 

• Calcular una curva de Profundidad Vertical Verdadera usando el módulo TVD 
 
 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics, selecciona Calculation > TVD. 
Y la ventana de Profundidad Vertical Verdadera se abrirá 

2. Da un clic en la tabla TVD Model y selecciona minimum curvatura para el método de 
cálculo 

3. Posteriormente da un clic en la pestaña File or Keyboard entry 
4. Da un clic en la casilla Load From File y selecciona Well1tvd.txt ó usando la opción 

browse 
5. En Data Format pon el valor de 2 en la opción Data Starts al line, 1 para la columna 

Depth is in, 2 para la columna Desviation is in y el valor de 3 para la columna Azimuth 
is in 

6. En File Format Delineator, selecciona Spaces 
7. Da un clic en RUN y Save para guardarlo como un archivo pre-definido 
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8. Da un clic en View Listing para abrir el archivo creado 
 
Este es el archivo que se ha creado: 
 

 
Fig. V.21 Formato Notepad de la curva TVD 

 
 
9. Ve el archivo y ciérralo 
10. Cierra la ventana TVD mediante la opción Close 
11. Salva la curva TVD creada en la Base de datos con la opción Save 
12. Abre un Log Plot mediante la opción triple commbo con los datos finales 
13. Da un clic en Edit Format y cambia Depth Gris Datum Curve por TVD. Da un clic en 

OK. Nota que las curvas son ahora en referencia a la curva TVD  
14. Da un clic en Edit Format 
15. Cambia Depth Grid Datum a Depth y da un clic en Apply 
16. Agrega un track a la derecha del track de profundidad con parámetros similares o 

con los mismos parámetros y da un clic en RUN 
17. Da un clic en la porción del título del track creado 
18. Bajo la opción Curves agrega la curva TVD y da un clic en RUN 
19. El Log Plot ahora despliega ambas profundidades MD y TVD 
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Nota ahora que todos los datos de las curvas del Log Plot despliegan ambas 
profundidades (Fig. V.22): 
 

 
Fig. V.22 Curva terminada de TVD mostrada en un Log Plot 
 
 
V.11.-DETERMINACIÓN DE Rw A APARTIR DE LA CURVA SP 
 
El módulo Rw from SP es usado para crear una curva continua de Rw, que es útil para 
estimar valores de Resistividad del agua de formación en zonas de interés. 
 
Los usuarios entran la curva de SP defasada a 0.0 mv y también debe entrarse una curva 
de temperatura. La curva resultante RwSP se calculará y se corregirá a la temperatura de 
entrada. La temperatura de entrada puede ser una curva ó un valor fijo. 
 
La curva opcional de salinidad convierte los valores de RwSP a valores de salinidad en 
unidades de kppm de cloruro de sodio equivalente. 
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Fig. V.23 Ventana desplegada para evaluar Rw 
 
En esta lección el usuario aprenderá como: 

• Calcular la Rw a partir de la curva de SP en Interactive Petrophysics 
 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona Calculation > Rw 
from SP 

2. El arreglo de la ventana se abrirá 
3. Asegúrate que al seleccionar las curvas SP y de Temp (de temperatura) sean las 

correctas 
4. Teclea 0.99 para Rmf y 80 para la temperatura de Rmf 
5. Asegúrate que todas las temperaturas estén en grados Fahrenheit 
6. Para la curva resultante usa RwSP y para la curva de salinidad resultante teclea 

Salinity 
7. Las casillas con nombre Start y Stop Depths déjalas en blanco 
8. Da un clic en la opción RUN  y posteriormente cierra la ventana con la opción 

Close 
9. Abre un Log Plot mediante la opción triple commbo y despliega la curva RwSP en el 

track de Resistividad (en escala logarítmica) 
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  V.12.-CORRECIONES AMBIENTALES 
 
El módulo Environmental Corrections usa correcciones ambientales para los registros 
proporcionadas por Schlumberger y Baker Atlas. 
Las correcciones de Schlumberger están basadas en algoritmos distribuidos por dicha 
compañía en su librería o biblioteca llamada “Green Book”. Por otra parte las 
correcciones Baker Atlas están basadas en algoritmos proporcionados por su biblioteca ó 
librería de correcciones ambientales. Las pantallas para cada módulo son similares, pero 
con opciones diferentes que dependen del tipo de herramienta. 
En esta lección el usuario aprenderá como: 

• Preparar las correcciones ambientales de Schlumberger en Interactive 
Petrophysics 

• Correr  las correcciones ambientales de Schlumberger en Interactive Petrophysics 
Nota: Antes de comenzar los ejercicios, carga el archivo W1splice.las. Este archivo 
contiene las curvas editadas, defasamiento en profundidad y el empalme de las curvas. 
Selecciona la opción sobrescribir todas las curvas al estar cargando el archivo. 
 
  V.12.1.-CORRECIONES PARA EL REGISTRO DE RAYOS GAMMA 
 

 
Fig. V.24 Correcciones para la curva de Rayos Gamma 
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PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona Calculation > 
Schlumberger Corrections. La ventana de Correciones Ambientales se abrirá 

 
2. Da un clic en la pestaña del registro de rayos gamma Gamma Ray 

 
 
3. Selecciona GRDds para la opción Gr Input Curve ( que será la curva de entrada y la 

cuál será corregida ) 
 
4. Selecciona CALIds para la opción Caliper Input Curve or Hole Size ( que será la curva 

de entrada de calibración del agujero) 
 

 
5. Selecciona GrC para la opción Gr Output Curve (que será la nueva curva de rayos 

gamma ya corregida) 
 
6. Selecciona Borehole Correct, Eccentric para la posición de la herramienta, Barite para 

el tipo de lodo y Open Hole para el tipo de agujero 
 

 
7. Teclea 11.8 para la opción Mud Weight (densidad del lodo), 3.875 para la opción 

Tool Diameter (diámetro de la herramienta) y el valor de 0 para la opción standoff 
 
8. El intervalo de profundidad del pozo será para la cima un valor de 9570 y para la 

profundidad de fondo de 10685 
 

 
9. Da un clic en el botón Run Tab y entonces da un clic en Plot Results para ver la 

curva GrC 
 
Nota: el intervalo de profundidad es de acuerdo a los datos proporcionados por 
Schlumberger 
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V.12.2.-CORRECCIONES PARA EL REGISTRO DE DENSIDAD 
 

 
Fig. V.25 Correcciones para la curva de Densidad 
 
PROCEDIMIENTO: 
 

1. Da un clic en la pestaña del registro de Density (registro de densidad) de la ventana 
principal de Correcciones Ambientales 

2. Selecciona RHOBds para la curva de entrada Density Input Curve, deja en blanco PEP 
Input Curve (curva de factor fotoeléctrico) y selecciona CALIds para la curva Caliper 
Input Curve or Hole Size 

3. Teclea RHOC para la curva de densidad corregida 
4. Selecciona Borehole Correct, Mud Weight (densidad del lodo igual a 11.8) y 

selecciona LTD para la opción Density Tool 
5. El intervalo de profundidad del pozo será para la cima un valor de 9570 y para la 

profundidad de fondo de 10685 
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6. Da un clic en el botón Run Tab y entonces da un clic en Plot Results para ver la 
curva RHOC 

 
 
V.12.3.-CORRECCIONES PARA EL REGISTRO NEUTRÓN 
 

 
Fig. V.26 Correcciones para el registro Neutrón 
 
PROCEDIMIENTO: 
 

1. Da un clic en la pestaña del registro CNL (registro Neutrón) de la ventana 
principal de Correcciones Ambientales 

2. Selecciona NPHIds para la curva de entrada Neutron Input Curve, Temp para la curva 
de temperatura, selecciona  DegF para las unidades en grados Fahrenheit y 
selecciona CALIds para la curva Caliper Input Curve or Hole Size 

3. Teclea NPHIC para la curva de neutrón corregida 
4. Selecciona como matriz de entrada Input Matriz la opción de arenisca, para el tipo 

de herramienta (Neutron Tool) selecciona CNT-A y para la matriz de salida 
selecciona la opción de carbonato 
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5. Activa las siguientes opciones: 
- Borehole correct 
- Hole size 
- Mudcake con un valor de 3.875 
- Temperatura 
- Mud weight con un valor de 11.8 
- Calculate pressure from depth 
- Borehole salinity 
- Barite mud, en este caso selecciona Barite y el valor de 0 en la opción Standoff 

 
6. Desactiva las siguientes opciones 
- Input Neutron hole size correction 
- Pressure  
- Case hole y  
- Oil mud 

 
7. El intervalo de profundidad del pozo será para la cima un valor de 9570 y para la 

profundidad de fondo de 10685 
8. Da un clic en el botón Run Tab y entonces da un clic en Plot Results para ver la 

curva NPHIC 
 
 
V.12.4.-CORRECCIONES PARA EL REGISTRO DE INDUCCION 
 

 
Fig. V.27 Correcciones para el registro de Inducción 
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PROCEDIMIENTO: 
 

1. Da un clic en la pestaña del registro INDUCTION (registro Inducción) de la ventana 
principal de Correcciones Ambientales 

 
2. Para las curvas de entrada selecciona ILD para la curva de inducción profunda, 

ILM para la curva de inducción media, SFLU para la curva de Resistividad somera, 
CALIds para la curva de calibración del agujero y Temp para la curva de 
temperatura y DegF para sus correspondientes unidades en grados Fahrenheit 

 
 
3. Selecciona la opción Borehole Correct para corrección por efecto del agujero 
 
4. Teclea 1.16 para la resistividad del lodo (Mud Resistivity) y 80°F para dicha 

temperatura, y 1.5 para la opción Standoff 
 

 
5. Selecciona Regular para la opción Induction Tool Type (tipo de herramienta) Y 

selecciona SFL para la opción Shallow Resistivity Tool Type (Tipo de herramienta para 
medir la resistividad somera) 

 
6. El intervalo de profundidad del pozo será para la cima un valor de 9570 y para la 

profundidad de fondo de 10685 
 

 
7. Da un clic en el botón Run Tab y entonces da un clic en Plot Results para ver las 

curvas ILDC,ILMC Y SFLC 
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V.12.5.-CORRECCIONES PARA EL REGISTRO DIL INVASION 
 

 
Fig. V.28 Correcciones para el registro DIL Invasión 
 
PROCEDIMIENTO: 

1. Da un clic en la pestaña del registro DIL INVASION (registro de doble Inducción) 
de la ventana principal de Correcciones Ambientales 

2. Para las curvas de entrada selecciona ILDC para la curva de inducción profunda, 
ILMC para la curva de inducción media, SFLUC para la curva de Resistividad 
somera 

3. Para las curvas resultantes selecciona Rt Para la curva de Resistividad verdadera, 
Di para la curva de diámetro de Invasión 

4. Selecciona ILD-ILM-LL87SFL Rxo/Rm = 20 para la opción Tool Combinations 
(combinación de herramientas) 

5. Da un clic en la opción Save y guarda el archivo con el siguiente nombre: 
Schlum.env 

6. El intervalo de profundidad del pozo será para la cima un valor de 9570 y para la 
profundidad de fondo de 10685 
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7. Da un clic en el botón Run Tab y entonces da un clic en Plot Results para ver las 
curvas Rt,Di 

 
V.13.-DETERMINACIÓN DEL VOLÚMEN DE ARCILLA 
 
El módulo Clay Volume Interpretation se usa para calcular el volumen de arcilla 
interactivamente de los múltiples indicadores de arcilla como las curvas de Rayos 
Gamma, Densidad, Neutrón y SP (Potencial Natural). 
 
La ventana de análisis de volumen de arcilla prepara las curvas de entrada que son 
indicadoras de volumen de arcilla, así como las curvas resultantes. El usuario puede 
cambiar el nombre de la curva de entrada si los valores pre-definidos y seleccionados no 
se corrigen, y cualquier nombre puede usarse para la curva  de volumen de arcilla 
resultante. Se puede especificar un simple o doble indicador de arcilla dentro del módulo 
de volumen de arcilla. 
 
La opción  Bad Hole Indicators le permite al usuario diferenciar donde los indicadores 
dobles del crossplot serán usados. Esto es una buena idea para verificar cualquier 
indicador que posiblemente podría ser utilizado; esto le permitirá al programa inicializar 
los parámetros de arcilla que han sido definidos previamente. 
 

 
Fig. V.29 Figura que muestra el cálculo de Volumen de Arcilla  
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Nota: Antes de empezar con el ejercicio carga el archivo wel1ec.las, este archivo 
contiene las curvas ya editadas, defasamiento en profundidad y los registros corregidos 
por correcciones ambientales. 
 
En esta lección el usuario aprenderá como: 

• Calcular interactivamente el volumen de arcillas desde varias curvas de registros 
en Interactive Petrophysics 

 
PROCEDIMIENTO: 
 

1. Carga el archivo wel1ec.las dentro de la Base de datos 
2. Desde el menú principal de Interactive Petrophysics selecciona Interpretation > Clay 

Volume 
3. La ventana de Análisis de Volumen de Arcilla se abrirá 
4. Para la opción Single Clay Indicators da un clic en el botón izquierdo de la curva de 

Rayos Gamma 
5. Selecciona GrC para la curva de entrada y VCLGR para la curva resultante 
6. Para la opción Double Clay Indicador da un clic en el botón izquierdo de las curvas 

de Densidad/Neutrón 
7. Selecciona RHOC para la curva de entrada de Densidad y NPHIC para la entrada 

de la curva de Neutrón. Deja la curva pre-definida VCLND como curva resultante 
8. Da un clic en la opción RUN 
9. En el segundo track de la izquierda pon el cursor y pulsando el botón derecho del 

mouse a una profundidad aproximadamente de 10178.5 ft 
10. Selecciona Split Zone. La línea de zona puede ser movida verticalmente poniendo 

el cursor sobre la línea de zona en el track, el cursor cambiará a un icono de dos 
flechas(hacia arriba y hacia abajo), sujeta el botón izquierdo del mouse y arrastra 
la línea de zona hacia abajo 

11. Luego, cambia la línea de zona a una profundidad de 10589 y 10684.5 ft, deben 
crearse cuatro zonas. Entonces pulsa el botón derecho del mouse y selecciona 
Delete Zone 

12. Nosotros sólo estamos interesados en las zonas dos y tres, la primera zona podría 
quitarse pero, para este ejercicio, guardaremos todas las zonas. 

13. Si escogemos sólo usar Gamma Ray Clay Indicador y posteriormente pulsamos el 
correcto botón del mouse en el track Density/Neutron para cada zona y 
seleccionamos la opción ND Use Turn Off (para desactivar la opción). Nota que la 
curva VCLND va desapareciendo. La opción Gamma Ray Clay Indicator será la única 
usada en estas zonas 

14. Desde el menú principal selecciona Interpretation > Clay Volume Parameters . Mueve 
la ventana Clay Volume Parameters a la derecha de la pantalla y da un clic en la 
opción Gamma Ray 

15. Retornamos al Log Plot para ajustar las líneas de algunos parámetros en cada zona 
para la opción Gamma Ray Clean y Clay Picks (picos de la arcilla). La línea roja es el 
pico limpio y la línea verde es el pico de la arcilla. Para hacer esto, pon el cursor 
en la línea que va a ser quitada, el cursor cambiará ahora a un icono con dos 
flechas (adelante y hacia atrás). Sujeta el botón izquierdo del mouse y mueve de 
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lado a lado de la línea a la posición deseada, entonces suelta el botón del mouse. 
Nota como se actualiza la ventana de la curva resultante. 

16. Para cada zona, pon los siguientes parámetros: 
• zona 1  28  clean  119  clay 
• zona 2  28  clean  121  clay 
• zona 3  31  clean  121  clay 
17. Cierra la ventana Clay Volume Parameters con la opción close 

 
 
V.14.-DETERMINACIÓN DE LA POROSIDAD Y SATURACIÓN DE AGUA 
 
El módulo Porosity and Water Saturation se usa para calcular la porosidad, la saturación 
de agua, la saturación de agua en la zona lavada, densidad de la matriz, densidad del 
fluido (hidrocarburo) y el volumen de arcilla. No todos los resultados es posible 
obtenerlos al mismo tiempo y éstos dependen del modelo de porosidad escogido y la 
lógica en la selección. 
 

 
Fig. V.30 Curvas de entrada para el cálculo de la porosidad y saturación de agua 
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Fig. V.31 Curvas resultantes para el cálculo de la porosidad y saturación de agua 
 
En esta lección el usuario aprenderá como: 

• Calcular la porosidad utilizando Interactive Petrophysics 
• Calcular la saturación de agua utilizando Interactive Petrophysics 

 
PROCEDIMIENTO: 
 

1. Desde el menú principal de Interactive Petrophysics selecciona Interpretation > 
Porosity and Water Saturation 

2. La ventana de Porosity and Water Saturation se abrirá 
3. Da un clic en la pestaña Input Curves 
4. Selecciona NPHIC para la curva de Neutrón, RHOC para la curva de Densidad, DT 

para la curva del registro Sónico, RT para la curva de Resistividad, VCLGR para la 
curve de volumen de arcilla y Temp para la curva de Temperatura 
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5. Para el modelo pre-definido de porosidad selecciona Neutron Density, Dual Water 
para determinar la saturación de agua mediante el método de Doble Agua y 
checar las unidades de la curva de temperatura en grados Fahrenheit 

6. Da un clic en la pestaña Output Curves 
7. Da un clic en Input Curves y selecciona la opción Multimineral Análisis Defaults 
8. De nuevo, da un clic en Output Curves. Ve las curvas y nota que se han definido 

con el cambio de análisis mineralógico 
9. De nuevo da un clic en Input Curves y desactiva la opción Multimineral Análisis 

Defaults 
10. Da un clic en RUN y si tu respuesta es sí, entonces IP copiará parámetros en zonas 

de la arcilla e iniciará la opción Parameter Plot 
11. En la zona 1 haz las siguientes aproximaciones ajustando las líneas de los 

parámetros deseados en cada uno de los tracks 
• New Wet Clay = 0.38 
• Sonic Wet Clay = 98 
• Rho Wet Clay = 2.51 
• Res Clay = 0.7 
• Rw = 0.17 
• Rw Bound = 0.167 
• Rho Gd = 2.65 
• Rho GD Max = 2.95 
• HC Den = 0.805 
 
12.  En la zona 2 haz las siguientes aproximaciones ajustando las líneas de los 

parámetros deseados en cada uno de los tracks 
 
• New Wet Clay = 0.35 
• Sonic Wet Clay = 93 
• Rho Wet Clay = 2.53 
• Res Clay = 0.72 
• Rw = 0.17 
• Rw Bound = 0.22 
• Rho Gd Min = 2.51 
• Rho Gd = 2.65 
• Rho GD Max = 2.86 
• HC Den Min = 0.15 
• HC Den = 0.27 

 
13.  En la zona 3 haz las siguientes aproximaciones ajustando las líneas de los 

parámetros deseados en cada uno de los tracks 
 
• New Wet Clay = 0.34 
• Sonic Wet Clay = 101 
• Rho Wet Clay = 2.51 
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• Res Clay = 0.765 
• Rw = 0.17 
• Rw Bound = 0.23 
• Rho Gd Min = 2.51 
• Rho Gd = 2.65 
• Rho GD Max = 2.95 
• HC Den Min = 0.15 
• HC Den = 0.23 

 
14. Cierra el Log Plot con la opción Close 
15. Para salvar los datos en la Base de Datos selecciona File > Save Current Well to 

Database 
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CAPÍTULO VI APLICACIÓN Y ANÁLISIS DE RESULTADOS 
 
 
VI .1.-EJEMPLO DE APLICACIÓN 

 
En este ejemplo práctico de aplicación se realizará una evaluación petrofísica para 
determinar las porosidades en diferentes intervalos de un pozo. El pozo cuenta con los 
siguientes registros: de calibración del pozo y de rayos gamma que se observan en el 
track 1, en el segundo track están los registros de resistividad somera, profunda y 
microesférica y, finalmente, en el tercer track se encuentran los registros de porosidad 
(neutrón, densidad y tiempo de tránsito). La profundidad total del pozo es de 2489 
metros, los intervalos de interés son 5 y ellos se van a describir por separado a qué 
profundidad se encuentran, la profundidad del intervalo de interés (es decir se tomaron 
núcleos en cada uno de estos y se tienen valores de porosidad obtenidas en laboratorio). 
 

 Fig. VI.1 Figura que muestra los registros geofísicos de pozos para el caso en estudio       
 
 
 

Haciendo correcciones ambientales a cada uno de los registros utilizando el Capítulo V 
con los subtemas V.12.1, V.12.2, V.12.3, V.12.4, V.12.5 y V.12.6  se muestra a 
continuación los registros corregidos por efectos ambientales. (ver Fig. VI.2) 
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Fig. VI.2 Registros corregidos por efectos ambientales 

 
VI .1.1.- PRIMER INTERVALO DE INTERÉS 
 
 

1) Para el primer intervalo de interés se encuentra a una profundidad que 
va de 2074.6m a 2076.1m. Se escogió dicho intervalo por contener datos 
de núcleos. Comenzando con una combinación de curvas de porosidad 
para determinar la litología y por supuesto la porosidad. 

 
Primer intervalo de interés: 
 

 
Fig. VI.3 Figura que muestra el primer intervalo de interés 
 

Para comenzar la interpretación se hará uso del Capítulo V y con base en los subtemas 
V.7 (Módulo de ingreso de fórmulas) y V.8 Crossplots (Gráficas cruzadas) del manual de 
Interactive Petrophysics se parte para llevar a cabo una combinación de gráficas de 
curvas de porosidad para estimar un valor promedio de porosidad en los intervalos de 
interés y posteriormente comparar los valores obtenidos con las ecuaciones de los 
registros sónico y densidad con los de laboratorio.  
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Gráfica φN Vs φρ 
 

 
Fig. VI.4 Gráfica Neutrón-Densidad para el primer intervalo de interés en tres dimensiones 

 
Se trata de una formación sucia ya que comparando la pequeña nube de puntos con el 
volumen de arcilla calculado previamente con la curva de Rayos Gamma se tiene un 
porcentaje de % arcilla que es mayor al 15% tratándose por lo tanto de una formación 
arcillosa como se muestra a continuación (Fig. VI.5): 

 

 
Fig. VI.5 Volumen de arcilla para el primer intervalo de interés 
 
Por la separación de los puntos no se puede dar un valor de porosidad exacto sino que se 
encuentra entre un rango entre 20 y 35% de porosidad de dolomita como veremos en la 
siguiente gráfica (Fig. VI.6): 
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Fig. VI.6 Gráfica Neutrón-Densidad en dos dimensiones (misma escala que en tres dimensiones) 

 

 
Fig. VI.7 Gráfica para obtener un valor promedio de porosidad 
 
En la figura VI.7 se seleccionó un área entre la nube de puntos para tener un mejor valor 
de la porosidad. Si tomamos el punto medio nos da una porosidad de alrededor de 28%. 
Dicha tendencia (línea de color azul) da una ecuación cuya dispersión se muestra a 
continuación. 
 
RHOC = 3.037691999  - 1.879013939 * NPHIC……………………………………….6.1 
   R2 =   0.853450 
 
Si de la ecuación 6.1 despejamos la porosidad y tomamos un punto central de la 
tendencia y leemos un valor de densidad de 2.4  (figura VI.7)  y resolviendo la ecuación  
da una porosidad de 0.33 en fracción ó del 33%. 
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Gráfica φN Vs ∆t 
 

 
Fig. VI.8 Gráfica Neutrón- Sónico 
 

Esta gráfica (Fig. VI.8) ahora de φN vs. ∆t muestra una similtud a la gráfica φN Vs φρ en 
cuanto a la tendencia de los puntos, sin embargo ahora se aprecia una combinación en las 
litologías; estas ahora caen entre las dos líneas de caliza-dolomita acercándose un poco 
más a lo que sería un 60% de caliza mientras que el resto (40%) correspondería a 
dolomita. Ahora comparando la gráfica (Fig. VI.9) con la gráfica (Fig. VI.5) siguen una 
misma tendencia en cuanto al porcentaje de volumen de arcilla es mayor al 15% por lo 
que se trata de una formación sucia que ahora comparando litologías muestra que es una 
combinación de caliza-dolomita. 
 

 
Fig. VI.9 Volumen de arcilla para la gráfica Neutrón- Sónico 
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En cuanto al rango de porosidades se encuentra ahora de 22-38% de porosidad, tal vez 
sea porque cada uno de estos registros de porosidad responden de manera diferente y el 
registro sónico sólo tiende a responder únicamente a la porosidad primaria de distribución 
uniforme. (ver figura VI.10  ) 
 

 
Fig. VI.10 Gráfica Neutrón-Sónico en dos dimensiones 

 

 
Fig. VI.11 Gráfica para obtener un valor promedio de porosidad 
 
En forma similar se trazó una tendencia a la pequeña nube de puntos para obtener un 
valor de porosidad promedio el cuál si se toma un punto medio de dicha tendencia y 
resolviendo la ecuación 6.2 da un valor de porosidad de aproximadamente 32%. La 
ecuación de dicha tendencia y su dispersión la podemos ver a continuación: 
 
DT1 = 40.474454312  + 157.673120819 * NPHIC……………………………………..6.2 
   R2 =   0.983217 
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Gráfica φρ Vs ∆t 
 

 
Fig. VI.12 Gráfica Densidad-Sónico en tres dimensiones 
 
Como se vuelve a observar la tendencia de los puntos para el intervalo de interés sigue 
siendo una roca carbonatada. (Fig. VI.12) 
 
 

 
Fig. VI.13 Volumen de arcilla para la gráfica Densidad-Sónico 
 
Ahora bien, si nos detenemos un poco y observamos en la barra derecha de la figura VI.13  
que indica el volumen de arcilla en el intervalo muestreado se observa que la mayoría de 
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los puntos están por arriba del 15% en volumen de arcilla por lo que se tiene una 
formación arcillosa.  
 

 
Fig. VI.14 Gráfica Densidad-Sónico en dos dimensiones 
 
Para obtener un valor de porosidad vamos a recurrir a la figura VI.14 y ahora el rango de 
valores es un poco más amplio por lo que la porosidad se tiene entre 16-40%. 
 

 
Fig. VI.15 Gráfica para obtener un valor promedio de porosidad 
 
De la misma forma que la gráfica densidad-neutrón se ajustó una tendencia a la nube de 
puntos de la gráfica φρ vs. ∆t para estimar un valor de porosidad. Si se toma el punto 
medio y resolviendo la ecuación 6.3 da una porosidad de alrededor de 34%. Dicha 
tendencia (línea de color azul) nos da una ecuación cuya dispersión se muestra a 
continuación: 
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RHOC = 3.357692458  - 0.010053033 * DT1………………………………………….6.3 
   R2 =   0.869369 
 
Esta interpretación es de una manera cualitativa. Análogamente vamos a determinar la 
porosidad de manera cuantitativa utilizando por separado las diferentes ecuaciones de los 
distintos registros de porosidad de manera individual. 
 
 La ecuación que nos determina la porosidad mediante el registro sónico se muestra a 
continuación: 
 
φ = (∆t – ∆tm)/( ∆tf - ∆tm)………………………………………………………………..6.4 
 
Como no se cuenta con información de tipo de lodo vamos a realizar los cálculos de las 
porosidades para lodo dulce  Los valores que se tienen para el tiempo de tránsito del 
fluido y de la matríz para lodo dulce son 189.0  y 47.5 respectivamente. 
  
Haciendo uso del subtema V.7 (Módulo de Ingreso de Fórmulas) debemos ingresar al 
software Interactive Petrophysics las ecuaciones 6.4 y 6.5 en el intervalo de interés, 
obteniendo así una curva continua de porosidad en dicho intervalo. 
 
Con la ecuación 6.4 del registro sónico y tomando un valor promedio se tiene que  φ = 
0.366 → 36.6% 
 
Si comparamos el valor obtenido anteriormente, con la porosidad obtenida de núcleos 
que es de 33.9%, se tiene una muy buena aproximación. 
 
Ahora con el registro de densidad. La ecuación que determina la porosidad se muestra a 
continuación: 
 
φ = (ρm – ρ)/( ρm – ρf)…………………………………………………………………...6.5 
 
Ahora el valor de porosidad obtenido con la ecuación 6.5 para el intervalo de interés es 
de φ = 0.326 → 32.6% 
 
Ahora se prepara una gráfica donde se colocan las porosidades obtenidas de laboratorio 
(de núcleos) y las porosidades obtenidas con las ecuaciones 6.4 y 6.5 como se muestra en 
la siguiente gráfica (Fig. VI.16) 
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Fig. VI.16 Valores de porosidades obtenidas de diversas metodologías  
 
Los puntos negros de la figura VI.16 indican las porosidades obtenidas de núcleos, 
mientras que los puntos de color azul y rojo nos indican las porosidades obtenidas con las 
ecuaciones de los registros sónico y densidad. 
 

Porosidades obtenidas de la combinación de 
gráficas de porosidad 

Porosidades obtenidas cuantitativamente de las 
ecuaciones de los registros sónico y densidad 

φN vs φρ 
 
 
φ = 33% 

φN vs ∆t 
 
 
φ = 32% 

φρ vs ∆t 
 
 
φ = 34% 

registro sónico 
 
 
φ = 36.6% 
 
 
 
 

registro densidad 
 
 
φ = 32.6% 

   Tabla 6.1 Valores de porosidad para el primer intervalo 
 
Como se puede observar en la Fig. VI.16 los valores de porosidad obtenidos de las 
ecuaciones 6.4 y 6.5 correspondientes a los registros sónico y densidad son muy 

 Primer Intervalo de Interés 
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próximos a dichos registros, es decir, siguen la tendencia al contorno de cada una de las 
curvas y comparando con las porosidades de núcleos los valores son muy confiables. 
 
VI .1.2.- SEGUNDO INTERVALO DE INTERÉS 
 

2) Para el segundo intervalo de interés que va de una profundidad de 
2214.4 a 2215.1 metros como lo muestra la siguiente figura (Fig. VI.17) : 

 

 
Fig. VI.17 Segundo intervalo de interés 
Siguiendo con la misma metología como en el primer caso (primer intervalo de interés)  

 
Gráfica φN Vs φρ 
 

 
Fig. VI.18 Gráfica Neutrón-Densidad para el segundo intervalo de interés en tres dimensiones 
 
Para estimar un valor de porosidad con la gráfica de la figura VI.18, la nube de puntos cae 
en la línea de igual porosidad y densidad para una dolomita; pero como se observa el 
rango de porosidades es demasiado extenso y para fijar un mejor valor de dicho 
parámetro seleccionamos un área entre la nube de puntos. 
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Fig. VI.19 Gráfica Neutrón-Densidad en dos dimensiones (misma escala que en tres dimensiones) 
 
 
Si observamos detenidamente la figura VI.19  ahora el rango de valores para la porosidad 
varía entre17-30%, si tomamos un punto medio de la tendencia leemos un valor de 
porosidad de aproximadamente 24%. De la tendencia trazada de la figura VI.19   tenemos 
la siguiente ecuación: 
 
RHOC = 2.943414683  - 1.932933022 * NPHIC……………………………………….6.6 
   R2 =   0.918548 
 
De la figura VI.19     y en el mismo punto intermedio podemos leer un valor de densidad 
de 2.245 y despejando la porosidad de la ecuación 6.6 tenemos que : 
 
φ = 0.2682 → 26.82% 
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Gráfica φN Vs ∆t 
 

 
Fig. VI.20 Gráfica Neutrón-Sónico en tres dimensiones 
 
Ahora bien analizando la gráfica de la figura VI.20,  ahora la pequeña nube de puntos  
indica que la litología cae entre las líneas de caliza así como de dolomita y para hacer un 
estimado del valor de porosidad vamos a llevar a cabo una selección de área entre los 
puntos (ver Fig. VI.21). 
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Fig. VI.21 Gráfica para obtener un valor promedio de porosidad al ajustar los puntos a una tendencia 

 
 
Si analizamos detalladamente la figura VI.21  y tomamos un punto intermedio de la 
tendencia de los puntos podemos leer un valor de porosidad de aproximadamente 26%. 
Pero en forma similar al primer intervalo podemos obtener la ecuación de la recta y su 
dispersión: 
 
DT1 = 39.660293575  + 164.818925475 * NPHIC…………………………………….6.7 
   R2 =   0.919379 
 
De la figura VI.21 y tomando el punto intermedio de la tendencia leemos un valor de 
tiempo de tránsito de 83 y despejando la porosidad de la ecuación 6.7 se tiene: 
 
φ = 0.2629  → 26.29% 
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Gráfica φρ Vs ∆t 
 

 
Fig. VI.22 Gráfica Densidad-Sónico en tres dimensiones 

 
En este crossplot se observa que de la nube de puntos podría tener dos opciones; que se 
trate de una dolomita arcillosa ó una arenisca sucia por la tendencia de los puntos que se 
ven un poco desplazados hacia abajo. De forma similar al primer intervalo para estimar el 
valor de porosidad vamos a seleccionar un área y tomar un punto medio. 
 

 
Fig. VI.23 Gráfica para obtener un valor promedio de porosidad 
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Tomando como referencia un punto intermedio leemos directamente el valor de la 
porosidad igual a 26%. Ahora bien si consideramos que este valor no podría ser muy 
confiable obtenemos la ecuación de la recta y su dispersión como se muestra a 
continuación: 
 
RHOC = 3.408535366  - 0.011727616 * DT1………………………………………….6.8 
   R2 =   0.714825 
Si tomamos el punto intermedio y leemos de la figura VI.22 un valor de tiempo de tránsito 
igual a 82  y resolviendo la ecuación 6.8 se tiene: 
φ = 24.48 % 
Similarmente al primer intervalo se prepara la figura VI.24 donde se colocan las 
porosidades obtenidas de las ecuaciones 6.4 y 6.5 así como las porosidades de laboratorio 
(núcleos).  

 
Fig. VI.24 Gráfica que muestra los valores de porosidad a través de diferentes métodos 

 

    Segundo Intervalo de Interés 
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 Los puntos de color rojo corresponden a las porosidades del registro sónico, mientras 
que los puntos color azul corresponden a los valores de porosidad del registro de 
densidad y los puntos en color negro indican las porosidades obtenidas de núcleos. 
 
Si obtenemos un valor medio de dichos valores: 
 
φ ∆t = 0.281 → 28.1% 
φ ρ  =  0.292 → 29.2% 
 
Como se observa en las figura VI.24 los valores de porosidad obtenidos de las ecuaciones 
6.4 y 6.5 son muy precisos, ya que siguen las mismas tendencias de los registros de 
porosidad. Por lo tanto se puede aseverar que tenemos valores de este parámetro muy 
confiables. 
 

Porosidades obtenidas de la combinación de 
gráficas de porosidad 

Porosidades obtenidas cuantitativamente de las 
ecuaciones de los registros sónico y densidad 

φN vs φρ 
 
 
φ = 24% 

φN vs ∆t 
 
 
φ = 26% 

φρ vs ∆t 
 
 
φ = 26% 

registro sónico 
 
 
φ = 25% 

registro densidad 
 
 
φ = 23% 

   Tabla 6.2 Valores de porosidad para el segundo intervalo 
 
VI .1.3.- TERCER INTERVALO DE INTERÉS 
 
 

3) Tercer intervalo de interés. Se encuentra a una profundidad que va de 
2229.9 a 2231.9 metros como se muestra en la siguiente figura: 

 

 
Fig. VI.25 Tercer intervalo de estudio 

 
 
Siguiendo con la misma metodología que en los casos anteriores para encontrar los 
valores de porosidad. 
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Gráfica de φN Vs φρ 

 

 
Fig. VI.26 Gráfica Neutrón-Densidad para el tercer intervalo de interés en tres dimensiones 

Como podemos observar en la gráfica de la figura VI.26  la nube de puntos cae en la 
litología de una dolomita, para poder obtener un valor más apropiado de porosidad vamos 
a trazar una tendencia como lo hemos hecho anteriormente (ver fig VI.27) 

 
Fig. VI.27 Gráfica para obtener un valor promedio de porosidad 
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Se traza una tendencia a los puntos y se toma un valor central para leer directamente de 
esta gráfica (Fig. VI.27) un valor de porosidad de 13% 
 

Gráfica φN Vs ∆t 
 

 
Fig. VI.28 Gráfica Neutrón-Sónico en tres dimensiones 

 
Fig. VI.29 Gráfica para obtener un valor promedio de porosidad 

Para este caso se sigue una secuencia similar a los casos descritos anteriormente como lo 
muestran las figuras VI.28  y VI.29 en el caso de la gráfica de interrelación φN Vs ∆t y, por 
lo tanto,  se obtiene un valor de porosidad de 14%. 
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Gráfica φρ Vs ∆t  
 

 
Fig. VI.30 Gráfica Densidad-Sónico en tres dimensiones 

 

 
Fig. VI.31 Gráfica para obtener un valor promedio de porosidad 

 
Siguiendo el mismo procedimiento, para este caso se tiene un valor de porosidad de 
14%. 
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De forma similar a los primeros dos intervalos de interés se prepara la gráfica de la figura 
VI.32 donde son colocadas las porosidades obtenidas con las ecuaciones 6.4 y 6.5 así 
como las porosidades obtenidas de núcleos. 
La figura VI.32 indica las porosidades obtenidas mediante las ecuaciones de los registros 
sónico y densidad en color rojo y azul respectivamente; mientras que los puntos en color 
negro son porosidades obtenidas de laboratorio. 
 

 
 
 

 
Fig. VI.32 Gráfica que muestra los valores de porosidad obtenidos por diferentes métodos 
 
En este tercer intervalo de interés también tenemos a una formación arcillosa de acuerdo 
con el volúmen de arcillas obtenido del registro de rayos gamma que rebasa el 15% por lo 
que se tomará en cuenta este valor para hacer correcciones de porosidad debidas a la 
arcillosidad  en todos los intervalos de interés. Igualmente llegamos a las mismas 

 Tercer Intervalo de Interés 
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observaciones del primer y segundo intervalo de estudio ya que los valores de porosidad 
obtenidos con las ecuaciones 6.4 y 6.5 siguen prácticamente las mismas tendencias de los 
registros de porosidad y también son muy cercanos a los valores de porosidad obtenidos 
de laboratorio. 
 
 

Porosidades obtenidas de la combinación de 
gráficas de porosidad 

Porosidades obtenidas cuantitativamente de las 
ecuaciones de los registros sónico y densidad 

φN Vs φρ 
 
 
φ = 13% 

φN Vs ∆t 
 
 
φ = 14% 

φρ Vs ∆t 
 
 
φ = 14% 

registro sónico 
 
 
φ = 12% 

registro densidad 
 
 
φ = 11.5% 

   Tabla 6.3 Valores de porosidad para el tercer intervalo 
 
VI .1.4.- CUARTO INTERVALO DE INTERÉS 
 
 

4) Cuarto intervalo de interés. Para este caso se encuentra a una 
profundidad que va de 2239.1 a 2240.6 metros como se muestra a 
continuación. 

 

 
Fig. VI.33 Esquema que muestra el cuarto caso de estudio 
 
 
Siguiendo con la metodología de los casos previos. 
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 Gráfica φN Vs φρ 
 

 
Fig. VI.34 Gráfica Neutrón-Densidad en tres dimensiones 
 
Como se puede observar en las gráficas de las figuras VI.34  y VI.35 la nube de puntos cae 
en la litología de dolomita y para determinar un valor más exacto de la porosidad 
trazamos una tendencia hacia los puntos y tomamos un punto medio. El valor de 
porosidad obtenido es de 13.5%.(ver figura VI.35) 
 

 
Fig. VI.35 Gráfica para obtener un valor promedio de porosidad 
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Gráfica φN Vs ∆t 
 

 
Fig. VI.36 Gráfica Neutrón-Sónico en tres dimensiones 
 
Ahora para este caso la nube de puntos cae entre las líneas de caliza y dolomita tendiendo 
más a una caliza. Similarmente para obtener un valor de la porosidad trazamos una 
tendencia hacia los puntos obteniendo un valor de porosidad de 13%.(ver figura VI.37) 
 
 
 
 

 
Fig. VI.37 Gráfica para obtener un valor promedio de porosidad al ajustar una tendencia 
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 Gráfica φρ Vs ∆t 
 

 
Fig. VI.38 Gráfica Densidad-Sónico en tres dimensiones 

 
En esta ocasión los puntos tienden hacia una litología de tipo dolomita como en el primer 
caso, por lo tanto se sigue el mismo procedimiento para la obtención de un valor de 
porosidad el cuál es de aproximadamente 14%.(ver figura VI.39) 
 
 
 
 

 
Fig. VI.39 Gráfica para obtener un valor promedio de porosidad 
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De forma similar a los casos previos se prepara la gráfica de la figura VI.40 donde de 
nuevo se colocan las porosidades obtenidas con las ecuaciones 6.4 y 6.5 así como las 
porosidades de núcleos. 
 

 
Fig. VI.40 Gráfica que muestra los valores de porosidad a partir de diferentes métodos 
 
En este caso como en los anteriores podemos observar las porosidades obtenidas de 
núcleos (puntos en color negro) y de los registros sónico y densidad (puntos en color rojo 
y azul) mostrados en la figura VI.40. 
 
Analizando los valores de porosidad obtenidos con las ecuaciones 6.4 y 6.5 así como los 
valores de porosidad de núcleos se tiene un comportamiento como se esperaba (siguen las 
tendencias aproximadas a los registros sónico, neutrón y densidad). 
 
 
 
 
 
 

  Cuarto Intervalo de Interés 
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Porosidades obtenidas de la combinación de 
gráficas de porosidad 

Porosidades obtenidas cuantitativamente de las 
ecuaciones de los registros sónico y densidad 

φN Vs φρ 
 
 
φ = 13.5% 

φN Vs ∆t 
 
 
φ = 13% 

φρ Vs ∆t 
 
 
φ = 14% 

registro sónico 
 
 
φ = 13.1% 

registro densidad 
 
 
φ = 15.6% 

   Tabla 6.4 Valores de porosidad para el cuarto intervalo 
 
 
VI .1.5.- QUINTO INTERVALO DE INTERÉS 
 
 

5) Quinto intervalo de interés, se localiza a una profundidad que va de 
2241.8 a 2242.6 metros como se muestra en la siguiente figura: 

 

 
Fig. VI.41 Esquema que representa el quinto y último caso de estudio 
 
Siguiendo el mismo procedimiento de los casos previos para la interpretación en el quinto 
intervalo 
 
Gráfico φN Vs φρ 

 

 
Fig. VI.42 Gráfica Neutrón-Densidad en tres dimensiones 
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Fig. VI.43 Gráfica para obtener un valor promedio de porosidad al ajustar una tendencia  
 
 
Gráfico φN Vs ∆t 
 

 
Fig. VI.44 Gráfica Neutrón-Sónico en tres dimensiones 
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Fig. VI.45 Gráfica para obtener un valor promedio de porosidad al ajustar una tendencia  
 
 
 
 
Gráfico φρ Vs ∆t 
 

 
Fig. VI.46 Gráfica Densidad-Sónico en tres dimensiones 
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Fig. VI.47 Gráfica para obtener un valor promedio de porosidad al ajustar una tendencia 

 
En cada uno de los crossplots de combinación de registros de porosidad como: Gráfico φN 
Vs φρ, φN Vs ∆t y  φρ Vs ∆t. Se tiene una tendencia muy similar en la nube de puntos 
cayendo en una litolgía de dolomita y siguiendo el mismo procedimiento como en los 
otros casos para determinar las porosidades se obtuvieron valores mostrados en la tabla 
6.5. 

 
Porosidades obtenidas de la combinación de 
gráficas de porosidad 

Porosidades obtenidas cuantitativamente de las 
ecuaciones de los registros sónico y densidad 

φN Vs φρ 
 
 
φ = 17% 

φN Vs ∆t 
 
 
φ = 17% 

φρ Vs ∆t 
 
 
φ = 18% 

registro sónico 
 
 
φ = 14.2% 
 
 
 
 

registro densidad 
 
 
φ = 16.5% 

   Tabla 6.5 Valores de porosidad para el quinto intervalo 
 
 
De forma similar que los casos previos se prepara la gráfica de la figura VI.48 donde 
nuevamente se colocan las porosidades obtenidas con las ecuaciones 6.4 y 6.5 así como 
los valores de porosidad obtenidos de núcleos. 
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Fig. VI.48 Gráfica que muestra los valores de porosidad para el quinto intervalo 
 
Y finalmente en la figura VI.48  se muestran los valores de las porosidades obtenidas de 
núcleos: puntos negros) así como los valores de las porosidades obtenidos con los 
registros sónico y densidad (puntos en color rojo y azul). Observando los puntos descritos 
anteriormente no cabe duda que son resultados muy buenos ya que siguen el mismo 
comportamiento de las curvas de los registros de porosidad y son muy cercanos a los 
valores de laboratorio.  
 
Para concluir se tendrán que realizar correcciones a los valores obtenidos de porosidad 
debido a que en los cinco intervalos de interés las formaciones resultaron ser arcillosas ya 
que el volumen de arcilla en dichos intervalos resultó mayor al 15%, por lo que se 
consideran formaciones sucias. 
 

  Quinto Intervalo de Interés 
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Las correcciones de los valores de porosidad se efectuarán tanto al registro sónico como 
al registro de densidad. Se pueden obtener los valores correctos de porosidad (corregidos) 
mediante gráficos o ecuaciones.  
 
Las ecuaciones son las siguientes: 
 
- del registro de densidad :   φ = (ρma - ρsh / ρma - ρf ) - Vsh (ρma - ρsh / ρma - ρf ).............6.9 
- del registro sónico : :   φ = (∆t - ∆ma / ∆tf - ∆ma) - Vsh (∆sh - ∆ma / ∆tf - ∆ma)..................6.10 
 
En todos los casos de estudio se obtuvo que la litología es una dolomita, por lo que la 
densidad de la matriz y el tiempo de tránsito son 2.87 g/cc y 43.5 µs/ft respectivamente, 
así como los valores de densidad y tiempo de tránsito del fluido son 1.0 g/cc y 189 µs/ft 
 
Para el primer intervalo de interés se obtuvieron los siguientes parámetros leídos 
directamente de los registros y resultados de interpretación: 
 

Densidad de la lutita (ρsh) = 2.22 g/cc 
Volumen de arcilla (Vsh) = 17% 
Tiempo de tránsito del intervalo (∆t) = 100 µs/ft 
Tiempo de tránsito de la lutita (∆sh) = 118 µs/ft 

Ahora bien, sustituyendo los valores anteriores en las ecuaciones 6.9 y 6.10 tenemos los 
siguientes valores de porosidad ya corregidos por arcillosidad 

φ = 30.13% del registro sónico 

φ = 25.29 del registro de densidad 

 
Para el segundo intervalo de interés se obtuvieron los siguientes valores: 

Densidad de la lutita (ρsh) = 2.30 g/cc 
Volumen de arcilla (Vsh) = 18% 
Tiempo de tránsito del intervalo (∆t) = 90 µs/ft 
Tiempo de tránsito de la lutita (∆sh) = 100 µs/ft 

Ahora bien, sustituyendo los valores anteriores en las ecuaciones 6.9 y 6.10 tenemos los 
siguientes valores de porosidad ya corregidos por arcillosidad 

φ = 25.74% del registro sónico 

φ = 25.60% del registro de densidad 
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Para el tercer intervalo de interés se obtuvieron los siguientes valores: 

Densidad de la lutita (ρsh) = 2.60 g/cc 
Volumen de arcilla (Vsh) = 16% 
Tiempo de tránsito del intervalo (∆t) = 70 µs/ft 
Tiempo de tránsito de la lutita (∆sh) = 109 µs/ft 

Ahora bien, sustituyendo los valores anteriores en las ecuaciones 6.9 y 6.10 tenemos los 
siguientes valores de porosidad ya corregidos por arcillosidad 

φ = 11.00% del registro sónico 

φ = 12.11% del registro de densidad 

 

Para el cuarto intervalo de interés se obtuvieron los siguientes valores: 

Densidad de la lutita (ρsh) = 2.55 g/cc 
Volumen de arcilla (Vsh) = 17% 
Tiempo de tránsito del intervalo (∆t) = 68 µs/ft 
Tiempo de tránsito de la lutita (∆sh) = 85 µs/ft 

Ahora bien, sustituyendo los valores anteriores en las ecuaciones 6.9 y 6.10 tenemos los 
siguientes valores de porosidad ya corregidos por arcillosidad 

φ = 11.98% del registro sónico 

φ = 14.20% del registro de densidad 

 

Para el quinto y último intervalo de interés se obtuvieron los siguientes valores: 

Densidad de la lutita (ρsh) = 2.52 g/cc 
Volumen de arcilla (Vsh) = 17% 
Tiempo de tránsito del intervalo (∆t) = 71 µs/ft 
Tiempo de tránsito de la lutita (∆sh) = 90 µs/ft 

Ahora bien, sustituyendo los valores anteriores en las ecuaciones 6.9 y 6.10 tenemos los 
siguientes valores de porosidad ya corregidos por arcillosidad 

φ = 13.46% del registro sónico 

φ = 15.53% del registro de densidad 
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Intervalo 

 
Porosidad 
Gráfica 
 
φN vs φρ 

 

Porosidad 
Gráfica 

φN vs ∆t 

Porosidad 
Gráfica 

φρ vs ∆t 

φ a 
partir de 
la ec. 
6.4 

φ a 
partir de 
la ec. 
6.5 

φ a partir de 
la ec. 6.4 
corregida por 
arcillosidad 

φ a partir de 
la ec.6.5 
corregida por 
arcillosidad 

1 33 32 34 36.6 32.6 30.13 25.29 

2 24 26 26 25 23 25.74 25.6 

3 13 14 14 12 11.5 11.0 12.11 

4 13.5 13 14 13.1 15.6 11.98 14.20 

5 17 17 18 14.2 16.5 13.46 15.53 

  Tabla 6.6 Valores de porosidad para todos los intervalos de estudio 

VI .2.- ANÁLISIS DE RESULTADOS 

Observando la tabla 6.6 podemos concluir que las columnas con los valores de porosidad 
obtenidos a través de la combinación de gráficas de registros de porosidad (columnas 2, 3 
y 4) en cada uno de los intervalos los resultados prácticamente son muy similares ya que 
como se observó al obtener dichas gráficas cruzadas en los subtemas del capítulo VI los 
puntos casi en cada una de estas gráficas de interrelación caían en una matríz de dolomita 
aunque hubo casos en los cuales parecía que eran una combinación de más de un material 
y su comportamiento en cada uno de los intervalos fue muy similar, cambiando dichos 
valores de porosidad con respecto a la profundidad. 

Con respecto a las columnas 5 y 6 los valores de porosidad obtenidos a partir de las 
ecuaciones de los registros sónico y densidad cambian un poco ya que no debemos de 
olvidar que las gráficas cruzadas de porosidad nos dan valores cualitativos, en cambio al 
estar utilizando las ecuaciones 6.4 y 6.5 lo estamos haciendo de una manera cuantitativa, 
estamos considerando mas parámetros de investigación en cada uno de los intervalos de 
interés y por lo tanto, los valores obtenidos a través de estas ecuaciones se consideran 
mas apegados a la realidad. 

Finalmente, las columnas 7 y 8 como era de esperarse los valores de porosidad 
disminuyen un poco comparándolos con los de las columnas 5 y 6 ya que se está tomando 
en cuenta que en los cinco intervalos de interpretación se llegó a la conclusión de que se 
trataba de formaciones arcillosas por el valor del volumen de arcilla obtenido a través de 
la curva de rayos gamma y en las ecuaciones 6.9 y 6.10 se está eliminando esta 
consideración a los valores de porosidad.  
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CONCLUSIONES 
 
 

- Los registros geofísicos de pozos constituyen una de las informaciones básicas 
obtenidas durante la perforación de un pozo petrolero, ya que permiten determinar 
propiedades geológicas y petrofísicas tales como litología, porosidad, 
permeabilidad, saturación de fluidos y por consiguiente su capacidad de 
producción de hidrocarburos así como su calidad de rocas almacén y sello. 

 
 
- Los registros de pozos son considerados elementos indispensables en la 

interpretación geológica-económica de áreas exploratorias, desarrollo de campos, 
caracterización de yacimientos y evaluación de reservas. 

 
 
- Las interpretaciones petrofísicas obtenidas de registros de pozos siempre deberán 

ser apoyadas con datos de muestras de canal, núcleos, análisis geológicos; es 
decir, de muestras de roca, así se tendrá una mayor confiabilidad de la 
información. 

 
- Antes de realizar una evaluación petrofísica se tendrá que preparar la información 

disponible, es decir se harán correcciones ambientales, ya que la información fue 
tomada en un medio alterado donde todas sus características originales sufrieron 
un cambio debido a procesos de perforación del pozo y las mediciones obtenidas 
con las sondas de los registros deben ser corregidas por tales efectos y así obtener 
resultados más precisos. 

 
 
- Todos los registros, separados de acuerdo a su clasificación (litología, porosidad y 

resistividad) deberán estar presentados en escalas congruentes antes de empezar 
con un proceso de interpretación. 

 
- Entre más procedimientos, modelos, etc., estén disponibles para el cálculo de 

algún parámetro petrofísico, mejor será la evaluación de dicho parámetro ya que 
se tomará en cuenta las consideraciones y requerimientos que hace el autor de 
dicho modelo propuesto y así nosotros como ingenieros petrofísicos podríamos 
definir una mejor conclusión en el análisis de resultados. 

 
 
- De acuerdo con la cantidad disponible de información será la calidad y alcance de 

un estudio petrofísico ya que nuestras principales limitaciones al contar con una 
mínima información son los costos y el tiempo. 
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- Para nuestro caso de estudio, formaciones carbonatadas, la pérdida de porosidad 
con el incremento de la profundidad parece estar controlado más bien por 
procesos químicos involucrando precipitación de cementos que por el resultado de 
la compactación de capas suprayacentes, esto de acuerdo con el proceso de 
diagénesis en los carbonatos. 

 
 
- Analizando de forma global los resultados de las porosidades obtenidas en los 

cinco intervalos de interés descritos con más detalle en el Capítulo VI podemos 
asegurar que los resultados obtenidos están en el rango permisible de literatura, 
esto con base en datos obtenidos experimentalmente, por lo que se llega a la 
conclusión de que esos resultados cuentan con una buena confiabilidad. 

 
 
- La combinación de gráficas cruzadas utilizadas para la realización de este trabajo 

pueden dar mayor información de la formación (porosidad, litología, arcillosidad, 
contenido de gas, porosidades secundarias, etc.) que la que se puede adquirir de 
un solo perfil. 

 
 
- El uso de un paquete de cómputo o software comercial como lo es en el caso de 

este trabajo, facilita los cálculos en cuanto a tiempo y dinero. Sin embargo, no 
olvidemos todos los conocimientos que están detrás de él y sobre todo de la 
persona encargada de su manejo, en pocas palabras nosotros como ingenieros; si 
contamos con los conocimientos adquiridos durante nuestra formación, el 
software sólo será un medio de obtención de resultados y hablando 
profesionalmente debemos ser capaces de resolver cualquier problema que se 
presente. 

 
 
- Con respecto a que si cumplimos con el objetivo de este trabajo, por parte de un 

servidor y mi director de tesis puedo afirmar que concluimos satisfactoriamente 
esta evaluación, pero por parte de los estudiantes de la carrera no se verá a corto 
tiempo sino que se tiene que esperar para que ellos puedan utilizar esta 
herramienta de apoyo y concluir si realmente se cumplió con este objetivo. 
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